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About this guide

Purpose

This user guide provides reference information for the QuantStudio™ 6 and 7 Flex Real-Time PCR
Systems and describes how to prepare, maintain, and troubleshoot the systems.

WARNING! The protection provided by the equipment may be impaired if the instrument is operated
outside the environment and use specifications, the user provides inadequate maintenance, or the
equipment is used in a manner not specified by the manufacturer (Thermo Fisher Scientific).

Note: For information and instructions on performing experiments on the QuantStudio™ 6 and 7 Flex
Real-Time PCR Systems, see the following documents:
. QuantStudio™ Real-Time PCR Software Getting Started Guide (Pub. No. 4489822)

. High Resolution Melt Module for QuantStudio™ 6 and 7 Flex Real-Time PCR System Software Getting
Started Guide (Pub. No. 4489823)

. QuantStudio™ 6 and 7 Flex Real-Time PCR Systems (v1.6.1 or later) Quick Reference (Pub.
No. MANO0018829)

Audience

This user guide is written for laboratory staff who operate and maintain the QuantStudio™ 6 and 7 Flex
Real-Time PCR Systems.

Assumptions

This guide assumes that your QuantStudio™ 6 / QuantStudio™ 7 Flex System has been installed by a
Thermo Fisher Scientific service representative.

This guide also assumes that you are familiar with the following:
* Windows™ operating system
e Standard laboratory techniques for handling and preparing nucleic acid samples for PCR
* Data storage, file transfers, and copying and pasting

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems (v1.6.1 or later) Maintenance and Administration Guide 11


https://www.thermofisher.com/search/results?query=4489823
https://www.thermofisher.com/search/results?query=MAN0018829

About this guide
User attention words

User attention words

The following user attention words might appear in this document. Each word implies a particular level
of observation or action as described below:

Note: Provides information that may be of interest or help but is not critical to the use of the product.

IMPORTANT! Provides information that is necessary for proper instrument operation or accurate

chemistry kit use.

Safety alert words appear in this document with an open triangle figure that contains a hazard symbol.
These hazard symbols are identical to the hazard symbols that are affixed to the instrument.

For descriptions of the safety symbols, see Appendix |, “Safety”.

Symbols on this instrument

Symbols may be found on the instrument to warn against potential hazards or convey important safety
information. In this document, the symbol is used along with the user attention words to highlight
important safety information. The following table gives the meaning of these symbols.

Symbol English Francais
Caution, risk of danger Attention, risque de danger

A Consult the manual for further safety Consulter le manuel pour d’autres
information. renseignements de sécurité.

Contents of this manual

This guide is divided into the following chapters and appendixes:

Chapter/appendix

Content

Chapter 1, “Getting started”

Introduces the QuantStudio™ 6 and 7 Flex Systems, including descriptions of
all related hardware and software.

Chapter 2, “Calibrate the
instrument”

Describes how to maintain a QuantStudio™ 6 or 7 Flex Real-Time PCR
System, including calibration and performance verification.

Appendix A, “Manual instrument
operation”

Describes how to operate the QuantStudio™ 6 and 7 Flex Systems manually
using the touchscreen interface.

Appendix B, “Maintenance”

Describes how to replace the user-serviceable parts of the QuantStudio™ 6
and 7 Flex Systems and how to resolve infrequent problems that can occur
during normal use.

Appendix C, “Networking”

Describes how to install the QuantStudio™ 6 and 7 Flex Systems to a local
area network for remote monitoring and control.

12 QuantStudio™ 6 and 7 Flex Real-Time PCR Systems (v1.6.1 or later) Maintenance and Administration Guide




About this guide
Contents of this manual

(continued)

Chapter/appendix Content
Appendix D, “Power on or off, Describes how to store, move, and reinstall the components of the
store, and move” QuantStudio™ 6 and 7 Flex Systems.

Appendix E, “Security, audit, and Describes how to configure the security, audit, and electronic signature
electronic signature” functions of the QuantStudio™ Real-Time PCR Software.

Appendix F, “Calibration

consumable preparation” Describes how to prepare consumables for custom dye calibration.

Describes how to order parts, accessories, and consumables for the

Appendix G, "Parts and materials QuantStudio™ 6 and 7 Flex Systems.

Appendix H, “Instrument Describes the QuantStudio™ 6 and 7 Flex System specifications,
specification and layout” requirements, layout, and connections.

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems (v1.6.1 or later) Maintenance and Administration Guide 13
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Differences between the QuantStudio™ 6 and 7 Flex Real-
Time PCR Systems

The following table displays the differences between the QuantStudio™ 6 Flex System and the
QuantStudio™ 7 Flex System.

QuantStudio™ 6 Flex System QuantStudio™ 7 Flex System
Does not support the TagMan™ Array Card block Supports the TagMan™ Array Card block
Features a coupled five-color filter set Features a decoupled six-by-six-color filter set

About the QuantStudio™ 6 and 7 Flex Real-Time PCR
Systems

The QuantStudio™ 6 and 7 Flex Real-Time PCR Systems use fluorescent-based polymerase chain
reaction (PCR) reagents to provide:

¢ Quantitative research detection of target nucleic acid sequences (targets) using real-time analysis.
¢ Qualitative research detection of targets using post-PCR (endpoint) analysis.
* (Qualitative analysis of the PCR product (achieved by melt curve analysis that occurs post-PCR).
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Data collection

Chapter 1 Getting started WA.‘
About the QuantStudio™ 6 and 7 Flex Real-Time PCR Systems

The QuantStudio™ 6 and 7 Flex Systems collect raw fluorescence data at different points during a PCR,
depending on the type of run that the QuantStudio™ 6 and 7 Flex Systems perform:

Table 1

Run type

Data collection point

Real-time runs

Standard curve

Relative standard
curve

Comparative C; (AACy)

Melting curve

The QuantStudio™ 6 and 7 Flex Systems collect data following
each extension step of the PCR.

Post-PCR
(endpoint) runs

Genotyping

Presence/absence

The QuantStudio™ 6 and 7 Flex Systems collect data:

1. Before the PCR. (For presence/absence experiments, data
collection before the PCR is optional, but recommended.)

2. (Optional) During the PCR. The QuantStudio™ 6 and 7 Flex
System can collect data during the run (real-time); collecting
data during the run can be helpful for troubleshooting.

3. After the PCR.

The instrument collects raw fluorescence data following each extension step of the PCR. A data
collection point, or read, on the QuantStudio™ 6 and 7 Flex System consists of three phases:
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Chapter 1 Getting started

About the QuantStudio™ 6 and 7 Flex Real-Time PCR Systems

1. Excitation: The instrument illuminates all wells of the plate or array card, within the instrument,
exciting the fluorophores in each reaction.

2. Emission: The instrument optics collect the residual fluorescence emitted from the wells of
the plate or array card. The resulting image collected by the device consists only of light that
corresponds to the range of emission wavelengths.

3. Collection: The instrument assembles a digital representation of the residual fluorescence
collected over a fixed time interval. The software stores the raw fluorescent image for analysis.

After a run, the software uses calibration data (ROI, background, uniformity, dye, and normalization) to
determine the location and intensity of the fluorescent signals in each read, the dye associated with
each fluorescent signal, and the significance of the signal.

Instrument filters and supported dyes

System dyes

The QuantStudio™ 6 Flex Real-Time PCR System features a coupled five-color filter set while the
QuantStudio™ 7 Flex Real-Time PCR System features a decoupled six-by-six-color filter set that
supports the dyes shown in the following table. For more information about the spectral dye calibration
kits, contact Thermo Fisher Scientific.

Filter wavelengthl']
Filter set| Color System dyes Example custom dyes
Excitation Emission
xi-m1 | Blue | 470+15nm | 520+ 15nm | M dye’(iLBR Green™ | syTo9 dye
- JOE™ dye, HEX™ dye,
x2-m2 Green | 520+ 10nm | 558 + 12 nm VIC™ dye TET™ dye 2
) NED™ dye, TAMRA™ dye, ®
x3-m3 | Yellow |549.5+10nm|586.5+ 10 nm ABY™ dye Cy~“3 dye
x4-m4 | Orange | 580 +10nm | 623 + 14 nm ROX™ dye, JUN™ dye Texas Red™ dye
x5-m5 | Red | 640=10nm | 682+ 14 nm MUSTANGCPy %?PLE 48 | L 1zw aye
x6-m6l3! | Deepred| 662 + 10 nm | 711 + 12 nm Nonel“ Cy®5.5 dye

' The central wavelengths are the optimized wavelengths.

@l The HEX™ dye and the TET™ dye from Thermo Fisher Scientific fall within the emission wavelength range of the system, therefore
they can be added and adapted for use in experiments on the system. To add any of these dyes to the Dye Library, perform a
custom dye calibration. For more information, see Appendix F, “Calibration consumable preparation”.

Bl QuantStudio™ 7 Flex Real-Time PCR System only.

¥ This filter set currently does not support any dyes supplied by Thermo Fisher Scientific.
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Chapter 1 Getting started M
Instrument hardware

Wavelength
(nm)

Emission
Spectra

x1-m1 x2-m2 x3-m3 x4-m4 x5-m5 x6-m6 , Filters
OO ©® ©
(1) FAM™ dye, SYBR Green™ dye
(@ vIC™ dye
@ NED™ dye, TAMRA™ dye, ABY™ dye

(® ROX™ dye, JUN™ dye
() MUSTANG PURPLE™ dye, Cy®5

Custom dyes

The QuantStudio™ 6 and 7 Flex Systems can run assays designed with custom dyes (dyes not supplied
by Thermo Fisher Scientific) that are excited between 455 to 672 nm and read between 505 to 723 nm.
To add a custom dye to the Dye Library, perform a custom dye calibration. For more information, see
Appendix F, “Calibration consumable preparation”.

Instrument hardware

The QuantStudio™ 6 and 7 Flex Systems consist of the components shown in the following figure and
described in the subsequent table.
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Instrument hardware

Front

Component Description

Provides access to the instrument functions. Can be used to run experiment, transfer

1| Touchscreen data, and operate the instrument functions without the use of the computer.

Provide USB communication with the instrument. Can be used to transfer data to and

from the instrument.

2 | USB ports . ) ) ) i
Note: If multiple USB drives are plugged into the instrument, the instrument mounts only

the first drive that is installed, regardless of the USB port used.

3 | Access door | Provides access to the instrument lamp, the heated cover, and the sample block.

4 | Lamp llluminates the plate or array card during a run.

Covers the plate or array card during a run to prevent condensation and leakage through

5 | Heated cover
the cover.

6 | Sample block | Heats the plate or array card during a run.

7 | Side door Opens to allow extension of the tray arm.

8 | Plate adapter | Secures the plate or array card to the tray arm.

Conveys the plate or array card to and from the sample block in the interior of the

9 | Tray arm )
Y instrument.
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Component

Description

1| Ethernet port

An RJ45 port that provides Ethernet (gigabit) communication with the instrument.!']

Provide USB communication with the instrument. USB ports can be used to transfer
data from the instrument.

2| USB ports . . ) ) .
Note: If multiple USB drives are plugged into the instrument, the instrument mounts
only the first drive that is installed, regardless of the USB port used.
Provides serial communication between the instrument and the computer.

3| RS232 port

IMPORTANT! The serial port is for Thermo Fisher Scientific use only.

4 | Instrument fans

Cool the interior of the instrument.

IMPORTANT! The fans must be unobstructed for adequate cooling and proper
function of the instrument.

5 | On/Off switch

Power switch for the instrument, where the states are on (| ) or off (O).

6 | Fuse cover

Dual 12.5A, Time-Lag T, 250 VAC, 5 x 20-mm electrical fuses that protect the
instrument from excessive electrical current.

For AU/NZ only - 6.3A, Time-Lag, 250VAC, 5 x 20-mm.

7 | Power port

The 100-240 VAC port that provides power to the instrument.

[ Use the Ethernet cable supplied with the instrument to connect the instrument (Ethernet port) to the network interface card in the

computer.
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Barcode scanner

20

The QuantStudio™ 6 and 7 Flex Systems include an optional Handheld Barcode Scanner (Cat. No.
4453271) that you can purchase to assist you with data entry. The barcode scanner uses a 670 nm
Class Il laser to scan plates or array cards (for only the QuantStudio™ 7 Flex System) and it is capable of
reading Code 128 (alphanumeric), which supports 128 ASCII character barcodes.

WARNING! LASER. Exposure to direct or reflected laser light can burn the retina and leave
permanent blind spots. Never look into the laser beam. Remove jewelry and anything else that can
reflect the beam into your eyes. Protect others from exposure to the beam.

The optional hand-held barcode scanner functions as an extension of the keyboard. You can use the
scanner to scan barcodes into the instrument software.

To scan a barcode using the hand-held barcode scanner:

1. Select the field in the instrument software where you want to enter the barcode.

2. Hold the hand-held barcode scanner 20-30 cm away from a plate or array card and aim at the
center of the barcode, then press the trigger. Slowly move the scanning beam across the barcode
until the scanner emits a high-pitched tone.

When the scanner scans a barcode, it automatically:

¢ Transmits the alphanumeric equivalent of the barcode to the instrument software. The software
enters the barcode text wherever the cursor is active.

* Transmits a carriage-return character (the equivalent of pressing the Enter key).

For more information on the hand-held barcode scanner, see the user documentation shipped with the
barcode scanner.
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Electrical protective devices

We recommend several protective devices to protect the instrument in environments with large voltage
and power fluctuations.

Power line regulator

We recommend the use of a 1.5-kVA power line regulator in areas where the supplied power fluctuates
in excess of + 10% of the normal voltage. Power fluctuations can adversely affect the function of the
instrument and the computer.

Note: A power line regulator monitors the input current and adjusts the power supplied to the
instrument or computer. It does not protect against a power surge or failure.

Uninterruptible power supply (UPS)

We recommend the use of a 1.5-kVA uninterruptible power supply (UPS), especially in areas prone to
power failure. Power failures and other events that abruptly terminate the function of the instrument and
the computer can corrupt data and possibly damage the system.

WARNING! PHYSICAL INJURY HAZARD. Do not attempt to lift the UPS unit without assistance
(minimum of two people). Improper lifting can cause painful and permanent back injury. Refer to the
UPS manufacturer user guide for more information.

IMPORTANT! UPSs provide power for a limited time. They are meant to delay the effects of a power
outage, not to serve as replacement power sources. In the event of a power loss, power off the
instrument and the computer, unless you expect to regain power within the battery life of the UPS.

Surge protector

We recommend the use of a 10-kVA surge protector (line conditioner) in areas with frequent electrical
storms or near devices that are electrically noisy, such as refrigerators, air conditioners, or centrifuges.
Short-duration, high-voltage power fluctuations can abruptly terminate the function of, and thereby
damage the components of, the computer and the instrument.

Note: A dedicated line and ground between the instrument/computer and the building’s main electrical
service can also prevent problems caused by power fluctuations.

Instrument software

The QuantStudio™ 6 and 7 Flex Systems include a suite of software applications that can be used to
calibrate, run, automate, and integrate the instrument into a laboratory workflow. The installation of the
software contains the components described in the following sections; however, additional software
may be available for the QuantStudio™ 6 and 7 Flex Systems. Go to thermofisher.com/gpcrsoftware
for a complete list of compatible software, and for updates and patches for the system software and
firmware.
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Computer requirements

The following are the minimum specifications for the computer used to operate the QuantStudio™ 6 and
7 Flex Systems:

® Operating system—Windows™ 10 (64-bit) or Windows™ 11
¢ Memory—4 GB RAM

* Free disk space—20 GB

* Monitor—1280 x 1024 resolution

An Ethernet port must be available for a direct connection to the instrument.

Antivirus software requirements

No antivirus software is provided because customer preferences and network requirements vary. You
are responsible for installing antivirus software of your choice to protect the computer against viruses.

The following antivirus software applications have been tested for use on the computer that operates
the QuantStudio™ 6 and 7 Flex Systems:

* McAfee™ Endpoint Security v10.7 (v10.7.0.2000)
* Symantec™ Endpoint Protection v14 (14.2 RU1 MP1) build 4814 (14.2.4814.1101)
* Microsoft Defender™ antivirus software

Software installation

The default installation of the instrument partitions the computer hard drive to create the logical drives
as explained below.

Drive Software Description
C drive | Microsoft™ Windows™ OS] Operating system files.
Used to calibrate and perform experiments on the
QuantStudio™ Real-Time PCR QuantStudio™ 6 and 7 Flex System.
Software Stores the installation files, application data files, and

Cor D drive user files (experiments, exports, and imports).

QuantStudio™ 6 and 7 Flex System | Used to automate the creation of new experiments and
Command Line Utility the export of existing experiments.

[ We recommend that you do not install programs to the C drive.
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Instrument consumables

The QuantStudio™ 6 and 7 Flex Systems support a series of specialized consumables through
interchangeable sample blocks. Use the consumables appropriate for the sample block of your
QuantStudio™ 6 or 7 Flex Systems.

Note: The QuantStudio™ 6 Flex System does not support the Array Card block.

WARNING! Use the flat caps for 0.2 mL tubes and 0.1 mL tubes. Rounded caps can damage the
heated cover.

Y

Sample block Consumable Reaction volume

*  MicroAmp™ Optical 8-Cap Strip
[ *  MicroAmp™ 8-Tube Strips (0.2-mL)

z = 2525, * MicroAmp™ Reaction Tubes without 100 pL
= 22662‘96 Caps (0.2-mL)
N7 °

MicroAmp™ 96-Well Tray/Retainer Set
96-well plate, 0.2 mL

* MicroAmp™ Optical Adhesive Film

* MicroAmp™ Optical 96-Well Reaction 100 pL
Plate with Bar Code

¢ MicroAmp™ Optical Adhesive Film

96-well plate, 0.1 mL *  MicroAmp™ Optical 96-Well Fast 50 pL

Reaction Plate with Bar Code

Notched corner

*  MicroAmp™ Optical Adhesive Film

384-well plate *  MicroAmp™ Optical 384-Well Reaction 20 L

Plate with Bar Code

TagMan™ Array

Cardl! | TagMan™ Array Card 1L

[ QuantStudio™ 7 Flex System only.
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Interchangeable sample blocks, heated covers, and plate
retainers

The QuantStudio™ 6 and 7 Flex Systems feature a set of interchangeable sample blocks, heated
covers, and plate retainers that allow the instruments to support multiple consumable formats. All

of the hardware is user-installable. Replacement can be done without the need for recalibration of

the instrument, provided that the calibrations for the new format have not expired. See Appendix B,
“Maintenance” for more information about changing the sample block, heated cover, and plate retainer.
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B Remove a plate stuck withinthe instrument ........ .. ... .. .. . .. 87

IMPORTANT! Perform the procedures for preparing array cards only if you are verifying the
performance of a QuantStudio™ 7 Flex System with an array card sample block. The QuantStudio™
6 Flex System does not support the array card sample block.
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Calibration overview

Calibration and maintenance schedule

The QuantStudio™ 6 and 7 Flex Systems require regular calibration and maintenance for proper
operation. For proper operation of your instrument, perform weekly, monthly, and semiannual
maintenance as indicated in the following table.

IMPORTANT! Perform calibrations and run experiments under the environmental conditions specified
in Appendix H, “Instrument specification and layout”. Exposure to extreme temperatures can have
adverse effects on the run results, as well as shortening the life span of the instrument components.

IMPORTANT! Do not use organic solvents to clean the QuantStudio™ 6 and 7 Flex Systems.

Frequency User-performed maintenance task

Check the computer disk space. If necessary, archive or back up your
experiment files and instrument settings.

Weekly Power off the computer that controls the instrument, then power on the
computer after 30 seconds.

Clean the surface of the instrument with a lint-free cloth.

Perform a background calibration.[!

Monthly Run disk cleanup and disk defragmentation.

Perform an instrument self test.

Perform an ROI calibration.

Perform a background calibration.[!

Semi-annually (every 6 months) | Perform a uniformity calibration.

Perform a dye calibration.

(TagMan™ Array Card block only) Perform a normalization calibration.[?]

Perform an RNase P instrument verification run.

As needed

Replace the instrument lamp.B!

' You can perform a background calibration to check for contamination.
@ A normalization calibration is not required for the 96-well plate blocks (0.1-mL or 0.2-mL) or the 384-well plate block.
B After replacing the instrument lamp, perform all calibrations and an RNase P instrument verification run.
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Calibration with QuantStudio™ Real-Time PCR Software v1.6.1 or later

QuantStudio™ Real-Time PCR Software v1.6.1 or later does not require a normalization calibration for
the 96-well plate blocks or the 384-well plate block. For this version of the software, normalization
calibration is only required for the TagMan™ Array Card block.

After the software is upgraded, the instrument must be calibrated before starting a run with a 96-well
plate block or a 384-well plate block.

After the software is upgraded, the instrument does not need to be calibrated before starting a run with
a TagMan™ Array Card block.

The feature to override a calibration can only be used for a data file with compatible calibration data.

* A data file generated with a previous version of the software cannot have the calibration overridden
after an upgrade to QuantStudio™ Real-Time PCR Software v1.6.1 or later.

* A data file generated with QuantStudio™ Real-Time PCR Software v1.6.1 or later cannot have the
calibration overridden if it is opened using a previous version of the software.

Planned maintenance

The instrument requires regular planned maintenance by Thermo Fisher Scientific service personnel
to help ensure that the instrument is operating within the installation specification. The planned
maintenance service can help you maximize your productivity by minimizing downtime, lowering
the cost of ownership by addressing potential problems before they manifest (lost data, samples,
or reagents), and increasing the quality of your results by maintaining your instrument at optimal
performance. For more information, contact your Thermo Fisher Scientific sales representative.

About maintenance reminders

The QuantStudio™ Real-Time PCR Software features an automated notification system that alerts you
of required calibrations. The feature will also prevent you from operating an instrument that is out of
calibration. For more information on setting the maintenance reminders, see “Enable or change the
calibration reminders” on page 32.
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Calibration workflow

Whether you are performing all calibrations or just a subset, perform calibrations for the QuantStudio™ 6
and 7 Flex Systems in the following sequence.

Background calibration can be performed on its own. For more information, see “Calibration and
maintenance schedule” on page 26.

Note: A normalization calibration is not required for the 96-well plate blocks (0.1-mL or 0.2-mL) or the
384-well plate block.

Start

v

ROI calibration (page 41)
v

Background calibration (page 46)
v
Uniformity calibration (page 51)

v

Dye calibration (page 54)
v

Normalization calibration (TagMan™ Array Card only) (page 60)

v

Verify the instrument performance (page 63)

(RNase P instrument verification)
v

Finish
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View the calibration status of an instrument

You can use the Instrument Console of the QuantStudio™ Real-Time PCR Software to view the
calibration status of an instrument.

1. In the QuantStudio™ Real-Time PCR Software Home tab, click * Instrument Console.

2. From the Instrument Console open the Instrument
Manager. Fie Edt Instrument Analysis 72—5\ Help

| New Experiment - = Opel _ Close ®

a. Select your instrument icon from the My
r e Remove from
Instruments group. o Tnctrements

Display Group: Fitered by: [
b. Click Manage Instrument. My Instruments (1)

Note: If the Manage Instrument option is inactive,
connect your instrument to the My Instruments group.

278860001
READY

3. From the Instrument Manager, click Monitor, then
click Information to open the instrument monitor.

The instrument monitor screen displays the following information:
a. The Instrument type (the QuantStudio™ 6 Flex System or the QuantStudio™ 7 Flex System)

b. The status of all calibrations, including the date and time of each calibration
c. The maintenance status of the instrument

d. The properties of the instrument
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& QuantStudio™ Real-Time PCR Software v1.6 — x
Fle Edit Instrument Analysis Tool Help

[&] New Experiment - | [z5 Open ~ [ Save - E5 dose Ep 8
278870366 (96-Well Block (0.2mL))
E] ﬁ| QuantStudio™ 7 Flex System
READY
(P oo o [ P ot oy
Monitor ——
ICalibration Status =)
ROI 07-18-2019 00:54:56 PDT GUEST Current ‘
Temperature
| Background 07-18-2019 01:05:17 PDT GUEST Current
Uniformity 07-18-2019 01:13:25 PDT GUEST Current
(‘{ ) B Dye
> CY5 07-18-2019 01:33:29 PDT GUEST Current
+ Maintenance ROX 07-18-2019 01:21:31 PDT GUEST Current
VIC 07-18-2019 01:21:31 PDT GUEST Current
FAM 07-18-2019 01:21:31 PDT GUEST Current
T SYBR 07-18-2019 01:21:31 PDT GUEST Current
ABY 07-18-2019 01:45:36 PDT GUEST Current
MUSTANG PURPLE 07-18-2019 01:45:36 PDT GUEST Current
TAMRA 07-18-2019 01:33:29 PDT GUEST Current
TEST 07-18-2019 01:55:27 PDT GUEST Current
NED 07-18-2019 01:33:29 PDT GUEST Current
JUN 07-18-2019 01:45:36 PDT GUEST Current
RNase P 07-16-2019 09:39:23 PDT GUEST Invalid
e Info Ca)
Lamp Life 663 hours @
Total Cycles for Block 38,014
Total Degrees for Block 872,608 |
Instrument Properties Ca)
Instrument Label ruo
Serial Number 278870366
Instrument Firmware Version 1.0.4
1P Address 10.128.68.252
Block Type 96-Well Block (0.2mL)
Controller Frmware Version 1.0.2
Optics Firmware Version 24
Thermal Block Frmware Version 20
A  Heated Cover Firmware Version 10
Instrument Con. .. ) 278870366 x

tudio™ Real

Figure 1 Information screen for the instrument with a 96-well plate block or a 384-well plate block
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)
Calibration overview

E] 278860001 (TagMan Array Card block)
ﬁ f QuantStudio™ 6 Flex System
READY
 Excort intrument Detaie | et Calbation oo |
Calibration Status =
fformaton -
— T R R
06-20-2013 09:49:16 SGT GUEST Current
Temperature
‘ Background 06-20-2013 00:57:32 SGT GUEST Current
Uniformity 06-20-2013 10:04:14 SGT GUEST Current
E Dye
FAM 06-20-2013 10:11:09 SGT GUEST Current
VIC 06-20-2013 10:18:06 SGT GUEST Current
ROX 06-20-2013 10:27:22 SGT GUEST Current ‘3[.)
SYBR 06-20-2013 10:37:27 SGT GUEST Current
NED 06-20-2013 10:53:57 SGT GUEST Current
TAMRA 06-20-2013 10:44:41 SGT GUEST Current
MELTDOCTOR 06-21-2013 14:40:54 SGT GUEST Current
E Nomalization
FAM/ROX 06-20-2013 11:01:35 SGT GUEST Current
VIC/ROX 06-20-2013 11:08:56 SGT GUEST Current
{E HRM
RNzsa P 06-21-2013 00:26:48 SGT GUEST Currant

Maintenance Info

T 2

Lamp Life 46 hours
Total Cycles for Block 3,856
Total Degrees for Block 121,250 |

Instrument Properties

|L

Instrument Label ruo

Serial Number 278860001

Instrument Firmware Version 1.0.3

IP Address 172.28.1.105

Black Type 'TaqMan Array Card block
Controler Frmware Version 1.0.2

Optics Firmware Version 24

Thermal Block Frmware Versicn 20

Heatec Cover Fimware Version 10

2 Instrument Can, ... = 201505-2515...

%@ 2788£0001 x

Figure 2 Information screen for the instrument with a TagMan™ Array Card block

Note: While viewing the Monitor screen, you can generate reports of the calibration history and status
for the instrument. The following options are available from the Instrument Manager:

* Print Calibration Log— Prints the calibration history of the instrument.

* Print Maintenance Summary—Prints a summary of the current instrument calibrations.

Note: The details for an instrument in the My Preferred list can be exported even if the network
connection has been interrupted. The exported details from the disconnected instrument would contain
the data most recently downloaded from the instrument before the interruption.
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Enable or change the calibration reminders

The calibration reminder settings allow you to configure the QuantStudio™ Real-Time PCR Software to
alert you by email when the QuantStudio™ 6 or 7 Flex Real-Time PCR System requires calibration. The
notifications settings feature is optional, and it does not affect instrument performance.

IMPORTANT! The calibration reminders feature requires a connection between the QuantStudio™ 6 or
7 Flex Real-Time PCR System computer and a computer network. If you choose to set up the feature
as described below, ensure that your network has appropriate security measures in place to protect
data from threats such as computer viruses.

IMPORTANT! The QuantStudio™ Real-Time PCR Software transmits emails only while the
QuantStudio™ 6 or 7 Flex Real-Time PCR System is monitored. If the network connection is interrupted,
the software will stop transmitting updates.

Requirements to email calibration reminders

The QuantStudio™ Real-Time PCR Software requires access to a Simple Mail Transfer Protocol (SMTP)
server to email calibration reminders. Contact your systems administrator or information technology
department for the following information:

* Network address of an SMTP server.
* A user name and password for the server, if required for access.
* The Secure Sockets Layer (SSL) setting of the server (on or off).

Define the mail server settings
1. In the QuantStudio™ Real-Time PCR Software, select Tools » Preferences.
2. From the Preferences dialog box, select the SMTP Settings tab.

3. Define the settings for the SMTP server:

a. From the Outgoing Mail Server (SMTP) field, enter the network address of a Simple Mail
Transfer Protocol (SMTP) server.

Optionally, you can specify the transmission control protocol (TCP) port for the server by
appending the port number to the server name, separating the two using a colon (:).

For example: smtp.mycompany.com:2023

Note: If a TCP port is not specified, the software uses the default port number (25).

b. Select Encryption Required if the mail server has SSL enabled.

c. Select Authentication Required if the mail server requires a user name and password.
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d. If the mail server requires authentication, enter the user name and password provided by your

systems administrator.

42 Preferences

( Defaults T Startup
Display Format

[

SMTP Settings Notification Settings

Experiment

@ Enter the SMTP server settings for email notifications.

Qutgoing Mail Server(SMTP):
Encryption Required?: O
Authentication Required?: [
User Name:

Password:

=

4. Click OK.

5. Test the mail server settings:
a. In the Home tab of the QuantStudio™ Real-Time PCR Software, select any experiment in the

Set Up panel, then click Set Up to create a new experiment.

b. In the experiment document, click ‘@ Run in the Experiment Menu, then click Notification
Setting to view the notification settings for the experiment.

c. In the Notification Settings of the experiment document, select Yes to enable the Enable
Notifications setting.

d. From the Enter e-mail addresses for notifications field, enter the email address that you
want to receive the test emails.
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e. Click Test Configuration to test the mail server settings.

Confirm that the email account you specified in substep 5d received the test messages from
the QuantStudio™ Real-Time PCR Software. If not, consult your network administrator to
confirm that the mail server settings are defined correctly.

Run Status: Not Started

@ @ []Enable Notifications
C

@

Amplification Plot

RLN Notification Settings

Temperature Plot
Run Method

Vicw Run Data

Tes: the current parameters.When you press the - -
Test Configuration, sample Run Sterted, Instrument Error, | Test Configuration
RUN Stopped, and Run COMDIETeC messages wil be sent.

I'F

Modify the notification settings for a monitored instrument

1. Open the Calibration Reminders screen for the QuantStudio™ 6 or 7 Flex Real-Time PCR System:
a. In the QuantStudio™ Real-Time PCR Software Home tab, click Instrument Console.

b. In the Instrument Console, select the icon for your instrument, then click Manage
Instrument.

Note: If the Manage Instrument button is inactive, add your instrument to the My
Instruments group.

c. In the Instrument Manager, click /5 Maintenance, then click Calibration Reminders.

2. In the Calibration Reminders Setting table, configure the notification settings for the calibrations
in interest. For each calibration that you want to monitor:

a. In the Send a Reminder column, select the check box to configure the QuantStudio™
Real-Time PCR Software to email a reminder to perform the calibration.

b. In the Reminder Interval column, enter the number of days before the calibration expires that
the software should send a reminder email.

3. In the Enter e-mail addresses for notifications field, enter the email address(es) that you want to
receive notifications. Separate multiple email addresses with commas (, ).

4. Click Apply to change the notification settings.
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@ QuantStudio™ Real-Time PCR Software v1.6 @ @ - X
Fle Edit Instrument Analyss Tools Help

& New Experiment « | (5 Open ~ [d Save ~ £ Close If} Import... - 4B a

Calibra Reminders Settings

calibration Date Last Calibrated | Expiry Interval Date Calibration Expir... Send an Email Remin... | Reminder Interval Reminder Date
ROl 07-18-2019 00:54:56 PDT 1802 01-14-2020 00:54:56 PST (m] 7R 01-07-2020 00:54:56 PST
Background 07-18-2019 01:05:17 PDT 1802 01-14-2020 01:05:17 PST O 7E 01-07-2020 01:05:17 PST
Unformity 07-18-2019 01:13:25 PDT 1805 01-14-2020 01:13:25 PST (m] 7 01-07-2020 01:13:25 PST
& Dye 1805 0 7B
| Dye-CYS 07-18-2019 01:33:29 PDT 01-14-2020 01:33:29 PST O 01-07-2020 01:33:29 PST
?\ Mantenance Dye-ROX 07-18-2019 01:21:31 PDT 01-14-2020 01:21:31 PST O 01-07-2020 01:21:31 PST
Dye-VIC 07-18-2019 01:21:31 PDT 01-14-2020 01:21:31 PST (m] 01-07-2020 01:21:31 PST
o Dye-FAM 07-18-2019 01:21:31 PDT 01-14-2020 01:21:31 PST O 01-07-2020 01:21:31 PST
Background Dye-SYBR 07-18-2019 01:21:31 PDT 01-14-2020 01:21:31 PST (m] 01-07-2020 01:21:31 PST
Dye-ABY 07-18-2019 01:45:36 PDT 01-14-2020 01:45:36 PST O 01-07-2020 01:45:36 PST
Uniformity Dye-MUSTANG PURPLE |07-18-2019 01:45:36 PDT 01-14-2020 01:45:36 PST O 01-07-2020 01:45:36 PST
Dye-TAMRA 07-18-2019 01:33:29 PDT 01-14-2020 01:33:29 PST O 01-07-2020 01:33:20 PST
ove Dye-TEST 07-18-2019 01:55:27 PDT 01-14-2020 01:55:27 PST (m] 01-07-2020 01:55:27 PST
RNase P Run Dye-HED 07-18-2019 01:33:29 PDT 01-14-2020 01:33:29 PST O 01-07-2020 01:33:29 PST
Dye-JUN 07-18-2019 01:45:36 PDT 01-14-2020 01:45:36 PST (] 01-07-2020 01:45:36 PST
@ e Riase P 07-16-2019 09:39:23 PDT 180 01-12-2020 09:39:23 PST O 7E 01-05-2020 09:39:23 PST
B HRM 180 m] 7E
HRM-MELTDOCTOR 07-16-2019 09:39:23 PDT 01-12-2020 09:39:23 PST [m] 01-05-2020 09:39:23 PST

Email Addresses Settings

Enter e-mai addresses for notifications: i

Separate e-mail addresses with "

For example, “john@email.com, Kevin@email.com”

x

Figure 3 Calibration reminders screen for the instrument with a 96-well plate block or a 384-well plate block
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Guidelines for preparing calibration plates and array cards

®

Calibration Reminders Settings

(2a)

D

Calibration Date Last Calibrated  ExpiryInterval Date Calibration Ex... Send an Email Remi... | Reminder Interval | Reminder Date
RO1 13-07-2012 11:12:58 PDT| | 180 = 09-01-2013 11:12:58 PST)| B 7k 02-01-2013 11:12:58 PST]|
h Background 13-07-2012 11:27:13 PDT, 3002 12-08-2012 11:27:13 PDT 7 05-08-2012 11:27:13 P...
Uniformity 13-07-2012 11:39:39 PDT| | 180 = 09-01-2013 11:39:39 PST)| ] 7E 02-01-2013 11:39:39 PST
B Dye 180[% 7
‘7;4 Dye-FAM 13-07-2012 11:50:46 PDT| 09-01-2013 11:50:46 PST)| 02-01-2013 11:50:46 PST]|
‘{7\ Maintenance Dye-VIC 13-07-2012 12:05:52 PDT 09-01-2013 12:05:52 PST)| 02-01-2013 12:05:52 PST|
2o Dye-ROX 13-07-2012 12:17:14 PDT| 00-01-2013 12:17:14 PST B 02-01-2013 12:17:14 PST|
Dye-CYS 13-07-2012 13:51:56 POT 09-01-2013 13:51:56 PST 02-01-2013 13:51:56 PST
Background B Normalization 180/ | 72
Normaization-FAM/RON1 3.07.2012 12:28:14 PDT| 09-01-2013 12:28:14 PST| 02-01-2013 12:28:14 PST|
Uniformity Normalzation-VIC/ROX|1 3672012 12:38:04 PDT, 00-01-2013 12:38:04 PST| 02-01-2013 12:38:04 PST]|
Riase P 13-07-2012 14:27:41 PDT| [ 180/% 00-01-2013 14:27:41 PST)| 7E 02-01-2013 14:27:41 PST|
e B HRM 180 B 7
Normalization
HRM
-r Enter e-mail addresses for notifications:
Heminders Separate e-mail addresses with *," (3)
For example, "“john@emai.com, Kevin@emal.com”
e
f Manage Files
A
Instiument Con,,,  |EECEE ViR

Figure 4 Calibration reminders screen for the instrument with a TagMan™ Array Card block
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Guidelines for preparing calibration plates and array cards

Observe the following guidelines when preparing calibration plates and array cards:

36

Wear appropriate protective eyewear, clothing, and gloves.

Prepare and run calibration plates and array cards within the recommended time limits listed below.

Consumable Time to thaw After thawed, run within...
All 96-/384-well calibration consumables!'! 30 minutes 120 minutes
All array card calibration consumables(?! 30 minutes 120 minutes
RNase P plate (96-/384-well) 5 minutes 30 minutes
RNase P array cardi! 15 minutes 60 minutes

[ All 96-well plates and 384-well plates used in the calibration of the instrument (ROI, background, uniformity, and dye).

[ All array cards used in the calibration of the QuantStudio™ 7 Flex System only (ROI, background, uniformity, dye, and
normalization).

Bl For use with the QuantStudio™ 7 Flex System only.
(Plates only) Do not discard the packaging for the calibration plates. Each plate can be used to
calibrate the QuantStudio™ 6 and 7 Flex Systems 3 times for up to 6 months if it is stored in its
packing sleeve.

Store calibration plates or array cards in a dark place until you are ready to use them. The
fluorescent dyes in the wells of calibration consumables are photosensitive. Prolonged exposure

to light can diminish the fluorescence of the dyes.
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Preparing array cards for instrument calibration

¢ Do not allow the bottoms of the plates or array cards to become dirty. Fluids and other
contaminants that adhere to the bottoms of the consumables can contaminate the sample block
and cause an abnormally high background signal.

* Confirm that your centrifuge is clean. Before centrifugation, wipe down the bucket(s) using a tissue.

¢ \Vortex and centrifuge all calibration plates to ensure complete mixing and that all reagents are
contained at the bottom of the wells. The calibration plates must be well mixed and centrifuged
before use.

Preparing array cards for instrument calibration

IMPORTANT! Perform the following procedure only if you are verifying the performance of a
QuantStudio™ 7 Flex System with an array card sample block. The QuantStudio™ 6 Flex System does
not support the array card sample block.

Required materials

* ViiA™ 7 Array Card Spectral Calibration Kit
— Empty TagMan™ Array Cards
- FAM™ dye
- VIC™dye
- ROX™ dye
- ROI dye mix
— Background buffer
- FAM™/ROX™ dye
- VIC™/ROX™ dye
* TagMan™ Array Card Sealer
* (Centrifuge with array card buckets and array card carrier clips
* Permanent marker or pen
* Pipettor, 200-pL (with pipette tips)
* Powder-free gloves
* Safety glasses
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Fill the calibration TagMan™ Array Cards

38

IMPORTANT! Wear powder-free gloves while creating the calibration array cards.

This procedure explains how to create all of the array cards required to calibrate the QuantStudio™ 7
Flex System, but not all of them are required for a monthly maintenance. Before preparing array cards
for calibration, determine which calibrations are required (see “Calibration and maintenance schedule”
on page 26).

Note: For more information on the array card loading procedure, contact Technical Support.

1.

Remove the tubes of calibration solutions from the freezer, allow them to thaw, then vortex the
tubes to mix the contents well.

Remove the array cards from their box and place them on a clean, dry surface.

Mark the side of the empty array cards with:
Background, FAM™, ROI, ROX™, VIC™, FAM™/ROX™,
and VIC™/ROX™. g
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For each array card, pipet 100 yL of the appropriate
calibration solution into each of the eight reservoirs in
the array card:

a. Place the array card on a lab bench, with the foil
side down.
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@ Mark here
b. Load 100 pL of the calibration solution into a
pipette.

¢. Hold the pipette in an angled position (approximately 45 degrees) and place the tip into the fill
port. The fill port is the larger of the two holes on the left side of the fill reservoir.

a

(D Fill port

(@ Vent port
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Preparing array cards for instrument calibration

d. Dispense the fluid so that it sweeps in and around
the fill reservoir toward the vent port.

Pipet the entire 100 pL into the fill reservoir, but do
not go past the first stop of pipettor plunger or you
may blow the solution out of the port.

IMPORTANT! Do not allow the tip to contact and
possibly damage the coated foil beneath the fill port.

5. Repeat step 4 to fill the remaining array card with the
appropriate calibration reagents.

6. Centrifuge the array card(s):

a. Place the filled array card(s) into a centrifuge array card carrier clip and place empty array
cards in the remaining slots. Confirm that the labels on the buckets and clips are oriented in
the same direction.

b. Place the filled carrier clips into the centrifuge buckets. Make sure that the array card fill
reservoirs and bucket and clip labels face outward when loaded into the centrifuge.

IMPORTANT! You must run the centrifuge with all four buckets in place and each of the two
carriers filled with array cards. Place empty array cards into unfilled slots.

IMPORTANT! Balance the loads in opposite buckets in the centrifuge.

c. Close the centrifuge cover, then spin the array card(s) for 1 minute at 1200 rpm.
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d. When the run is finished, stop the centrifuge, then spin the array card(s) again for 1 minute at
1200 rpm.

IMPORTANT! Do not try to save time by doing one spin for 2 minutes. The two sets of ramps
are important for a good fill into the array card.

7. When the second run is finished, open the centrifuge and check that the fluid levels in the
reservoirs of each array card have decreased by the same amount. Also, check all wells for
bubbles and note the locations as possible problems.

Correct fill Incorrect/partial fill

R (SO | [

If necessary, centrifuge the array cards for an additional minute to fill any unfilled wells. Do not
exceed three 1-minute runs or centrifuge the array card for longer than 1 minute at a time.

8. Seal the array card(s):

a. With the carriage (roller assembly) of the TagMan™
Array Card Sealer in the Start position, place a filled
array card into the fixture with the foil side up so
that the fill reservoirs are the farthest away from the
carriage.

b. Press down on all four corners of the array card to
ensure that it is fully seated within the fixture.

c. Use the two alignment pins in the fixture to position
the array card correctly.
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ROl calibration

)l

d. Seal the array card by running the carriage slowly
over it. Run the carriage over the array card in one
direction only. Do not apply downward force on the
carriage as you move it forward over the card.

e. Remove the sealed array card from the fixture and v
trim the fill reservoirs from the array card assembly o "
using scissors. Trim the foil array card so that the N ¥
edge is even with the plastic carrier.

IMPORTANT! Completely remove the fill reservoirs @ 9
from the array card so that the edge is free of

residual plastic. The plastic from the fill reservoirs

that extends beyond the edge of the card can j
prevent the array card from seating properly on the

sample block and can affect amplification.

Correct trim Incorrect trim

¢ @ @ @ @

9. Repeat step 8 to seal the remaining array cards.

IMPORTANT! If an array card is sealed improperly, it can leak and contaminate the sample block
and/or it can cause the associated calibration or RNase P test to fail.

IMPORTANT! As you seal the remaining filled array cards, store them in a dark place. Do not expose
the array cards to light until you are ready to use them. The dyes in the array cards are photosensitive.
Prolonged exposure to light can diminish the fluorescence of the dye.

ROI calibration

A region of interest (ROI) calibration maps the positions of the wells on the sample block of the
instrument. The software uses the ROI calibration data to associate increases in fluorescence during a
run with the wells on the plate or array card. The instrument uses a set of optical filters to distinguish
the fluorescence emissions gathered during runs. The software generates a calibration image for each
filter to account for minor differences in the optical path.
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When to perform the calibration

Perform the ROI calibration once every 6 months.

IMPORTANT! For the 96-well plate block and the 384-well plate block, after every ROI calibration, you
must perform (in order): a background calibration, uniformity calibration, and a dye calibration.

For the TagMan™ Array Card block, after every ROI calibration, you must perform (in order): a
background calibration, uniformity calibration, dye calibration, and a normalization calibration.

About the calibration data

During the ROI calibration, the instrument software captures images of the ROI calibration plate or
array card at each instrument filter. An ROI calibration passes if the collected image for each filter
distinguishes all wells of the ROI plate or array card. Each well in the image must be distinct and visible
at the same luminosity relative to the other wells in the image.

Note: You can review the ROI calibration image for each filter set by selecting the desired filter
combination from the Filter Set menu of the ROI tab in the Instrument Manager.

Passing image Failing image

X XXX/
)00
00000 OGOGS
09006

[ X XX X XXX )

X X X X X X X A N A A

2000000000046
2000000000

Red circles around some of the wells indicate that the
wells did not calibrate. The absence of a circle indicates
that the region of interest for the well position is not
sufficiently bright.

Green circles around all wells indicate that the
wells calibrated successfully. Each green circle
indicates that the region of interest for the well
position is sufficiently bright.

Preparing the calibration plate or array card

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare plates or array cards.

Prepare the calibration consumable appropriate for your QuantStudio™ 6 or 7 Flex System:

* “Prepare the ROI calibration plate” on page 43
* “Preparing array cards for instrument calibration” on page 37
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Prepare the ROI calibration plate

Materials required

Region of Interest (ROI) Plate
Centrifuge with plate adapter
Powder-free gloves

Safety goggles

Prepare the plate

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare the plate.

1.

Remove the ROI calibration plate from the freezer, then thaw it at room temperature for
approximately 30 minutes.

IMPORTANT! Use the calibration plate within 2 hours of defrosting it. Until you are ready to run
the plate, store it in the dark and at ambient temperature (15-30°C). Do not remove the calibration
plate from its packaging until you are ready to run it. The fluorescent dyes in the wells of the plate
are photosensitive. Prolonged exposure to light can diminish the fluorescence of the dyes.

2. Remove the ROI plate from its packaging. Do not remove the optical film.

3. Vortex and centrifuge the plate:

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems (v1.6.1 or later) Maintenance and Administration Guide

a. Vortex the ROI calibration plate for 5 seconds.

b. Centrifuge the plate for 2 minutes at < 1500 rpm.

IMPORTANT! The ROI calibration plate must be well mixed and centrifuged.

c. Confirm that the liquid in each well of the ROI calibration plate is at the bottom of the well. If
not, centrifuge the plate again at a higher rom and for a longer period of time.
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Perform the ROI calibration

44

1.

2.

In the QuantStudio™ Real-Time PCR Software Home tab, click Instrument Console.

In the Instrument Console, select the icon for your instrument, then click Manage Instrument.

Note: If the Manage Instrument button is inactive, add your system to the My Instruments
group.

In the Instrument Manager, start the calibration:
a. Click /X Maintenance, then click ROI.

b. In the ROI Calibration screen, click Start Calibration.
Click Next, then prepare for the calibration as instructed.

From the bottom of the Setup tab, enter the reagent information for the ROI plate or array card that
you are using.

Reagent Information

Plate Barcode Reagent Name Reagent Part Number Reagent Lot Number Reagent Expiration Date

[7] Check the box when the ROI calibration plate has been loaded, and when you have ensured you have entered all reagents information correctly

(G [ [

4k

Load the calibration plate or array card into the instrument:
a. From the instrument touchscreen, tap & to eject the instrument tray.
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b. Load the plate or array card into the plate holder so that:
¢ Well A1 of the plate or array card is in the top-left corner of the plate adapter.
* The barcode faces the front of the instrument.

(0000256 MMM )

IMPORTANT! Plates and array cards should be loaded and unloaded by operators who have
been warned of the moving parts hazard and have been adequately trained.

c. From the instrument touchscreen, tap & to close the instrument tray.

7. After loading the plate or array card, start the calibration:

a. At the bottom of the Setup tab, select Check the box when the ROI calibration plate has
been loaded, then click Next.

b. In the Run screen, click Start run.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while
the instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to 10 minutes) to allow the
heated cover to reach the required temperature.

8. When the run is complete and the software displays the Analysis screen, select each filter from the
Filter Set drop-down list, then confirm that the corresponding ROI Image displays a green circle
around each well area.
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9. After you inspect all ROl images, confirm the status of the calibration, where passed indicates that
the run produced viable calibration data, and failed indicates that the run did not produce data or
that the data it collected is unusable.

Analysis status Action
Passed Click Next.
Failed Troubleshoot the failed calibration (see “Troubleshooting”).

10. Unload the calibration plate or array card:
a. After the calibration, tap 3 on the touchscreen to eject the plate or array card.

Note: If the instrument does not eject the plate or array card, remove it as explained in
“Troubleshooting”.

b. Remove the ROI calibration plate or array card from the instrument tray and store it in the dark
at room temperature until you are ready to perform the uniformity calibration.

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the plate or array
card temperature can reach 100°C. Allow the consumable to cool to room temperature
before removing.

c. Tap & on the instrument touchscreen to close the instrument tray.

11. In the ROI Calibration screen, click Finish to complete the calibration, then click Yes when
prompted to save the results.

Note: If the QuantStudio™ Real-Time PCR Software displays the warning Saving ROI calibration
will invalidate other existing calibrations except HRM Calibrations, click OK to proceed.

Note: HRM (High Resolution Melt) is a separately licensed module. If your instrument requires this
module, contact Thermo Fisher Scientific.

12. (Optional) Click Print Report in the upper right corner of the screen to print a summary of the
calibration results for your records.

Background calibration

The software uses the background calibration data during subsequent experiments to remove
background fluorescence from the experiment data.

When to perform the calibration

Perform the background calibration monthly.
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About the calibration data

During the background calibration, the software captures a series of images of the background plate or
array card using each instrument filter. The software compares the fluorescence from each well to the
average for the plate or array card. A background calibration passes if the collected images for all filters
are free of abnormal fluorescence.

Background fluorescence

Fluorescence data collected by the instrument includes a fluorescence signal inherent to the instrument,
referred to as “background fluorescence.” Background fluorescence is a composite signal found in all
spectral data that consists of fluorescence from several sources, including:

* Background electronic signal
¢ Contaminants in the sample block
* The plastic consumable (plate or array card)

Preparing the calibration plate or array card

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare plates or array cards.

Prepare the calibration consumable appropriate for your QuantStudio™ 6 or 7 Flex System:
* “Prepare the background calibration plate” on page 47
* “Preparing array cards for instrument calibration” on page 37

Prepare the background calibration plate

Materials required

* Background Plate

* Centrifuge with plate adapter
* Powder-free gloves

* Safety goggles

Prepare the plate

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare the plate.

1. Remove the background calibration plate from the freezer, then thaw it at room temperature for
approximately 30 minutes.

IMPORTANT! Use the calibration plate within 2 hours of defrosting it. Until you are ready to run
the plate, store it in the dark and at ambient temperature (15-30°C). Do not remove the plate from
its packaging until you are ready to run it.
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2. Remove the background calibration plate from its packaging. Do not remove the optical film.

3. Vortex and centrifuge the plate:
a. Vortex the background calibration plate for 5 seconds.

b. Centrifuge the plate for 2 minutes at <1500 rpm.

IMPORTANT! The background calibration plate must be well mixed and centrifuged.

¢. Confirm that the liquid in each well of the background calibration plate is at the bottom of the
well. If not, centrifuge the plate again at a higher rom and for a longer period of time.

IMPORTANT! Do not allow the bottom of the plate to become dirty. Fluids and other
contaminants that adhere to the plate bottom can contaminate the sample block and cause
an abnormally high background signal.

Perform the background calibration

1. In the QuantStudio™ Real-Time PCR Software Home tab, click Instrument Console.

2. In the Instrument Console, select the icon for your instrument, then click Manage Instrument.

Note: If the Manage Instrument button is inactive, add your instrument to the My Instruments
group.

3. In the Instrument Manager, start the calibration:
a. Click /& Maintenance, then click Background.

b. In the Background Calibration screen, click Start Calibration.

4. Click Next, then prepare for the calibration as instructed.
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5.

At the bottom of the Setup tab, enter the reagent information for the background plate or array
card that you are using.

Reagent Information

Plate Barcode

Reagent Name Reagent Part Number

Reagent Lot Number Reagent Expiration Date

[7] Check the box when the background calibration plate has been loaded, and when you have ensured you have entered all reagents information correctly

Instrument Can...

* 287880008 x

]

Load the calibration plate or array card into the instrument:

a. From the instrument touchscreen, tap & to eject the instrument tray.

b. Load the calibration plate or array card into the plate holder so that:

Well A1 of the plate or array card is in the top-left corner of the plate adapter.
The barcode faces the front of the instrument.

(Cooooozse 1M )

IMPORTANT! Plates or array cards should be loaded and unloaded by operators who have
been warned of the moving parts hazard and have been adequately trained.

c. From the instrument touchscreen, tap B to close the instrument tray.

7. After loading the plate or array card, start the calibration:
a. In the Setup tab, select Check the box when the background calibration plate has been
loaded, then click Next.

b. From the Run screen, click Start Run.
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10.

11.

12.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while
the instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to 10 minutes) to allow the
heated cover to reach the required temperature.

When the run is complete and the QuantStudio™ Real-Time PCR Software displays the Analysis
screen, confirm the status of the calibration. The analysis status indicates the success of the
calibration, where passed indicates that the run produced viable calibration data, and failed
indicates that the run did not produce data or that the data it collected is unusable.

Analysis status Action
Passed Click Next.
Failed Troubleshoot the failed calibration (see “Troubleshooting”).

Note: Abnormal spectra or abnormally high background fluorescence can indicate the presence of
contamination on the plate or array card or sample block, which can cause the calibration to fail.

Select the QC tab to review the quality check summary. The QC status indicates the quality of

the calibration data, where Passed indicates that all wells produced data that passed the quality
check, and Failed indicates that one or more wells produced spectra that deviate significantly from
the other wells on the plate or array card.

Note: If the calibration failed, the QC tab can provide information regarding the cause of the
failure.

Unload the calibration plate or array card:
a. After the calibration, tap & on the touchscreen to eject the plate or array card.

Note: If the instrument does not eject the plate or array card, remove it as explained in
“Troubleshooting”.

b. Remove the plate or array card from the instrument tray and discard it.

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the plate or array
card temperature can reach 100°C. Allow the consumable to cool to room temperature
before removing.

c. Tap & on the instrument touchscreen to close the instrument tray.

From the Background Calibration screen, click Finish to complete the calibration, then click Yes
when prompted to save the results.

(Optional) Click Print Report in the upper right corner of the screen to print a summary of the
calibration results for your records.

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems (v1.6.1 or later) Maintenance and Administration Guide



Chapter 2 Calibrate the instrument M
Uniformity calibration

Uniformity calibration

The uniformity calibration generates data that allows the software to compensate for the physical
effects of the instrument filters.

When to perform the calibration

Perform a uniformity calibration once every 6 months.

Preparing the calibration plate or array card

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare plates or array cards.

Prepare the calibration consumable appropriate for your QuantStudio™ 6 or 7 Flex System:
* “Prepare the ROI calibration plate” on page 51
* “Preparing array cards for instrument calibration” on page 37

Prepare the ROI calibration plate

Materials required

Note: The uniformity calibration requires the same materials used to perform the ROI calibration.

* Region of Interest (ROI) Plate
* (Centrifuge with plate adapter
* Powder-free gloves

* Safety goggles

Prepare the plate

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare the plate.

If you have a prepared ROI calibration plate from a recent ROI calibration, go to step 3b; otherwise,
prepare the ROI calibration plate as follows:

1. Remove the ROI calibration plate from the freezer, then thaw it at room temperature for
approximately 30 minutes.

IMPORTANT! Use the calibration plate within 2 hours of defrosting it. Until you are ready to run
the plate, store it in the dark and at ambient temperature (15-30°C). Do not remove the plate from
its packaging until you are ready to run it.

2. Remove the ROI plate from its packaging. Do not remove the optical film.

3. Vortex and centrifuge the plate:
a. Vortex the ROI calibration plate for 5 seconds.
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b. Centrifuge the plate for 2 minutes at < 1500 rpm.

IMPORTANT! The ROI calibration plate must be well mixed and centrifuged.

¢. Confirm that the liquid in each well of the ROI calibration plate is at the bottom of the well. If
not, centrifuge the plate again at a higher rom and for a longer period of time.

Perform the uniformity calibration

52

—
.

In the QuantStudio™ Real-Time PCR Software Home tab, click Instrument Console.

In the Instrument Console, select the icon for your instrument, then click Manage Instrument.

Note: If the Manage Instrument button is inactive, add your instrument to the My Instruments
group.

From the Instrument Manager, start the calibration:
a. Click /A Maintenance, then click Uniformity.

b. From the Uniformity Calibration screen, click Start Calibration.
Click Next, then prepare for the calibration as instructed.

At the bottom of the Setup tab, enter the reagent information for the ROI plate or array card that
you are using.

Reagent Information

Plate Barcode Reagent Name Reagent Part Number Reagent Lot Number Reagent Expiration Date

[7] check the box when the ROI calibration plate has been loaded, and when you have ensured you have entered all reagents information correctly

(G [ [N

Instrument Con. .. * _ 2B7880008 x
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6. Load the calibration plate or array card into the instrument:
a. From the instrument touchscreen, tap B to eject the instrument tray.

b. Load the calibration plate or array card into the plate holder so that:
¢ Well A1 of the plate or array card is in the top-left corner of the plate adapter.
* The barcode faces the front of the instrument.
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IMPORTANT! Plates or array cards should be loaded and unloaded by operators who have
been warned of the moving parts hazard and have been adequately trained.

c. From the instrument touchscreen, tap B to close the instrument tray.

7. After loading the plate or array card, start the calibration:
a. In the Setup tab, select Check the box when the ROI calibration plate has been loaded,
then click Next.

b. In the Run screen, click Start Run.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while
the instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to 10 minutes) to allow the
heated cover to reach the required temperature.
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8. When the run is complete and the Analysis screen displays, confirm the status of the calibration.
The analysis status indicates the success of the calibration, where passed indicates that the run
produced viable calibration data, and failed indicates that the run did not produce data or that the
data it collected is unusable.

Analysis status Action
Passed Click Next.
Failed Troubleshoot the failed calibration (see “Troubleshooting”).

9. Select the QC tab to review the quality check summary.

Note: The QC tab can provide information on the cause of a failed calibration.

10. Unload the calibration plate or array card:

a. After the calibration, tap B on the touchscreen to eject the plate or array card.

Note: If the instrument does not eject the plate or array card, remove it as explained in
“Troubleshooting”.

b. Remove the calibration plate or array card from the instrument tray and discard it.

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the plate or array
card temperature can reach 100°C. Allow the consumable to cool to room temperature
before removing.

c. Tap B on the instrument touchscreen to close the instrument tray.

11. From the Uniformity Calibration screen, click Finish to complete the calibration, then click Yes
when prompted to save the results.

12. (Optional) Click Print Report in the upper right corner of the screen to print a summary of the
calibration results for your records.

Dye calibration

The software uses the calibration data collected from the dye standards to characterize and distinguish
the individual contribution of each dye in the total fluorescence collected by the instrument. After each
run, the instrument software receives data in the form of a raw spectra signal for each reading. The
software determines the contribution of the fluorescent dyes used in each reaction by comparing the
raw spectra to the pure spectra calibration data. When you save an experiment after analysis, the
instrument software stores the pure spectra with the collected fluorescence data for that experiment.
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When to perform the calibration

Perform a dye calibration once every 6 months.

IMPORTANT! Perform a background calibration before every series of dye calibrations. Because the
age and use of instrument components can affect spectra readings, you must perform a dye calibration
at least every 6 months.

About the dye calibration data

The product of a dye calibration is a collection of spectral profiles that represent the fluorescence
signature of each dye standard. Each profile consists of a set of spectra that correspond to the
fluorescence collected from the wells of the calibration plate or array card. Following the calibration of
each dye, the software “extracts” a spectral profile for each dye. The software plots the resulting data
for each profile in a graph of fluorescence versus filter.

When the software extracts the dye calibration data, it evaluates the fluorescence signal generated by
each well in terms of the collective spectra for the entire calibration plate or array card. Dye spectra
are generally acceptable if they peak within the same filter as their group, but diverge slightly at other
wavelengths (see below).

Acceptable spectra Unacceptable spectra

Spectra peak at the same wavelength and do not diverge
significantly

" Spectra peak at the different wavelengths
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Note: Because the wells of a calibration plate or array card contain identical concentrations of a dye,
the resulting signals for the wells should be similar. Variations in spectral position and peak position
are caused by minor differences in the optical properties and excitation energy between the individual
wells.
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Preparing the calibration plate or array card

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare plates or array cards.

Prepare the calibration consumable appropriate for your QuantStudio™ 6 or 7 Flex System:
* “Prepare the dye calibration plates” on page 56

* “Preparing array cards for instrument calibration” on page 37

Prepare the dye calibration plates

Required materials to prepare calibration plates

Spectral calibration plates for the QuantStudio™ 3 and 5 Instruments are used for the calibration
procedure with QuantStudio™ Real-Time PCR Software v1.6.1 or later.

Note: We recommend calibrating with all Spectral Dye Calibrations Plates available for your block
configuration even if you are not using all the dyes in the plates. This is recommended for optimal
system performance.

Table 2 Spectral calibration plates

Block Plate

QuantStudio™ 3/5 Spectral Calibration Plate 1, 96-Well 0.2-mL
(FAM™, VIC™, ROX™, SYBR™ dyes)

96-well 0.2-mL block | QuantStudio™ 3/5 Spectral Calibration Plate 2, 96-Well 0.2-mL
(ABY™, JUN™, MUSTANG PURPLE™ dyes)

QuantStudio™ 3/5 Spectral Calibration Plate 3, 96-Well 0.2-mL (TAMRA™, NED™, Cy®5 dyes)

QuantStudio™ 3/5 Spectral Calibration Plate 1, (FAM™, VIC™, ROX™, and SYBR™ dyes),
96-well, 0.1 mL

QuantStudio™ 3/5 Spectral Calibration Plate 2 (ABY™, JUN™, MUSTANG PURPLE™ dyes),

96-well 0.1-mL block | oo 1l (0.1-mL) plate

QuantStudio™ 3/5 Spectral Calibration Plate 3 (TAMRA™, NED™ and Cy®5 dyes)
96-well (0.1-mL) plate

QuantStudio™ 5 Spectral Calibration Plate 1, (FAM™, VIC™, ROX™
TAMRA™, and SYBR™ dyes), 384-well

384-well block
QuantStudio™ 5 Spectral Calibration Plate 2 (ABY™, JUN™, MUSTANG PURPLE™, NED™, and

Cy®5 dyes), 384-well

* (Centrifuge with plate adapter
* Powder-free gloves
e Safety goggles
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Prepare the plate

IMPORTANT! Before performing a dye calibration, you must perform an ROI calibration, a background
calibration, and a uniformity calibration.

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare the plate.

1. Remove the dye calibration plate from the freezer, then thaw it at room temperature for
approximately 30 minutes.

IMPORTANT! Use the calibration plates within 2 hours of defrosting them. Until you are ready to
run the plates, store them in the dark and at ambient temperature (15-30°C). Do not remove the
plates from their packaging until you are ready to run them.

2. Before using each dye plate, vortex the plate for 5 seconds, centrifuge it for 2 minutes at
< 1500 rpm, then confirm that the liquid in each dye plate is at the bottom of the wells. If not,
centrifuge the plate again at a higher rpom and for a longer period of time.

Perform the dye calibration

IMPORTANT! The software guides you through the calibration of each dye separately. You must set
up, run, and analyze each dye independently.

1. In the QuantStudio™ Real-Time PCR Software Home tab, click Instrument Console.

2. In the Instrument Console, select the icon for your instrument, then click Manage Instrument.

Note: If the Manage Instrument button is inactive, add your system to the My Instruments
group.

3. In the Instrument Manager, start the calibration:
a. Click /< Maintenance, then click Dye.
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b. In the Dye Calibration screen, select System Dye Calibration, then click Start Calibration.

4. In the Dye Calibration screen, select the plate and dye to calibrate from the Dye Name drop-
down list, then perform the calibration as instructed.

5. At the bottom of the Setup tab, enter the reagent information for the dye plate or array card that
you are using.

Reagent Information

Plate Barcode Reagent Name Reagent Part Number Reagent Lot Number Reagent Expiration Date
| B
[] Check the box when the dye calibration plate has been loaded, and when you have ensured you have entered all reagents information correctly

W Previous I"-,[-:v:t

Instiument Cen... " 287880008 x

6. Load the dye plate or array card into the instrument:
a. From the instrument touchscreen, tap & to eject the instrument tray.

b. Confirm that the dye plate or array card matches the dye selected in the software, then load it
into the plate holder.

Load the plate or array card so that:
¢ Well A1 of the plate or array card is in the top-left corner of the plate adapter.
* The barcode faces the front of the instrument.

QJDDDGISE |IIII|IIII|II|I|IIIIIIIIIIII)‘

Note: The name of the dye contained by the plate or array card is next to the barcode on the
front of it.

IMPORTANT! Plates or array cards should be loaded and unloaded by operators who have
been warned of the moving parts hazard and have been adequately trained.
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c. From the instrument touchscreen, tap & to close the instrument tray.

After loading the plate or array card, start the calibration:

a. In the Dye Calibration screen, select Check the box when the dye calibration plate has
been loaded, then click Next.

b. In the Run screen, click Start Run.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked while
the instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to 10 minutes) to allow the
heated cover to reach the required temperature.

When the run is complete and the software displays the Analysis screen, confirm the grouping of
the dye spectra:

a. Select the Plate Layout tab, then review the raw data. For each spectrum, confirm that the
peak is:

* Within the detectable range for the QuantStudio™ 6 and 7 Flex Systems.
* Free of irregular spectral peaks.

* Present at the correct filter for the dye (see “Instrument filters and supported dyes” on
page 16).

Note: Among wells containing the same dye, variations in spectral position and peak position
are caused by minor differences in the optical properties and excitation energy between the
individual wells.

b. Select the QC tab, then review the summary of wells that failed the quality check (QC).

After you inspect the dye spectra, confirm the analysis status of the calibration. The analysis status
indicates the success of the calibration, where passed indicates that the run produced viable
calibration data, and failed indicates that the run did not produce data or that the data it collected
is unusable.

Analysis status Action

1. Click Next.

Passed 2. Enter comments in the Comments field, click Finish, then click Yes when
prompted to save the results.

Failed Troubleshoot the failed calibration (see “Troubleshooting”).

Select the QC tab to review the quality check summary. The QC status indicates the quality of
the calibration data, where passed indicates that all wells produced data that passed the quality
check, and failed indicates that one or more wells produced dye spectra that differ significantly
from the other wells on the plate or array card.

Note: If the calibration failed, the QC tab can provide information regarding the cause of the
failure.
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11. Unload the calibration plate or array card:
a. After the calibration, tap B on the touchscreen to eject the plate or array card.

Note: If the instrument does not eject the plate or array card, remove it as explained in
“Troubleshooting”.

b. Remove the calibration plate or array card from the instrument tray and discard it.

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the plate or array
card temperature can reach 100°C. Allow the consumable to cool to room temperature
before removing.

c. Touch & on the instrument touchscreen to close the instrument tray.

12. Repeat the calibration to calibrate the instrument for the remaining dyes that are present in the
experiments that you will be running.

13. (Optional) Click Print Report in the upper right corner of the screen to print a summary of the
calibration results for your records.

Normalization calibration (TagMan™ Array Card only)

During the normalization calibration, the instrument collects and stores the data from the normalization
standards.

IMPORTANT! Normalization calibration is only required for the TagMan™ Array Card block.
Normalization calibration is not required for the 96-well plate blocks or the 384-well plate block.

When to perform the calibration

For the TagMan™ Array Card block, perform a normalization calibration once every 6 months.

About the calibration data
During the normalization calibration, the software captures a series of images of each normalization

array card using each instrument filter. The normalization calibration yields a “Pass” or “Fail” result for
each normalization consumable used.

Preparing the calibration array card

IMPORTANT! Wear powder-free gloves and safety glasses when you prepare the array cards.

For detailed instructions to prepare the calibration array card, see “Preparing array cards for instrument
calibration” on page 37.
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Normalization calibration (TagMan™ Array Card only)

Perform the normalization calibration

Normalization calibration is only required for the TagMan™ Array Card block.

1. In the QuantStudio™ Real-Time PCR Software Home tab, click Instrument Console.

2. In the Instrument Console, select the icon for your instrument, then click Manage Instrument.

Note: If the Manage Instrument button is inactive, add your system to the My Instruments
group.

3. In the Instrument Manager, start the calibration:
a. Click /< Maintenance, then click Normalization.

b. In the Normalization Calibration screen, click Start Calibration.

4. In the Normalization Calibration screen, select the reporter and passive dye combination that you
want to calibrate, then perform the calibration as instructed.

5. At the bottom of the Setup tab, enter the reagent information for the array card that you are using.

Reagent Information

| Plate Barcode Reagent Name Reagent Part Number Reagent Lot Number Reagent Expiration Date

[] Check the box when the normalization calibration plate has been loaded, and when you have ensured you have entered all reagents information correctly

Instrument Cen, ., * 287880008 x

6. Load the array card into the instrument:
a. From the instrument touchscreen, tap B to eject the instrument tray.
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b. Confirm that the array card matches the selection in the software, then load it into the card
holder so that:

¢ Well A1 of the array card is in the top-left corner of the adapter.

* The barcode faces the front of the instrument.
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Note: The dyes contained in each array card appear next to the barcode on the front of it.

IMPORTANT! Array cards should be loaded and unloaded by operators who have been
warned of the moving parts hazard and have been adequately trained.

c. From the instrument touchscreen, touch & to close the instrument tray.

7. After loading the array card, start the calibration:
a. In the Normalization Calibration screen tab, select Check the box when the normalization
calibration plate has been loaded, then click Next.

b. In the Run screen, click Start Run.

IMPORTANT! Do not attempt to open the access door during the run. The door is locked
while the instrument is in operation.

Note: Before starting the calibration, the instrument may pause (up to 10 minutes) to allow
the heated cover to reach the required temperature.
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8. When the run is complete and the QuantStudio™ Real-Time PCR Software displays the Analysis
screen, confirm the status of the calibration. The analysis status indicates the success of the
calibration, where passed indicates that the run produced viable calibration data, and failed
indicates that the run did not produce data or that the data it collected is unusable.

Analysis status Action
Passed Enter comments in the Comments field, click Next.
Failed Troubleshoot the failed calibration (see “Troubleshooting” on page 76).

9. Select the QC tab to review the quality check summary. The QC status indicates the quality of
the calibration data, where passed indicates that all wells produced data that passed the quality
check, and failed indicates that one or more wells produced unusable data.

Note: If the calibration failed, the QC tab can provide information regarding the cause of the
failure.

10. Unload the array card:
a. After the calibration, tap B on the touchscreen to eject the array card.

Note: If the instrument does not eject the array card, remove it as explained in
“Troubleshooting” on page 76.

b. Remove the array card from the instrument tray and discard it.

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the array card
temperature can reach 100°C. Allow the consumable to cool to room temperature before
removing.

c. Tap & on the instrument touchscreen to close the instrument tray.

11. In the Normalization Calibration screen, click Finish to complete the calibration, then click Yes
when prompted to save the results.

12. Repeat the calibration procedure to perform the remaining normalization calibration.

13. (Optional) Click Print Report in the upper right corner of the screen to print a summary of the
calibration results for your records.

Verify the instrument performance

When necessary, you can perform the RNase P instrument verification test to confirm the performance
of the QuantStudio™ 6 and 7 Flex Systems.
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When to perform the test

We recommend performing an RNase P instrument verification test:
* After moving the instrument to another location.
* As needed to confirm the function of the instrument.

About the RNase P kits

The RNase P instrument verification test uses instrument verification kits available from
thermofisher.com. The kits differ only in the consumable format for which they are designed: an RNase
P Instrument Verification Plate for QuantStudio™ 6 and 7 Flex Systems with 96/384-well sample blocks
and an Array Card RNase P Kit for the QuantStudio™ 7 Flex System with array card sample blocks.

RNase P instrument verification plates

The RNase P plate is preloaded with the reagents necessary for the detection and quantitation of
genomic copies of the human RNase P gene (a single-copy gene encoding the RNase moiety of the
RNase P enzyme). Each well contains: PCR master mix, RNase P primers, FAM™ dye-labeled probe,
and a known concentration of human genomic DNA template.

Figure 5 illustrates the arrangement of the standard and unknown populations on a 96-well and Fast
96-well RNase P plate. The RNase P plate contains five replicate groups of standards (1250, 2500,
5000, 10000, and 20000 copies), two unknown populations (5,000 and 10,000 copies), and a no
template control (NTC).

1 2 3 4 5 6 7 8 9 10 11 12 "\

Unknown A
(5000]

e

T o m o m O O m I=

NTC STD 1250 STD 2500
STD 5000 STD 10000 | STD 20000

Unknown B
(10000)

== = e EEE——————————————)

Figure 5 96-well and Fast 96-well RNase P plate layout

Figure 6 illustrates the arrangement of the standard and unknown populations on a 384-well RNase P
plate. The RNase P plate contains five replicate groups of standards (1250, 2500, 5000, 10000, and
20000 copies), two unknown populations (5,000 and 10,000 copies), and a no template control (NTC).
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Figure 6 384-well RNase P plate layout

Array card RNase P kits

The RNase P Kits include one empty array card and eight tubes of solution. Each tube contains
reaction mix (PCR master mix, RNase P primers, and FAM™-MGB dye-labeled probe) and a known
concentration of human genomic DNA template.

To perform an instrument verification run, each solution is loaded into the empty array card in the
arrangement shown in Figure 7. When complete, the array card contains five replicate groups of
standards (200, 400, 800, 1600, and 3200 copies), two of unknown populations (800 and 1600 copies),
and one that serves as a no template control (NTC).
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Analytical performance

The software performs the same analysis of data from an instrument verification run regardless of the
type of consumable used.

After the run, the software:

1. Generates a standard curve from the averaged threshold cycle (Cy) values of the replicate groups of
standards.

2. Calculates the concentration of the two unknown populations using the standard curve.

3. Calculates the following to assess the QuantStudio™ 6 or 7 Flex System performance:

[(CopyUnka) — 3(dcopyunk2)] > [(CopyUnky) + 3(0copyunki)]
where:

* CopyUnky = Average copy number of unknown population A
®  Ocopyunki = Standard deviation of unknown population A
* CopyUnks, = Average copy number of unknown population B
® Ocopyunke = Standard deviation of unknown population B

Note: Unknown population A refers to the 5,000-copy population and unknown population B
refers to the 10,000-copy population in the RNase P plate.
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The QuantStudio™ 6 or 7 Flex System passes the installation specification if the inequality holds and
the instrument successfully distinguishes between unknown populations A and B with a statistical
confidence level of 99.7%.

As shown in the following table, you can omit a limited number of outlier wells from the unknown
populations to meet the installation specification.

Maximum number of outlier wells that can be removed
Sample block Unknown population | Unknown population Standards (STD)l3 No template controls
ALl Bl2 (NTC)
96-well platel! 6 6 1 0
384-well plate 10 10 2 0
Array card!®! 4 4 4 0

11 5,000-copy population for 384-well plates; 800-copy population for array cards.

2l 10,000-copy population for 384-well plates; 1,600-copy population for array cards.
Bl Maximum number of wells that can be removed from each standard population.

4 Standard 96-well plates or Fast 96-well plates

5l QuantStudio™ 7 Flex System only.

Prepare the RNase P plate

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems (v1.6.1 or later) Maintenance and Administration Guide

Materials required

* RNase P Instrument Verification Plate
¢ Centrifuge with plate adapter

* Powder-free gloves

¢ Safety goggles

Prepare the plate

IMPORTANT! When performing the RNase P instrument verification test:

. Perform all calibrations beforehand.

. Run the RNase P plate soon after you allow the plate to thaw. Minimizing the time that the prepared
plate or array card sits on the bench ensures optimal performance.
. Wear powder-free gloves and safety glasses when you prepare plates.

1. Obtain the RNase P Instrument Verification Plate from the freezer, then allow the plate to warm to
room temperature (for approximately 5 minutes).

IMPORTANT! Use the RNase P plate within 30 minutes of defrosting it. Until you are ready to run
the plate, store it in the dark and at ambient temperature (15-30°C). Do not remove the plate from
its packaging until you are ready to run it.
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2. Remove the RNase P plate from its packaging.

3. Briefly vortex and centrifuge the RNase P plate:
a. Vortex the plate for 5 seconds.

b. Centrifuge the reaction plate for 2 minutes at < 1500 rpm.

IMPORTANT! The reaction plate must be well mixed and centrifuged.

c. Confirm that the liquid is at the bottom of each well of the reaction plate. If not, centrifuge the
reaction plate again at a greater rpm and for a longer period of time.

IMPORTANT! Do not allow the bottom of the plate to become dirty. Fluids and other
contaminants that adhere to the bottom of the reaction plate can contaminate the sample
block and cause an abnormally high background.

Preparing an array card for instrument verification

IMPORTANT! Perform the following procedure only if you are verifying the performance of a
QuantStudio™ 7 Flex System with an array card sample block.

Required materials

* TagMan™ Array Card Sealer

* Centrifuge with centrifuge array card carrier clips and buckets
* Powder-free gloves

* Safety goggles

* Pipettor, 200-pL (with pipette tips)
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* ViiA™ 7 Array Card RNaseP Verification Kit, includes the following components:
- TagMan™ Array Card

— Eight (8) vials of RNase P detection reagents, one for each port in the TagMan™ Array Card.
Each vial contains the following reagents:

— PCR master mix

— RNase P primers

- A FAM™ dye-labeled probe

— A known concentration of human genomic DNA template

Preparing the RNase P array card

IMPORTANT! Wear powder-free gloves while preparing the array card.

1. Remove the Array Card RNase P Kit from the freezer, then allow it to warm to room temperature
(for approximately 15 minutes).

IMPORTANT! You must fill and run the RNase P array card within 60 minutes of thawing the Array
Card RNase P Kit.

2. Remove an array card from its box and place it on a clean, dry surface.

3. Using a permanent marker, mark the side of the empty array card with RNase P.

A<,
ANRAAALZS
Aadadadadadindnd:

(D Mark here
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4. Transfer 100 pL of each solution into the appropriate port of the array card:
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(1) No Template Control (5) standard 400
(2 Unknown A (800) (®) Standard 800
(3) Unknown B (1600) (@) Standard 1600
(@ standard 200 Standard 3200

For each transfer:
a. Place the array card on a lab bench, with the foil side down.

b. Load 100 pL of fluid into a pipette.

¢. Hold the pipette in an angled position (~45 degrees) and place the tip into the fill port. The fill
port is the larger of the two holes on the left side of the fill reservaoir.

?
>

I_ﬂf

(@ Fill port

(@) Vent port
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d. Dispense the fluid so that it sweeps in and around the fill reservoir toward the vent port. Pipet
the entire 100 pL into the reservoir, but do not go past the first stop of pipettor plunger or you
may blow the solution out of the port.

IMPORTANT! Do not allow the tip to contact and possibly damage the coated foil beneath
the fill port.

5. Centrifuge and seal the array card as explained in step 6 through step 8 in “Fill the calibration
TagMan™ Array Cards” on page 38.

6. Run the prepared array card as soon as possible after filling it.

IMPORTANT! Store the array card in a dark place until you are ready to run it. The fluorescent dyes in
the array card are photosensitive. Prolonged exposure to light can diminish the fluorescence of the dye.

Run the RNase P plate or array card

1. In the QuantStudio™ Real-Time PCR Software Home tab, click Instrument Console.

2. In the Instrument Console, select the icon for your instrument, then click Manage Instrument.

Note: If the Manage Instrument button is inactive, add your system to the My Instruments
group.

3. In the Instrument Manager, start the RNase P run:
a. Click ,/{ Maintenance, then click RNase P Run.

b. In the RNase P Run screen, click Start RNase P Run.

4. Click Next, then prepare for the instrument verification test as instructed.
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5. At the bottom of the Setup tab, enter the reagent information for the RNase P plate or array card
that you are using.

Reagent Information

Plate Barcode Reagent Name Reagent Part Number Reagent Lot Number Reagent Expiration Date

|

[7] Check the box when the RNase P plate has been loaded, and when you have d you have entered all reagents information correctly

s

= 287880008 X

6. Load the RNase P plate or array card into the instrument:
a. From the instrument touchscreen, tap & to eject the instrument tray.

b. Load the plate or array card into the plate holder so that:
* Well A1 of the plate or array card is in the top-left corner of the adapter.
* The barcode faces the front of the instrument.

[:ﬂﬂmi.'rISE |IIII|IIII|II|I|IIIIIIIIIIII)

IMPORTANT! Plates and array cards should be loaded and unloaded by operators who have
been warned of the moving parts hazard and have been adequately trained.

c. From the instrument touchscreen, touch & to close the instrument tray.

7. After loading the plate or array card, start the instrument verification test:

a. In the Overview screen, select Check the box when the RNase P plate has been loaded,
then click Next.

b. In the Run screen, click Start Run to start the test.
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IMPORTANT! Do not attempt to open the access door during the run. The door is locked while
the instrument is in operation.

Note: Before starting the instrument verification test, the instrument may pause (up to 10 minutes)
to allow the heated cover to reach the required temperature.

8. When the run is complete and the software displays the Analysis screen, confirm the status of the
run.

Analysis

status Action

Passed The system passed the RNase P run.

The system failed the RNase P run. Review the data for outliers.

If the run fails, the software may have included outliers that caused the initial analysis to
fail. Error may cause some wells to be amplified insufficiently or not at all. These wells
typically produce C; values that differ significantly from the average for the associated
replicate wells. If included in the calculations, these outlying data (outliers) can result in
erroneous measurements.

Failed

9. In the Amplification Plot, select Ct vs. Well from the Plot Type menu.

10. Confirm the uniformity of each replicate population (controls, standards, and unknowns) on the
plate or array card by comparing the groupings of C; values:

a. In the Plate Layout, select the wells containing Unknown Population A:

b. From the plot, confirm that the C; values of the replicate population are equivalent.

Note: The numbers on the X-axis of the plot correspond to the wells of the plate or array
card. Beginning with well A1, the wells are numbered from left-to-right, and top-to-bottom.

c. If an outlier is present in the selected population, select the corresponding well of the plate
layout, then click Omit to remove the well from the analysis. If the total number of outliers
for the replicate population exceeds the limit in the table below, repeat the test using another
RNase P plate or array card.

Maximum number of outlier wells that can be removed
Sample block Unknown Unknown No template
3] P
population Al'l population B2 SEMEELEE (ST controls (NTC)

96-well platel! 6 6 1 0
384-well plate 10 10 2 0
TagMan™ Array

Cardls) 4 4 4 0

11 5,000-copy population for 384-well plates; 800-copy population for array cards.

[ 10,000-copy population for 384-well plates; 1,600-copy population for array cards.
Bl Maximum number of wells that can be removed from each standard population.

4l Standard 96-well plates or Fast 96-well plates

51 QuantStudio™ 7 Flex System only.
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11. Repeat step 10 for each replicate population (unknowns, standards, and no template controls) on
the plate or array card.

12. Review the Results Table for quality flags generated by the test:
a. Select the Results Table tab.

b. Review the Flag column for wells that generated quality flags.

c. Troubleshoot each well that generated a flag as explained in “Troubleshooting”.
¢ AMPNC —Amplification in negative control
* BADROX-—Bad passive reference signal
¢ BLFAIL—Baseline algorithm failed
® CTFAIL—C; algorithm failed
¢ EXPFAIL —Exponential algorithm failed
* HIGHSD —High standard deviation in replicate group
* NOAMP —No amplification
* NOISE—Noise higher than others on the consumable
* NOSIGNAL—No signal in well
* OFFSCALE—Fluorescence is offscale
* OUTLIERRG—Outlier in replicate group
* SPIKE—Noise spikes
¢ THOLDFAIL—Thresholding algorithm failed

13. If you omitted outliers, click Reanalyze to analyze the run.

If the status of the RNase P Run is Failed after performing step 8-12, repeat the RNase P test
using a different RNase P plate or array card. If the problem persists, contact Technical Support.

14. Review the standard curve:
a. Select the Standard Curve tab.

b. Click the upper-left corner of the Plate Layout to select all wells.
c. Confirm that the R? value is =0.990.

If the R? value is <0.990, repeat the RNase P test using a different RNase P plate or array card. If
the problem persists, contact Technical Support.

15. In the Analysis screen, click Next, remove the plate or array card when the instrument ejects the
tray arm, then discard the consumable.

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the plate or array
card can reach 100°C. Before removing the consumable, be sure to wait until it reaches room
temperature.
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Note: If the instrument does not eject the plate or array card, remove it as explained in
“Troubleshooting”.

16. Click Finish, then click Yes when prompted to save the test.

17. (Optional) Click Print Report in the upper right corner of the screen to print a summary of the
RNase P test results for your records.
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Troubleshooting

The tables in this section describe how to troubleshoot failed calibrations and RNase P instrument
verification tests.
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Table 3 ROI calibration troubleshooting

Chapter 2 Calibrate the instrument ~ EF18
Troubleshooting

Problem/symptom

Possible cause

Action

ROI calibration failed.
¢ ROl image is blurry
* ROl image is faint

Plate or array card was
centrifuged insufficiently.

Plate or array card
contains old or
insufficient reagents.

The sample block or
heated cover may not
be seated correctly.

/\  CAUTION! PHYSICAL INJURY HAZARD.

1.

5.

During operation, the sample block can reach
100°C. Before removing the plate or array card,
wait until the block reaches room temperature.

Unload the instrument and confirm that you loaded
the correct plate or array card. If not, perform

the calibration again using the correct type of
consumable.

View the wells of the plate or array card. If the
liquid in the wells is not:

* At the bottom of the wells, centrifuge the plate
or array card for a longer time, then repeat the
calibration.

* FEquivalent in volume, the plate or array card
is not sealed properly and the reagents have
evaporated. Discard the consumable and run
another.

If the calibration plate or array card appears to be
normal, discard it and run another.

If the calibration fails again, check the sample
block and heated cover positions (see Figure 8 on
page 78):

a. Power off and unplug the instrument. Wait
15 minutes, then open the access door.

b. Firmly push the sample block and the heated
cover toward the back of the instrument to
confirm that they are seated correctly.

IMPORTANT! Align the arrows on the front
handle of the heated cover as shown. If

the arrows are not aligned, push the heated
cover into the instrument until the handle
locks into place.

IMPORTANT! Confirm that the indicator

on the left side of the sample block is
positioned behind the red line on the
instrument rail. If not, push the sample block
into the instrument until it is seated correctly.

c. Repeat the calibration.

If the calibration fails again, contact Technical
Support.
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Table 3 ROI calibration troubleshooting (continued)

Problem/symptom

Possible cause

Action

Instrument does not eject
the ROI plate or array
card (it is stuck within the
instrument).

The adhesive cover may
have adhered the plate or
array card to the heated
cover.

Remove the plate or array card from the instrument
as explained in “Remove a plate stuck within the
instrument” on page 87.

Instrument malfunction.

Multiple possible causes.

Contact your local Thermo Fisher Scientific Field
Service Office.

Figure 8 Check sample block and heated cover positions
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Problem/symptom Possible cause

Action

Background calibration *
failed.

* Plate or array card

reagents.

card produced spectra

Plate or array card was
centrifuged insufficiently.

contains old or insufficient

* One or more wells of the
background plate or array

that exceed the maximum
limit for the instrument.

& CAUTION! PHYSICAL INJURY HAZARD.
During operation, the sample block can reach
100°C. Before removing the plate or array card,
wait until the block reaches room temperature.

1. Unload the QuantStudio™ 6 or 7 Flex System
and confirm that you loaded the correct plate
or array card into the instrument. If not, perform
the calibration again using the correct type of
consumable.

2. View the wells of the plate or array card. If the
liquid in the wells of the consumable is not:

* At the bottom of the wells, centrifuge the plate
or array card for a longer time, then repeat the

calibration.

¢ Equivalent in volume, the plate or array card

is

not sealed and the reagents have evaporated.

Discard the consumable and run another.
3. If the calibration plate or array card appears to be
normal, discard it and run another.
4. If the calibration fails again, determine the source
of the contamination, as explained in “How to
identify contamination” on page 86.

Instrument does not

eject the background
plate or array card

(it is stuck within the

instrument).

instrument.

The adhesive cover may have
adhered the plate or array card
to the heated cover within the

Remove the plate or array card from the instrument
as explained in “Remove a plate stuck within the
instrument” on page 87.

Instrument malfunction. | Multiple possible causes.

Contact your local Thermo Fisher Scientific Field
Service Office.
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Table 5 Uniformity calibration troubleshooting

Problem/symptom Possible cause Action
Uniformity calibration | ¢ Plate or array A\ CAUTION! PHYSICAL INJURY HAZARD. During
failed. card was centrifuged

operation, the sample block can reach 100°C.

insufficiently. Before removing the plate or array card, wait until

* Plate or array card the block reaches room temperature.
contains old or
insufficient reagents. 1. Unload the QuantStudio™ 6 or 7 Flex System and

e Abnormally low spectra confirm that you loaded the correct plate or array card
across all wells of the into the instrument. If not, perform the calibration again
plate or array card. using the correct type of consumable.

2. Unload the QuantStudio™ 6 or 7 Flex System and view
the wells of the plate or array card. If the liquid in the
wells of the consumable is not:

* At the bottom of the wells, centrifuge the plate
or array card for a longer time, then repeat the
calibration.

¢ Equivalent in volume, the plate or array card is not
sealed and the reagents have evaporated. Discard
the consumable and run another.

3. If the calibration plate or array card appears to be
normal, discard it and run another.

4. If the calibration fails again, contact Technical Support.

One or more wells 1. While viewing the calibration data in the Analysis
produced spectra that screen, locate the well(s) with abnormal signal in the
deviate significantly from Plate Layout tab.

the rest of the plate orarray | 5 Rotate the plate or array card 180°, then perform the

card. calibration again.

3. Determine the location of the contaminated wells again.
If the position(s) of the well(s) identified in the steps
above are:

® |dentical - The sample block is contaminated.
Decontaminate the sample block.

* Reversed - The ROI plate or array card is
contaminated. Discard the consumable, then
perform the uniformity calibration using a new ROI
plate or array card.

4. |If the calibration fails again, contact Technical Support.
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Table 5 Uniformity calibration troubleshooting (continued)

Problem/symptom

Possible cause

Action

Instrument does not
eject the ROI plate
or array card (the
consumable is stuck

The adhesive cover may
have adhered the plate or
array card to the heated
cover within the instrument.

within the instrument).

Remove the plate or array card from the instrument as
explained in “Remove a plate stuck within the instrument”
on page 87.

Instrument
malfunction.

Multiple possible causes.

Contact your local Thermo Fisher Scientific Field Service
Office.

Table 6 Dye calibration troubleshooting

Problem/symptom

Possible cause

Action

Dye calibration failed.

One or more raw spectra are
at or below the detectable
threshold for the calibration.

* Dye plate or array
card was centrifuged
insufficiently.

* Dye plate or array
card contains old or
insufficient reagents.

& CAUTION! PHYSICAL INJURY HAZARD.
During operation, the sample block can reach
100°C. Before removing the plate or array
card, wait until the block reaches room
temperature.

1. Unload the QuantStudio™ 6 or 7 Flex System
and view the wells of the plate or array card. If
the liquid in the wells of the consumable is not:

* At the bottom of the wells, centrifuge the
plate or array card for a longer time, then
repeat the calibration.

¢ Equivalent in volume, the plate or array
card is not sealed and the reagents have
evaporated. Discard the consumable and
run another.

2. If the dye calibration plate or array card appears
to be normal, discard it and run another.

3. If the problem persists, contact Technical
Support.

® Spectra contain peaks in
more than one filters.

* One or more raw spectra
exceed the maximum
limit for the instrument.

Fluorescent contaminants
are present on the sample
block or dye plate or array
card.

Confirm that contaminants are not present by
performing a background calibration. If the
background calibration does not show sample block
contamination, the dye plate or array card may be
contaminated.

Instrument does not eject the
dye plate or array card (the
consumable is stuck within
the instrument).

The adhesive cover may
have adhered the plate or
array card to the heated
cover within the instrument.

Remove the plate or array card from the instrument
as explained in “Remove a plate stuck within the
instrument” on page 87.

Instrument malfunction.

Multiple possible causes.

Contact your local Thermo Fisher Scientific Field
Service Office.
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Table 7 Normalization calibration troubleshooting (TagMan™ Array Card block only)

Problem/symptom

Possible cause

Action

Normalization
calibration failed.

Abnormally low
spectra across all
wells of the array
card.

/\ CAUTION! PHYSICAL INJURY HAZARD. During

operation, the sample block can reach 100°C. Before
removing the array card, wait until the block reaches room
temperature.

Unload the QuantStudio™ 7 Flex System and confirm that
you loaded the correct array card into the instrument. If not,
perform the calibration again using the correct consumable.

If you are using the correct array card, perform the calibration
again using a different normalization consumable.

If the calibration fails again, contact your local Thermo Fisher
Scientific Field Service Office.

One or more

wells produced
spectra that deviate
significantly from the

rest of the array card.

4.

. While viewing the calibration data in the Analysis screen,

locate the well(s) with abnormal signal in the Plate Layout tab.
Rotate the array card 180°, then perform the calibration
again.

Determine the location of the contaminated wells again. If the
position(s) of the well(s) identified in the steps above are:

¢ Identical: The sample block is contaminated.
Decontaminate the sample block.

* Reversed: The normalization array card is contaminated.
Discard the consumable, then perform the normalization
calibration using a new normalization array card.

If the calibration fails again, contact your local Thermo Fisher
Scientific Field Service Office.

Instrument does not
eject the normalization
array card (it is stuck
within the instrument).

An adhesive cover
may have adhered
the array card to the
heated cover within
the instrument.

Remove the array card from the instrument (see “Remove a plate
stuck within the instrument” on page 87).

Instrument malfunction.

Multiple possible
causes.

Contact your local Thermo Fisher Scientific Field Service Office.
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Problem/symptom

Possible cause

Action

RNase P plate or array card
verification run failed.

* Contamination
¢ Defective seal

* Inaccurate fluid
transfer during plate
or array card
manufacturing

¢ [nsufficient
centrifugation

/\ CAUTION! PHYSICAL INJURY HAZARD.

1.

During operation, the sample block can reach
100°C. Before removing the plate or array card,
wait until the block reaches room temperature.

Unload the RNase P plate or array card from the
instrument.

Hold the plate or array card up to a light source, and

confirm that all wells contain the same volume of
fluid.

If there are differences in fluid volumes, check the
heat seal of the wells with lower volumes for signs
of damage or evaporation.

Compare the position of the wells that have lower
volumes with the outliers that you have removed
from the plate or array card. If the well positions
coincide, the heat seal on the consumable may
be defective, resulting in the evaporation of the
associated samples.

Contact Thermo Fisher Scientific to order a
replacement RNase P plate or array card. If the
replacement consumable fails, contact Technical
Support for assistance.

Instrument does not eject
the RNase P plate or array
card (the consumable is
stuck within the instrument).

Adhesive cover may have
adhered the plate or array
card to the heated cover
within the instrument.

Remove the plate or array card from the instrument
as explained in “Remove a plate stuck within the
instrument” on page 87.

Negative control well
displays the AMPNC flag,
indicating that the well
amplified.

Contamination in one
or more PCR reaction
components contained in
the negative control well.

Contact Thermo Fisher Scientific to order a replacement
RNase P plate or array card kit. If the replacement

RNase P consumable fails, contact Technical Support for
assistance.
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Table 8 RNase P test troubleshooting (continued)

Problem/symptom

Possible cause

Action

Well displays the BADROX™
flag, indicating that the
passive reference signal

is unacceptable for the
normalization of the reporter
dye signal.

Droplets on the sides
of the wells

Improper sealing or
seal leaks

Condensation on the
plate or array card

If a well is flagged, confirm the results:

1.

Select the flagged well(s) in the plate layout or well
table.

View the amplification plot (R, vs. Cycle), and review
the data in the C; region for abnormalities.

Examine the plate or array card to check for
condensation and/or inconsistent reaction volumes.

Contact Thermo Fisher Scientific to order a
replacement RNase P plate or array card. Repeat
the test and make sure to properly centrifuge the
RNase P consumable. If the replacement RNase P
plate or array card fails, contact Technical Support
for assistance.

Well displays the BLFAIL
flag, indicating that the
software cannot calculate
the best fit baseline for the
data.

Amplification too late
No amplification

* Well displays the
CTFAIL flag, indicating
that the software
cannot calculate the
threshold cycle (Cy).

* Well displays the
EXPFAIL flag, indicating
that the software
cannot identify the
exponential region of
the amplification plot.

Amplification too
early

Amplification too late
Low amplification
No amplification

If a well is flagged, confirm the results:

1.

Select the flagged well(s) in the plate layout or well
table.

View the ampilification plot (R, vs. Cycle and DR,
vs. Cycle) and check for early, late, low, or no
amplification.

Contact Thermo Fisher Scientific to order a
replacement RNase P plate or array card. Repeat
the test, making sure to properly seal and centrifuge
the RNase P plate or array card. If the replacement
RNase P plate or array card fails, contact Technical
Support for assistance.

Well displays the HIGHSD
flag, indicating that the C;
standard deviation for the
replicate group exceeds the
current flag setting.

Droplets on the sides
of the wells

Improper sealing or
seal leaks

Condensation on the
plate or array card

Inconsistent volumes
across the plate or
array card

Well displays the NOAMP
flag, indicating that the
sample did not amplify.

Missing template

Excitation source
in the instrument
stopped functioning

If a well is flagged, confirm the results:

1.

2.

3.

Select the flagged well(s) and the associated
replication group(s) in the plate layout or well table.

View the amplification plot (R, vs. Cycle), and review
the data for abnormalities.

Hold the plate or array card up to a light source, and
check for condensation or evaporation.

If there are differences in fluid volumes, check the
heat seal of the wells with lower volumes for signs
of damage or evaporation.

Contact Thermo Fisher Scientific to order a
replacement RNase P plate or array card. Repeat
the test, and make sure to properly centrifuge the
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Problem/symptom

Possible cause

Action

Well displays the NOISE
flag, indicating that the well
produced more noise in the
amplification plot than other
wells on the plate or array
card.

Droplets on the sides
of the wells

Improper sealing or
seal leaks

Condensation on the
plate or array card.

RNase P consumabile. If the replacement RNase P
plate or array card fails, contact Technical Support
for assistance.

Well displays the NOSIGNAL
flag, indicating that the well
produced very low or no
fluorescence signal.

Missing reaction mix
resulting from pipetting
error.

If a well is flagged, confirm the results:

1. Consider omitting the well from the analysis.

Note the location for each flagged well, and check
each corresponding well in the plate or array card
for evaporation or low reaction volume.

. Contact Thermo Fisher Scientific to order a

replacement RNase P plate or array card. If the
replacement RNase P consumable fails, contact
Technical Support for assistance

Well displays the OFFSCALE
flag, indicating that the
fluorescence signal for one
or more dyes in the well
exceeds the instrument’s
maximum detectable range
for one or more cycles.

Fluorescent
contaminant on the
plate or array card or
sample block

Fluorescent
contaminant in the
reaction

Perform a background calibration. If you detect
fluorescent contamination, decontaminate the
sample block.

. Contact Thermo Fisher Scientific to order a

replacement RNase P plate or array card. If the
replacement consumable fails, contact Technical
Support for assistance

Well displays the
OUTLIERRG flag, indicating
that the C; of the well
deviates significantly from
C; values in the associated
replicate group (only the
outlier is flagged).

Contamination

Improper sealing or
seal leaks

Decontaminate the work area and pipettors.

. Contact Thermo Fisher Scientific to order a

replacement RNase P plate or array card. Repeat
the test and make sure that the RNase P
consumable is properly sealed. If the replacement
RNase P plate or array card fails, contact Technical
Support for assistance.

Well displays the SPIKE
flag, indicating that the
amplification curve contains
one or more data points
inconsistent with the other
points in the curve.

Bubbles in the
reaction

Evaporation during
the denaturation step
because of improper
sealing or seal leaks

Contact Thermo Fisher Scientific to order a replacement
RNase P plate or array card. Repeat the test, and make
sure to properly centrifuge the RNase P consumable.

If the replacement RNase P plate or array card fails,
contact Technical Support for assistance.
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Table 8 RNase P test troubleshooting (continued)

Problem/symptom Possible cause Action
Well displays the * Amplification too If a well is flagged, confirm the results:
THOLDFAIL flag, indicatin early
9 d L 1. Select the flagged well(s) in the plate layout or well

that the software cannot e Amplification too late table

calculate the threshold. L '
* Low amplification 2. View the amplification plot (R, vs. Cycle and DR,
* No amplification vs. Cycle), and check for early, late, low, or no

amplification.

3. Contact Thermo Fisher Scientific to order a
replacement RNase P plate or array card. If the
replacement RNase P consumable fails, contact
Technical Support for assistance.

Instrument malfunction. Multiple possible causes | Contact your local Thermo Fisher Scientific Field Service
Office.

How to identify contamination

Signals that exceed the limit of normal background fluorescence may indicate fluorescent contaminants
on the calibration plate or array card or the sample block. Common contaminants include ink residue
from permanent pens, powder from disposable gloves, and dust.

To identify and resolve a possible contamination problem:

1. While viewing the background calibration data in the Analysis screen, select the QC tab to review
the list of wells that failed the quality check.

2. Eject the background plate or array card from the instrument, rotate the plate 180°, then perform
the background calibration again.

3. Determine the location of the contaminated wells again as in step 1.
If the position(s) of the contaminated well(s) in the steps above are:

¢ Identical — The sample block is contaminated. Decontaminate the sample block as explained
in “Decontaminate the sample block” on page 103.

* Reversed - The background plate or array card is contaminated. Discard it, then perform the
background calibration using a new background consumable.

4. If the calibration fails after you replace the background plate or array card and decontaminate the
sample block, contact Technical Support.
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Remove a plate stuck within the instrument

If the QuantStudio™ 6 or 7 Flex System does not eject a plate after you touch E§ on the touchscreen,
the adhesive cover of the plate may have adhered to the heated cover within the instrument. If so, you
can remove the plate from the instrument as follows.

1.

2.

Power off the instrument. Wait 15 minutes, then power on the instrument and eject the plate.
If the plate does not eject, power off and unplug the instrument, then open the access door.

While wearing powder-free gloves, reach into the instrument and remove the plate from the heated
cover, then close the access door.

Perform a background calibration to confirm that the sample block has not been contaminated.
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Overview of instrument touchscreen functions ........ ... .. . i 88
Operate the instrument from the touchscreen ....... ... ... . . . i i i 89
Maintain the instrument from the touchscreen ... ... .. .. . i 93
Administrate the instrument from the touchscreen ........ ... .. ... . . i 96

Note: This appendix describes how to operate the QuantStudio™ 6 and 7 Flex Systems manually using
the touchscreen interface. Although the QuantStudio™ 6 and 7 Flex Systems can be used without an
Ethernet connection to a computer, the touchscreen allows you to perform only a subset of the total
instrument functions.

Overview of instrument touchscreen functions

88

The QuantStudio™ 6 and 7 Flex Systems feature a touchscreen interface that you can use to transfer
data, manage instrument settings, and configure the instrument for network use. The touchscreen does
not provide access to all instrument functions. Features such as analyzing experiments, instrument
calibration, and remote notification are available only through the QuantStudio™ Real-Time PCR
Software.

The following table summarizes the functions that are available from the touchscreen.

Available in secure

Category Function mode?ll]

Create experiments from templates

Run experiments

Operational@ No

Transfer and delete experiments, templates, and results
to/from a USB drive

Back up and restore the instrument settings

Perform an instrument self test

Maintenancels!
Install and record a new lamp

Update the instrument firmware Yes

Define the date and time

Administrationl*! | Define the instrument settings

Define the network settings
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(continued)

Available in secure

Category Function mode?l!]

Define the maintenance reminders

Define the system shortcuts

Enable or disable instrument security
Administration! Yes
Review the instrument statistics

Review the instrument version information

View the system log

[ See “Enable or disable instrument security” on page 101.

2l Tasks for users responsible for day-to-day use of the instrument.

B Tasks for users who maintain the instrument.

¥ Tasks for systems administrators or for information technology personnel.

Operate the instrument from the touchscreen

The touchscreen provides limited control of the instrument to run experiments and transfer data. You
can perform the following functions from the touchscreen to operate the instrument without using the
QuantStudio™ Real-Time PCR Software:

* (Create an experiment from a template (see page 89)
* Run an experiment (see page 90)
* Transfer experiments, templates, and results data (see page 91)

Note: If the instrument is operating in secure mode, users can only open and close the side door (see
“Enable or disable instrument security” on page 101).

Create an experiment from a template

1. If necessary, download the experiment template to the QuantStudio™ 6 or 7 Flex Real-Time PCR
System (see “Transfer experiments from a USB drive” on page 92).

2. If the instrument is in standby, tap the instrument touchscreen to activate it, then tap 3.
3. In the main menu, tap & View Templates.

4. Inthe View Templates screen, tap a template, then tap + New.

To view the parameters of a template, select the desired template, then tap & View. When
finished, tap { to return to the View Templates screen.

Note: You cannot modify the experiment parameters of a template.
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5. In the Create New Experiment screen, tap each field to set the following items:

* Tap the New Experiment Name field and use the keypad to enter a name (up to
100 characters) for the experiment.

* Tap the Save to Folder field to open the Select Folder screen.
* Tap the Reaction Volume field to enter a reaction volume in pL.

* (Optional) Tap the Barcode Number field to enter a barcode, and tap the Notes field to enter
notes (up to 200 characters) about the experiment.

6. When finished, select one of the following options:

* Tap g Save & Exit.
* Tap # Save & Start Run to proceed to the Start Run screen.

Run an experiment

1. If the instrument is in standby, tap the QuantStudio™ 6 or 7 Flex Real-Time PCR System
touchscreen to activate it, then tap [@).

2. In the main menu, tap B.

3. When the side door opens, load the appropriate plate
or array card.

Ensure that the consumable is properly aligned in the

holder. )
. ", WDO0000000000006000800080
* (A) Load 96/384-well plates with the A1 position at s
the top-left corner of the plate adapter. 1222""“‘-’,35:8323333235’?22§
* (B) Load both plates and array cards with the 888 3538358535 E
barcode facing the front of the instrument. 33 8
H

L o

4. In the main menu, tap Browse Experiments.

5. In the Experiments screen, touch the desired
experiment, then tap one of the following options:

Option Description
4 Start Run Start the run immediately, then go to step 10.
& View/Edit View or edit the experiment before starting the run.
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6. Modify the experiment parameters as needed.

* Add a stage or step to the thermal profile, tap the stage or step to the left of where you want
to add the stage or step, then tap B Add.

e Add a melt curve to the end of the thermal profile, tap “® Add Melt Curve.

* (Change the time or temperature of a stage or step, touch the time/temperature field of the
stage or step, modify the settings as desired, then tap Close.

* Change the cycle parameter of a stage, tap the cycle field, modify the setting as desired, then
tap Close.

¢ Delete a stage or step from the thermal profile, tap the stage or step you want to remove, then
tap [iii Delete.

7. When finished modifying the parameters, tap & Save.

8. In the Save Experiment screen, tap each field to set the experiment, name, reaction volume,
barcode, and any additional information to save to the experiment

9. When finished, tap # Save & Start Run to start the experiment.

10. In the Start Run screen, tap each field as needed to modify the associated parameter, then tap
4 Start Run Now to start the experiment.

Note: When the run is complete, tap B to unload the plate. You can download the experiment
results to a computer if the QuantStudio™ 6 or 7 Flex Real-Time PCR System is connected to

a network, or you can copy the data to a USB drive (see “Transfer experiments, templates, and
results data” on page 91).

Transfer experiments, templates, and results data

You can transfer experiments, templates, and results data

to/from the QuantStudio™ 6 and 7 Flex Systems using a

USB flash drive. Before transferring data, you must plug the 0
drive into the USB port below the touchscreen. @— LP

IMPORTANT! Do not use the USB ports on the rear panel
of the QuantStudio™ 6 and 7 Flex Systems. The rear USB
ports are only for use by Thermo Fisher Scientific personnel
to service the instrument.

Transfer templates from a USB drive

1. Plug a USB drive into the USB port below the touchscreen.

2. |f the instrument is in standby, touch the QuantStudio™ 6 or 7 Flex System touchscreen to activate
it, then press (3.

3. In the Main Menu, touch & View Templates.
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4.

5.

In the Browse Experiments screen, select the template:
a. Touch [ @], then touch USB.

b. Touch the desired template, then touch & Save.

In the Save Experiment As screen, set the name for the file.
a. Touch the New Template Name field, then enter a name for the copied file.

b. Touch the Save to Folder field, then select the folder to receive the file.

c. Touch Save.

6. Touch [ to return to the Main Menu.

7.

Unplug the USB drive.

Transfer experiments from a USB drive

1.

2.

6.

7.

Plug a USB drive into the USB port below the touchscreen.

If the instrument is in standby, touch the QuantStudio™ 6 or 7 Flex System touchscreen to activate
it, then press [@.

In the Main Menu, touch Browse Experiments.

In the Browse Experiments screen, select the experiment:
a. Touch [&], then touch USB.

b. Touch the desired experiment, then touch g Save.

In the Save Experiment As screen, touch the experiment that you want to transfer to the USB drive,
then touch Save.

Touch [ to return to the Main Menu.

Unplug the USB drive.

Copy experiment results to a USB drive

1.

2.

Plug a USB drive into the USB port below the touchscreen.

If the instrument is in standby, touch the QuantStudio™ 6 or 7 Flex System touchscreen to activate
it, then press [3).

From the Main Menu of the instrument touchscreen, touch Collect Results.
From the list of experiments, touch the experiment(s) of interest or touch s Select All.
Touch # Save to USB.

From the Copy Results To USB screen, check that the name of the USB drive is correct to ensure
that it is mounted, then touch /4 Save to USB.
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7. Touch Ed to return to the Main Menu.

8. Unplug the USB drive.

Note: After the results from a completed run have been collected, the corresponding experiment
displays “Collected” and it can be deleted.

Delete results

Once you have collected results from the QuantStudio™ 6 or 7 Flex System, you can use the
touchscreen to delete the files from the instrument hard drive.

1. From the Main Menu of the instrument touchscreen, touch Collect Results.
2. From the list of experiments, touch the experiment(s) of interest, then touch fif Delete.
3. When asked to confirm the deletion, touch OK.

4. Touch K to return to the Main Menu.

Maintain the instrument from the touchscreen

The touchscreen provides access to a few maintenance functions that cannot be accessed remotely

from the QuantStudio™ Real-Time PCR Software. Unlike the maintenance performed using the
QuantStudio™ Real-Time PCR Software, some of the touchscreen functions are not part of the
recommended maintenance schedule. The frequency that you perform them depends on your
laboratory policies.

* Back up and restore the instrument settings (see page 93)
* Perform an instrument self-test (see page 95)
* Update the instrument firmware (see page 95)

Note: The touchscreen does not provide access to all instrument functions. Features such as

instrument calibration and remote notification are available only through the QuantStudio™ Real-Time

PCR Software.

Back up and restore the instrument settings

You can use the QuantStudio™ 6 or 7 Flex System touchscreen to back up the instrument settings

(icon, standby time-out, and cover idle temperature), and some network settings (the Autodiscovery and
Smart Monitoring options). If the QuantStudio™ 6 or 7 Flex Instrument settings are reset, you can restore

the settings using the backup.

Note: The backup feature can be used as an administrative tool to manage QuantStudio™ 6 and 7
Flex Systems. You can use the feature to create a standard “image” for a QuantStudio™ 6 or 7 Flex

Instrument that can then be restored on other instruments to bypass the manual setup process.
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The QuantStudio™ 6 and 7 Flex Systems back up to and

restores instrument settings from a USB flash drive. Before

backing up or restoring settings, you must plug the drive 0
into one of the USB ports below the touchscreen. U— LIJ

IMPORTANT! Do not use the USB ports on the rear panel
of the QuantStudio™ 6 and 7 Flex Systems. The rear USB
ports are for use by Thermo Fisher Scientific personnel to
service the instrument.

Back up the instrument settings

1. Plug a USB drive into the USB port below the touchscreen.

2. From the Main Menu of the instrument touchscreen, touch Tools, then touch Backup Settings.
3. From the Backup Settings screen, touch & Backup.

4. Wait for the backup to complete, then touch [ to return to the Main Menu.

5. Unplug the USB drive.

Note: For administrative purposes, you can reuse the instrument settings saved to the USB drive to
configure more than one QuantStudio™ 6 or 7 Flex System. Note that you must configure the network
settings for each instrument individually.

Restore the instrument settings

1. Plug the USB drive that contains the instrument settings into the USB port below the touchscreen.
2. From the Main Menu of the instrument touchscreen, touch Tools, then touch Restore Settings.

3. From the Restore Settings screen, select the settings to restore:
a. Touch the settings that you want to restore from the list.

b. Touch g Restore to upload the instrument settings from the USB drive.

IMPORTANT! Do not remove the USB drive from the QuantStudio™ 6 or 7 Flex System until
instructed.

Note: Alternatively, touch Restore Default Settings to restore the QuantStudio™ 6 or 7 Flex
System to the factory settings.

4. After the QuantStudio™ 6 or 7 Flex System restarts, unplug the USB drive.
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Perform an instrument self test

You can use the QuantStudio™ 6 Flex Real-Time PCR System and the QuantStudio™ 7 Flex Real-Time
PCR System touchscreen to perform a comprehensive self test of the subsystems. After the self test is
complete, the system generates two files that provide a detailed summary of the instrument condition
and function. In the event of a problem, you can save the results files to a USB drive and email them to
Technical Support for a diagnosis.

Note: We recommend running the self test as part of regular maintenance to help ensure optimal
performance of the system.

1. From the Main Menu of the instrument touchscreen, touch Tools, then touch Run Self Test.
2. From the Self Test screen, touch [ Start Self Test, then wait for the test to complete.

3. (Optional) When the system completes the self test, save the results to a USB drive:
a. Plug a USB drive into the USB port below the touchscreen.

0

O

IMPORTANT! Do not use the USB ports on the rear panel of the instrument. The rear USB
ports are for use by Thermo Fisher Scientific personnel to service the instrument.

b. Touch & Save.

IMPORTANT! Do not remove the USB drive from the instrument until instructed.

c. When the system finishes writing the results to the USB drive, touch OK, then remove the
USB drive.

4. Touch EJ to return to the Main Menu.

Update the instrument firmware

You can download the QuantStudio™ 6 and 7 Flex Systems firmware updates at thermofisher.com/
qpcrsoftware. After obtaining a firmware update, transfer the update to the system using a USB drive.

1. Download the firmware update:
a. Go to thermofisher.com/qpcrsoftware.

b. In the Real-Time PCR section, select QuantStudio™ 6 and 7 Flex Real-Time PCR Systems.

c. In the Software Downloads page, click Updates - Patches.
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d. Download the firmware to a USB drive.

2. Plug a USB drive into the USB port below the touchscreen.

IMPORTANT! Do not use the USB ports on the rear panel of the QuantStudio™ 6 and 7 Flex
Systems. The rear USB ports are for use by Thermo Fisher Scientific personnel to service the
instrument.

3. If the instrument is in standby, tap the touchscreen to activate it, then tap [@.
4. Inthe main menu, tap Tools, then tap & Upgrade Firmware.

5. In the Upgrade Firmware screen, select the update package, then tap & Upgrade Firmware.
Allow the system to complete the upgrade.

IMPORTANT! Do not remove the USB drive from the system until you are instructed to do so.

6. After the upgrade is complete and the system reboots, confirm the upgrade success:
a. Unplug the USB drive.

b. Tap Settings, then tap About this instrument to view the software version number to confirm
that the firmware has been upgraded.

Administrate the instrument from the touchscreen

The touchscreen provides access to several administrative functions that you can use to integrate the
QuantStudio™ 6 and 7 Flex Systems into a laboratory workflow. The following functions are available
from the touchscreen and can be used after installation to customize the instrument settings and
configure it for network use.

* Define the date and the time (page 97)

¢ Define the instrument settings (page 97)

* Define the maintenance reminders (page 99)

* Define the network settings (page 99)

* Define the system shortcuts (page 100)

* Review the instrument statistics (page 101)

* Review the instrument version information (page 101)
* Enable or disable the instrument security (page 101)
* View the instrument log (page 102)
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Note: The touchscreen does not provide access to all instrument functions. Features such as
instrument calibration and remote notification are available only through the QuantStudio™ Real-Time
PCR Software.

Define the date and time

IMPORTANT! If your laboratory is subject to daylight savings time changes, you must manually adjust
the time settings during daylight savings to help ensure that the internal clocks of your computer and
instrument are synchronized.

1. From the Main Menu of the instrument touchscreen, touch Settings, then touch Set Date & Time.

2. From the Set Date & Time screen:
a. Touch the Time zone field, then touch the correct time zone from the list.

b. Touch the Date field, enter the current date, then touch Done.

c. Touch the Date Format drop-down list, then select the format for your region.
d. Touch each Time field, enter the appropriate time units, then touch Done.

e. Touch 12 Hour or 24 Hour to select the appropriate time format.

f. Touch Save to save the settings, then touch OK when prompted.

3. Touch E to return to the Main Menu.

Define the instrument settings

1. In the main menu of the instrument touchscreen, tap Settings, then tap Configure the
Instrument.

2. Tap the Instrument Name field, enter up to a 25-character name for the system, then tap Done.
The instrument name is the alphanumeric string used to identify the instrument on the network.

IMPORTANT! To connect the instrument to a network, the name must be unique.

IMPORTANT! The instrument name cannot include spaces or special characters (suchas;: " < >
*+=\]7,).
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3. Upload the instrument icon:

The instrument icon is the graphic used to represent the instrument in the QuantStudio™ Real-Time
PCR Software Instrument Console:

a. Save the replacement graphic to a USB drive, then plug the drive into the USB port below the
touchscreen.

O

IMPORTANT! Do not use the USB ports on the rear panel of the instrument. The rear USB
ports are for use by Thermo Fisher Scientific personnel to service the instrument.

b. Tap Upload Icon, select the desired graphic file, then tap Done.

Note: The replacement graphic must be a maximum of 48 x 48 pixels and be stored in the
portable net graphic (PNG) format.

4. Define the standby time-out setting:
a. Select Standby Time-out to activate the feature.

b. Tap the Standby Time-out field.

c. Enter the number of minutes (1-300) that the instrument should remain idle until it enters
standby mode, then tap Done.

Note: When in standby mode, the instrument powers off the LCD screen backlight and enters
low-power mode.

5. Define the heated cover temperature setting:
a. Select Cover Idle Temperature to activate the feature.

b. Tap the Cover Idle Temperature field.

c. Enter the temperature (50.0-110.0°C) that the heated cover should maintain when the
instrument is idle, then tap Done.

Note: The recommended cover idle temperature is 60.0°C for reaction plate formats and
85.0°C for the array card format.

6. Tap Save to save the settings, tap touch OK when prompted.
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7. Unplug the USB drive.

8. Tap E to return to the main menu.

Define the maintenance reminders

You can use the QuantStudio™ 6 or 7 Flex System touchscreen screen to:
* Set the expiration period for instrument calibrations and lamp replacement.

* Activate, deactivate, or change the frequency of the maintenance reminders displayed by the
QuantStudio™ 6 or 7 Flex System.

To set the reminder:

1. From the Main Menu of the instrument touchscreen, touch Settings, then touch Set Maintenance
Reminders.

2. For each reminder:
a. Touch the Calibration expires after field.

b. Use the keypad to enter the number of days (or, for the lamp, the number of hours) that
should elapse before expiration, then touch Done.

c. (Optional) Touch the checkbox to activate or deactivate an expiration reminder, then go to
step 3.

3. (Optional) Configure the reminder:
a. Touch the Display reminders before field.

b. Enter the number of days (or, for the lamp, the number of hours from 1-2000) before which the
instrument should display warnings of the impending expiration, then touch Done.

4. Touch Save to save the settings, then touch OK when prompted.

5. Touch E to return to the Main Menu.

Define the network settings

1. In the main menu of the instrument touchscreen, tap Settings, then tap Set Network Information.

Note: The Set Network Information screen displays the Media Access Control (MAC) address
of the QuantStudio™ 6 or 7 Flex Real-Time PCR System below the Autodiscovery and Smart
Monitoring check boxes. The MAC address can be used to uniquely identify the system on the
network.

2. Tap Autodiscovery to make the system discoverable by computers that are running the
QuantStudio™ Real-Time PCR Software.
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3. Tap Smart Monitoring to enable the feature on the QuantStudio™ 6 or 7 Flex Real-Time PCR

System.

The Smart Monitoring feature allows Thermo Fisher Scientific service personnel to monitor the
status of the QuantStudio™ Real-Time PCR Software remotely through an internet connection.
Smart Monitoring employs multiple layers of security, including a Secure Sockets Layer (SSL) and
Lightweight Directory Access Protocol (LDAP) authentication, to provide real-time troubleshooting
and problem resolution for the system. For a detailed description of the Smart Monitoring Service,
see the Smart Monitoring Service Product Bulletin: Leveraging the power of the Internet while
maintaining system security (Pub. No. 121PB07-03).

4. Set the Internet Protocol (TCP/IP) Properties for either DHCP or Static IP communication.

Network service

Action

DHCP Tap Obtain an IP address automatically.
1. Tap Use the following IP address.
2. Tap the IP Address field, enter the IP address using the keypad, then tap Done.
3. Assign the:
Static IP

* [P addresses for the DNS Servers (primary and secondary)
® Subnet Mask setting
* Default Gateway setting

5. Tap & Save to save the settings, then tap OK when prompted.

6. Tap | to return to the main menu.

Define the system shortcuts

You can use the QuantStudio™ 6 or 7 Flex System touchscreen to map the shortcut buttons that appear
in the Main Menu. You can configure shortcuts to automatically open specific files and folders so that
you can access data quickly and easily without having to navigate to it.

1. If the instrument is in standby, touch the QuantStudio™ 6 or 7 Flex System touchscreen to activate

it, then press [{.

2. In the Main Menu, configure the shortcuts as desired: To add a shortcut:
a. Touch the shortcut of interest, then touch @& Set Shortcut.

b. Touch [ = ] From Templates to link to a specific template file or touch From Folders to
link to a folder.

c. Touch the desired template file or folder to configure the shortcut.

To delete a shortcut, touch the shortcut of interest, then touch jii Remove Shortcut, or touch
Remove All to delete all shortcuts.

3. When you are finished configuring the shortcuts, touch Edto return to the Main Menu.
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Review the instrument statistics

You can use the QuantStudio™ 6 or 7 Flex System touchscreen to view usage statistics on the heated
cover, lamp, and other instrument components.

1. From the Main Menu of the instrument touchscreen, touch Tools, then touch Show Statistics.

2. When you are finished, touch [ to return to the Main Menu.

Review the instrument version information

You can use the QuantStudio™ 6 or 7 Flex System touchscreen to view instrument version data, such as
instrument serial number and version numbers for most instrument components and firmware.

1. From the Main Menu of the instrument touchscreen, touch Tools, then touch About the
Instrument.

2. When you are finished, touch K to return to the Main Menu.

Enable or disable instrument security

The QuantStudio™ 6 and 7 Flex Systems feature a secure mode that can be enabled to restrict local
instrument functionality. When security is enabled, use of the touchscreen is restricted to administrative
functions that change the instrument settings. After the system is secured, you must enter an
administrator password to modify the instrument settings, use the firmware tools, or deactivate the
secure mode.

IMPORTANT! If you enable or disable the QuantStudio™ 6 and 7 Flex Systems security, auditing,

and electronic signature feature, you must similarly enable or disable the QuantStudio™ Real-Time PCR
Software security (see “Access the Security screen and enable or disable security” on page 139). The
QuantStudio™ Real-Time PCR Software cannot connect to the QuantStudio™ 6 and 7 Flex Systems that
do not match security settings.

Note: Secure mode limits the number of features that are available from the system touchscreen. It
does not provide user authentication functionality through the instrument touchscreen.

1. If the instrument is in standby, tap the touchscreen to activate it, then tap [@.
2. In the main menu, tap Settings, then tap Set Administrator Options.

3. In the Set Administrator Options screen, tap Secure Environment to enable (checked) or disable
(unchecked) system security.

4. (Optional) To change the administrator password:
a. Tap Change Password.

b. Enter the current password, then tap Done.

c. Enter the new password, then tap Done.
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d. Reenter the password when prompted.

e. Tap OK when prompted.

Note: The default password for the instrument touchscreen is password; however, the password
can be changed during installation.

5. Tap & Save.
6. Tap the Administrator Password field, enter the administrator password, then tap Done.

7. Tap K to return to the main menu.

View the instrument log

You can use the QuantStudio™ 6 or 7 Flex System touchscreen to view a log that summarizes
instrument activity from the last 6 months. For each recorded activity, the activity log provides a
description of the activity and the date/time when it occurred.

1. From the Main Menu of the instrument touchscreen, touch Tools, then touch View Log.

2. From the View Log screen, configure the settings to display the records of interest:
® Select an option from the drop-down menu to filter the log.
¢ Select Earliest First or Latest First to determine the order to sort the records.

3. (Optional) Plug the USB drive into the port below the
touchscreen, then touch Export to USB to save the log
to the drive. OJ

IMPORTANT! Do not use the USB ports on the rear /\/‘“ Y\P
panel of the QuantStudio™ 6 and 7 Flex Systems. The

rear USB ports are for use by Thermo Fisher Scientific

personnel to service the instrument.

4. Touch g to return to the Main Menu.
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IMPORTANT! This chapter contains all user service procedures for the QuantStudio™ 6 and 7 Flex
Systems. Procedures other than those described in this document must be performed by a qualified
Thermo Fisher Scientific Service Engineer.

Decontaminate the sample block

Perform this procedure to eliminate fluorescent contaminants from the sample block. Contamination
is generally evident in failed background calibrations where one or more wells consistently exhibit
abnormally high signals.

CAUTION! PHYSICAL INJURY HAZARD. Do not remove the QuantStudio™ 6 or 7 Flex Real-Time
PCR System cover. There are no components inside the instrument that you can safely service
yourself. If you suspect a problem, contact a Thermo Fisher Scientific Service Representative.

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the sample block can reach
100°C. Allow the sample block to cool to room temperature before performing the procedure.

CAUTION! Before using a cleaning or decontamination method other than those recommended by
Thermo Fisher Scientific, confirm with Thermo Fisher Scientific that the proposed method will not
damage the equipment.
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Decontaminate the sample block

Materials required

Bleach, 10% solution

Tissue, lint-free

Cotton or nylon swabs and lint-free cloths
Ethanol, 95% solution

Safety glasses

Pipette (100-pL) with pipette tips
Powder-free gloves

Screwdriver

Deionized water

How to handle the sample block

To prevent damaging or contaminating the sample block, handle the assembly as shown. After the
assembly has been removed from the QuantStudio™ 6 or 7 Flex System, place the sample block on a
clean, dry surface or in its shipping container.

Clean the sample block

A WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the sample block can reach
' 100°C. Allow the sample block to cool to room temperature before performing the procedure.

IMPORTANT! Wear powder-free gloves when you perform this procedure.

1.

104

Identify the contaminated wells of the sample block (see “How to identify contamination” on
page 86).

Power off and unplug the QuantStudio™ 6 or 7 Flex Real-Time PCR System, then allow it to cool
for 15 minutes.

Open the access door.
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4. Firmly press down on the handle of the sample block,
then remove it from the system. Place the sample
block on a clean, dry surface.

5. Clean the contaminated wells of the sample block
using deionized water:

a. Pipet a small volume of deionized water into each
contaminated well.

b. In each well, pipet the water up and down several
times to rinse the well.

c. Pipet the water to a waste beaker.

d. Use a cotton swab to scrub inside of each contaminated well.

e. Use a lint-free cloth to absorb the excess deionized water.

6. Load the sample block into the system, then close the
access door.

IMPORTANT! After installing the sample block,
confirm that the indicator on the left side of the

sample block is positioned behind the red line on the
instrument rail. If the indicator is forward of the red line,
push the sample block into the system until it is seated
correctly.

7. Close the access door.

IMPORTANT! Confirm that the access door is completely closed. The QuantStudio™ Real-Time
PCR Software displays an error message if the door is not completely closed and latched, or if the
sample block is not seated correctly.

8. Plug in, then power on the QuantStudio™ 6 or 7 Flex Real-Time PCR System.

9. Perform a background calibration to confirm that you have eliminated the contamination.
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10. If the contamination remains, repeat steps 2-5, then clean the contaminated wells of the sample
block using a 95% ethanol solution:

a. Pipet a small volume of 95% ethanol solution into each contaminated well.
b. In each contaminated well, pipet the solution up and down several times to rinse the well.
c. Pipet the ethanol solution to a waste beaker.

11. Repeat steps 5-9 to rinse the wells of the sample block and to ensure that you have eliminated the
contamination.

IMPORTANT! Always use deionized water to rinse wells after cleaning with bleach or ethanol
solution.

12. If the contamination remains, repeat steps 2-5, then clean the contaminated wells of the sample
block using 10% bleach solution:

a. Pipet a small volume of 10% bleach solution into each contaminated well.
b. In each contaminated well, pipet the solution up and down several times to rinse the well.
c. Pipet the bleach solution to a waste beaker.

13. Repeat steps 5-9 to rinse the wells of the sample block and to confirm that you have eliminated
the contamination.

IMPORTANT! Always use deionized water to rinse wells after cleaning with bleach or ethanol
solution.

14. |f the contamination remains, contact Thermo Fisher Scientific.

Replace the halogen lamp

Replace the halogen lamp at or before 2000 hours of life.

WARNING! PHYSICAL INJURY HAZARD. The QuantStudio™ 6 or 7 Flex System and lamp are hot!
The lamp can become very hot while in use. Before handling the lamp, allow it to cool for 15 minutes
and put on protective, powder-free gloves.

CAUTION! PHYSICAL INJURY HAZARD. Wear disposable, powder-free gloves when handling the
lamp to prevent burns and to prevent shortening the life of the replacement lamp.

WARNING! This QuantStudio™ 6 or 7 Flex System is designed for 12 V, 75 W halogen lamps only.
Replace with halogen bulbs supplied by Thermo Fisher Scientific.
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Materials required

e Safety glasses
* Powder-free gloves
® Halogen bulb (12 V, 75 W)

Halogen lamp warnings

The QuantStudio™ Real-Time PCR Software can display the following warnings before or during an
experiment:
* The lamp current is below the acceptable level at the start of the run.
Replace the halogen bulb (see “Replace the lamp” on page 107).

* The QuantStudio™ Real-Time PCR Software stopped the run because the lamp current decreased
below the acceptable level during the run.
Replace the halogen bulb (see “Replace the lamp” on page 107). Click OK in the message box,
then replace the lamp bulb.

* The lamp usage exceeds 2000 hours at the start of a run.
Click Cancel Run, then replace the lamp before you perform another experiment.

View the lamp status
1. In the QuantStudio™ Real-Time PCR Software Home tab, click Instrument Console.

2. From the Instrument Console, select your system from the list of instruments, then review the
Lamp Life and Last Serviced readings in the Maintenance Info pane.
If the lamp usage has reached 2000 hours, replace the lamp (see “Replace the lamp” on
page 107).

Note: The Lamp Life report displays the total number of hours that the halogen lamp has been
illuminated. The Last Serviced report displays the date that the lamp was installed.

Replace the lamp

IMPORTANT! Always wear powder-free gloves when you handle the lamp. Finger prints shorten the
lamp life.

1. Record the lamp installation:
a. In the main menu of the touchscreen, tap Tools, then tap Record Lamp Installation.

b. Tap the Name field, enter any relevant information (such as the make, model, or serial number
of the lamp), then tap Done.

c. Tap the Comments field, enter any additional information that you want to record, then touch
Done.

d. Tap Save, then tap OK.
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e. When asked to confirm lamp replacement, tap OK

Note: The data that you enter for the new lamp appear in the instrument log.

2. Power off and unplug the QuantStudio™ 6 or 7 Flex Real-Time PCR System, then allow it to cool
for 15 minutes.

3. Open the access door.

4. Remove the lamp from the system:
a. Slide the lamp release lever downward.

b. Firmly grasp the lamp and lift it up and out of the slotted mount.

5. Inspect the lamp for damage (carbon usually coats the inside of a failed lamp). If necessary,
dispose of the lamp and obtain a replacement.

IMPORTANT! Dispose of the lamp in accordance with your local municipal waste ordinances. Do
not dispose of the lamp as unsorted municipal waste.

6. Install the new lamp into the QuantStudio™ 6 or 7 Flex Real-Time PCR System:
a. Slide the lamp release lever upward.
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b. Firmly grasp the lamp, place it into the slotted mount, then carefully slide the lamp downward
into place.

7. Close the access door.

8. Plug in and power on the QuantStudio™ 6 or 7 Flex Real-Time PCR System.

IMPORTANT! Confirm that the access door is completely closed. The QuantStudio™ Real-Time
PCR Software displays an error message if the door is not completely closed and latched, or if the
lamp is not seated correctly.

9. Start the QuantStudio™ Real-Time PCR Software, then perform an ROI calibration.

While the system is running, look through grating of the access door and confirm that the lamp is
illuminated.

* If the lamp is illuminated, the lamp has been installed successfully.

¢ If the lamp is not illuminated, the replacement halogen lamp may be defective. Replace the
lamp again. If the second lamp does not illuminate, check the system fuses for failure (see
“Replace the instrument fuses” on page 110).

10. After replacing the lamp, perform the following calibrations in the specified order:
a. ROI calibration

b. Background calibration

(2}

. Uniformity calibration
d. Dye calibration

e. Normalization calibration (TagMan™ Array Card block only)

.—h

RNase P test
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Replace the instrument fuses

Replace the QuantStudio™ 6 or 7 Flex System fuses when the fuses fail.

Flex System.

Materials required

* Fuses, 12.5A, Time-Lag T, 250VAC, 5 x 20-mm (2)

* Fuses for AU/NZ only, 6.3A, Time-Lag T, 250VAC, 5 x 20-mm (2)

* Safety glasses
* Powder-free gloves
* Screwdriver, flathead

Replace the fuses

CAUTION! FIRE HAZARD. For continued protection against the risk of fire, replace fuses only with
listed and certified fuses of the same type and rating as those currently in the QuantStudio™ 6 or 7

1. Power off, then unplug the QuantStudio™ 6 or 7 Flex System. Allow it to cool for 15 minutes.

2. Using a flat-head screwdriver, unscrew and remove the fuse holder.

3. Remove each fuse from its fuse holder and inspect it
for damage. Carbon typically coats the inside of failed
fuses.

4. Replace each failed fuse with a 12.5A, Time-Lag T,
250VAC, 5 x 20-mm Fuse.

Good

Failed

Note: The voltage and amperage ratings are on the
fuse holder.

Note: For AU/NZ only, replace each failed fuse with a 6.3A, Time-Lag T, 250VAC,

5 x 20-mm Fuse.
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5. Install the fuse holder.

6. Plug in, then power on the QuantStudio™ 6 or 7 Flex System. The installation is successful if the
instrument powers on.

Note: Fuse failure can result from fluctuations in the supplied power to the QuantStudio™ 6 or 7 Flex
System. To prevent further failures, consider installing an electrical protective device, such as a UPS or
a surge protector.

Install the QuantStudio™ Real-Time PCR Software

Computer requirements

See “Computer requirements” on page 22 for a list of hardware and operating system requirements for
the QuantStudio™ 6 and 7 Flex Real-Time PCR System Software.

Install the software

1. Go to thermofisher.com/gpcrsoftware.
2. In the Real-Time PCR section, click QuantStudio™ 6 & 7 Flex Real-Time PCR Systems.

3. Click Download, then follow the instructions.

Software licenses

The base QuantStudio™ Real-Time PCR Software does not require a license.

The High Resolution Melting (HRM) Software and the SAE module require licenses.

Activate a license

A valid license key is required for the High Resolution Melting (HRM) Software or the SAE module.

IMPORTANT! An internet connection, a web browser, and a valid email account are required to
activate a license for the modules. If the computer that contains the QuantStudio™ Real-Time PCR
Software is not connected to the internet or it lacks a web browser application, contact Technical
Support to request the license file.

1. In the QuantStudio™ Real-Time PCR Software Home tab, select Tools » License Central.

2. In the License Central dialog box, select the license of interest from the table, click Activate
License, then wait for the default web browser application to connect to thermofisher.com.

3. From the Software License Activation page, select the module, then activate the license as
instructed.
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After you successfully activate the license, you will receive an email containing the activated license file
(LIC) to install on your computer.

Install a license file

Activate a license and receive a license file (LIC) (see “Activate a license” on page 111).

The following steps describe how to install the license file to in order to unlock the High Resolution
Melting (HRM) Software or the SAE module.

Note: Each license file is generated specifically for the computer that was used to activate the license
key.

1. Save the license file (LIC) to the computer that contains the QuantStudio™ Real-Time PCR
Software.

2. In the QuantStudio™ Real-Time PCR Software Home tab, select Tools » License Central.
3. From the License Central dialog box, click Install License.
4. From the Open dialog box, navigate to the license file, then click Open.

5. Click OK to close the License Central dialog box.

Note: Contact Technical Support if the software fails to install the license.

Update the QuantStudio™ Real-Time PCR Software

Thermo Fisher Scientific may release updates to the QuantStudio™ Real-Time PCR Software that you
can install without the aid of Thermo Fisher Scientific service personnel. You can obtain updates directly
from the service section of thermofisher.com.

For the latest services and support information for the QuantStudio™ 6 or 7 Flex Real-Time PCR
System:

1. Go to thermofisher.com/qpcrsoftware.

2. On the Software Downloads page, select Applied Biosystems™ QuantStudio™ 6 and 7 Flex
Systems from the menu.

3. On the Software Downloads page, click Updates - Patches.

The website opens the page describing the latest software updates for the system.
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Update the software

Prepare for the upgrade
To prepare for the software update, back up all data files and experiments by creating a copy of the
directory that you are using to store files. The default directories are:

¢ |Installation directory—<drive>:\Program Files (x86)\Applied
Biosystems\QuantStudio Real-Time PCR Software\

* Data directory—<drive>:\Applied Biosystems\AppData\QuantStudio Real-Time
PCR Software

* User files directory—<drive>:\Applied Biosystems\QuantStudio Real-Time PCR
Software\User Files

Note: The <drive> is the location where the software is installed.

Install the software

Install the software update according to the instructions that download with the software. A license is
not needed for the base version of the QuantStudio™ Real-Time PCR Software.

Update the Microsoft™ Windows™ operating system

Do not upgrade or update the Microsoft™ Windows™ operating system of the computer running

the QuantStudio™ Real-Time PCR Software without first consulting the software release notes or
thermofisher.com. Future versions and updates to the Windows™ operating system may conflict with
the software.

1. Go to thermofisher.com/gpcrsoftware.

2. In the Real-Time PCR section, click Applied Biosystems QuantStudio 6 & 7 Flex Real-Time
PCR Systems.

3. Click Read Me.

4. If the release notes do not contain the information of interest, contact Technical Support.

Change the sample block

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the sample block and
heated cover can reach 100°C. Allow the sample block to cool to room temperature before removing.

When to change the sample block

You can change the sample block:
* To change the consumable format of the QuantStudio™ 6 or 7 Flex System.
* In the event of a hardware failure.
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Materials required

e Safety glasses
* Powder-free gloves
* Sample block

How to handle the sample block

To prevent damaging or contaminating the sample block, handle the assembly as shown. After the
assembly has been removed from the QuantStudio™ 6 or 7 Flex System, place the sample block on a
clean, dry surface or in its shipping container.

Change the sample block

1. Power off and unplug the QuantStudio™ 6 or 7 Flex Real-Time PCR System, then allow it to cool
for 15 minutes.

2. Open the access door.

3. Firmly press down on the handle of the sample block,
then remove it from the system. Place the sample
block on a clean, dry surface.
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4. Install the new sample block into the QuantStudio™ 6
or 7 Flex Real-Time PCR System.

IMPORTANT! After installing the sample block,
confirm that the indicator on the left side of the
sample block is positioned behind the red line on the
instrument rail. If not, push the sample block into the
system until it is seated correctly.

5. If you are installing a sample block of a different
consumable format, replace the heated cover and plate
adapter if necessary.

6. Close the access door.

IMPORTANT! Confirm that the access door is completely closed. The QuantStudio™ Real-Time
PCR Software displays an error message if the door is not completely closed and latched, or if the
sample block is not seated correctly.

7. Plug in and power on the QuantStudio™ 6 or 7 Flex Real-Time PCR System.
8. In the QuantStudio™ Real-Time PCR Software Home tab, click Instrument Console.

9. In the Instrument Console, select your instrument from the list of instruments, then review the
Block Type field in the Instrument Properties pane.

The installation is successful if the system powers on and if the Block Type field displays the
correct type of sample block.

Note: The Block Type field displays the type of sample block installed in the system.

10. Check the calibration status of the system (see “View the calibration status of an instrument” on
page 29).
If the calibrations for the new sample block/heated cover have expired, perform the following
calibrations in the specified order:

a. ROl calibration

b. Background calibration
c. Uniformity calibration
d. Dye calibration

e. Normalization calibration (TagMan™ Array Card block only)

IMPORTANT! If the calibrations for the new sample block/heated cover are valid, you do not
need to recalibrate the QuantStudio™ 6 or 7 Flex Real-Time PCR System.
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Change the heated cover

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the sample block and
£ heated cover can reach 100°C. Allow the heated cover to cool to room temperature before removing.

When to change the heated cover

You can change the heated cover:
* To change the consumable format of the QuantStudio™ 6 or 7 Flex System.
* In the event of a hardware failure

Materials required

* Safety glasses
* Powder-free gloves
* Heated cover

How to handle the heated cover

To prevent damaging or contaminating the heated cover, handle the assembly as shown below. After
the assembly has been removed from the QuantStudio™ 6 or 7 Flex System, place the heated cover on
a clean, dry surface or in its shipping container.

Change the heated cover

Note: Confirm that the replacement heated cover supports the plate or array card format that you want
to use. Some heated covers support more than one consumable type.

1. Power off and unplug the QuantStudio™ 6 or 7 Flex Real-Time PCR System, then allow it to cool
for 15 minutes.

2. Open the access door.
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3. Unlock the heated cover by pinching the handle together, then pull the assembly from the system
and place it on a clean, dry surface.

N I ~

4. Install the new heated cover into the QuantStudio™ 6 or 7 Flex Real-Time PCR System.

IMPORTANT! Align the arrows on the front handle as shown below. If the arrows are not aligned,
push the heated cover into the system until the handle locks into place.

Correct Incorrect

5. If you are installing a heated cover of a different consumable format, replace the sample block and
plate adapter if necessary.

6. Close the access door and ensure it is completely closed.

Note: The QuantStudio™ Real-Time PCR Software displays an error message if the door is not
completely closed and latched, or if the sample block is not seated correctly.

7. Plug in and power on the QuantStudio™ 6 or 7 Flex Real-Time PCR System.

8. In the QuantStudio™ Real-Time PCR Software Home tab, click Instrument Console.
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9. In the Instrument Console, select your instrument from the list of instruments, then review the
Heated Cover Firmware Version field in the Instrument Properties pane.

The installation is successful if the system powers on and if the Heated Cover Firmware Version
field displays a version number.

10. Check the calibration status of the system (see “View the calibration status of an instrument” on
page 29).
If the calibrations for the new sample block/heated cover have expired, perform the following
calibrations in the specified order:

a. ROl calibration

b. Background calibration
c. Uniformity calibration
d. Dye calibration

e. Normalization calibration (TagMan™ Array Card block only)

IMPORTANT! If the calibrations for the new sample block/heated cover are valid, you do not
need to recalibrate the QuantStudio™ 6 or 7 Flex Real-Time PCR System.

Change the plate adapter

Change the plate adapter in the event of a hardware failure or if you want to change the consumable
format of the QuantStudio™ 6 or 7 Flex System.

WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the plate adapter can reach
100°C. Allow the plate adapter to cool to room temperature before removing.

When to change the plate adapter

You can change the plate adapter:
* To change the consumable format of the QuantStudio™ 6 or 7 Flex System.

* |n the event of a hardware failure

Materials required

* Safety glasses
* Powder-free gloves
* Plate adapter
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Change the plate adapter
1. Touch the instrument touchscreen to activate it, then press [Jj.

2. From the Main Menu, touch &.

3. When the tray arm opens, pull the latch, then lift and remove the plate adapter.

4. Attach the new adapter to the tray arm, then pull the latch to allow the adapter to lower into place.
If necessary, apply pressure as indicated until the adapter snaps into place.

5. From the Main Menu, touch &.

6. If you are installing a tray adapter of a different consumable format, replace the sample block and
heated cover if necessary.
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IMPORTANT! This chapter does not provide adequate detail to integrate the QuantStudio™ 6 or 7
Flex Systems into all possible network architectures. Because your network may contain advanced
features (such as a firewall or network domains), consult a network administrator before connecting the
QuantStudio™ 6 or 7 Flex Systems to your laboratory network.

Networking overview

After installing the QuantStudio™ 6 or 7 Flex System, you can connect the QuantStudio™ 6 or 7 Flex
System to a local area network to enhance its functionality.
This appendix describes how to:

® Set up the QuantStudio™ 6 or 7 Flex System for use on a network.

* Set up a computer for remote monitoring.

¢ Test the network connection by engaging the remote monitoring feature.

Controlling and monitoring networked QuantStudio™ 6 and 7 Flex Systems

120

When the QuantStudio™ 6 or 7 Flex Real-Time PCR System is connected to a network, computers

on the network that are running the QuantStudio™ Real-Time PCR Software can control or monitor

it. The software can control up to 4 instruments and monitor up to 10 instruments simultaneously. A
networked system can be controlled by only one computer at a time. A networked computer running
the QuantStudio™ Real-Time PCR Software can transfer experiments to and from an instrument, begin
or stop a run, and perform some maintenance functions. During a run, the Remote Monitoring feature of
the software can be used to view the run status, temperature, and amplification data in real-time.

Note: Remote monitoring does not allow you to control the system.
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About the ethernet port

The QuantStudio™ 6 or 7 Flex Real-Time PCR System features a Gigabit Ethernet port for direct
communication with the system computer and for network communication. When the system is
connected to a network, computers on the network that run the QuantStudio™ Real-Time PCR Software
can:

¢ Send and download experiments to and from the QuantStudio™ 6 or 7 Flex Real-Time PCR
System.

* Run experiments on the QuantStudio™ 6 or 7 Flex Real-Time PCR System.
* Remotely monitor the QuantStudio™ 6 or 7 Flex Real-Time PCR System as it performs runs.

The Ethernet port of the system supports:

e Static IP network service with subnet mask, primary and secondary data network service (DNS),
and default gateway settings, or dynamic host configuration protocol (DHCP) network service

* mDNS/DNS for local domains

Note: Because mDNS is limited to direct network connections, a system set for mDNS may not be
visible to other nodes that are separated by a router, hub, or another network device.

* [Pv4 link-local (IPV4LL) in the RFC (also known as Automatic Private IP Addressing [APIPA] or
Internet Protocol Automatic Configuration [IPAC])

Note: When the QuantStudio™ 6 or 7 Flex Real-Time PCR System is set for DHCP, APIPA is
automatically enabled, and the system provides an IP address when no address is supplied by the
DHCP server.

Firewall ports that must be open

Table 9 v1.6.1 and earlier

Ports Condition
mDNS, 7000 Instrument-to-computer connection
mDNS, 5353 Instrument discovery

Table 10 v1.7 or later

Ports Condition
mDNS, 7443 Instrument-to-computer connection
mDNS, 5353 Instrument discovery
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Example network layouts

Example 1

In the following example, one or more of the QuantStudio™ 6 and 7 Flex Systems, which have been
configured for dynamic host configuration protocol (DHCP) operation, are connected to a network by
their Ethernet ports. In this layout, any computer on the network can monitor and control the systems.

Note: A networked computer running the QuantStudio™ Real-Time PCR Software can simultaneously
control up to 4 instruments and monitor up to 10 instruments that have been connected to the network.

DHCP server

|

()
&5

Networked Networked
computer instrument(s)

Example 2

In the example shown below, the QuantStudio™ 6 or 7 Flex Real-Time PCR System is connected
directly to the computer, which is also connected to the local area network. In this configuration, the
computers on the network can exchange experiments with the system computer. The QuantStudio™
6 or 7 Flex Real-Time PCR System can be neither monitored nor controlled remotely because it is
physically isolated from the network.

DHCP server

|
&

— - —

Networked Networked Instrument
computer computer
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Networking guidelines and best practices

* Consult a network administrator.
- We recommend that you consult a network administrator before connecting the QuantStudio™
6 or 7 Flex Real-Time PCR System to your laboratory network.

— To enable the full functionality of the QuantStudio™ Real-Time PCR Software, the computer
requires a network connection.

® Limit remote monitoring to 10 computers.
Avoid using more than 10 computers to simultaneously monitor the system remotely. Although
the system supports remote monitoring from multiple computers, each connection taxes the
instrument microprocessor. Too many connections can overburden the system and result in
instrument errors.

Note: The effects of an overburdened system are evident in the Temperature Plot during a
run. Symptoms can include extended hold times or brief, unexpected plateaus in the instrument
Temperature Plot.

¢ Observe the restrictions to mMDNS and Autodiscovery.
The QuantStudio™ 6 or 7 Flex Real-Time PCR System supports mDNS but only when the
system and the computer share a direct network connection and are within the same subnet.
Consequently, network computers that are separated from the system by a router, hub, or another
network device may not be able to access the system by its host name.

® Confirm the uniqueness of the instrument name.

The QuantStudio™ 6 or 7 Flex Real-Time PCR System does support name resolution but the
instrument name must be unique within the subnet. The QuantStudio™ Real-Time PCR Software
can automatically discover systems on the link-local network that are configured for Autodiscovery.

Note: The system does not test the uniqueness of the instrument name when it is set.

* Name systems using lowercase letters.
When you define the system settings, enter the instrument name using lowercase letters only.
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Network setup workflow

The following figure illustrates the workflow for installing the QuantStudio™ 6 or 7 Flex System to a local
area network.

Start
v
Collect the required network information.

v

Connect the QuantStudio™ system to the network.
v

Connect the computer to the network.

v

Monitor the system to test the network connection.
v

Finish

Collect the required network information

Obtain the following information from your network administrator:

* Network policy for obtaining IP addresses (DHCP or static IP).

IMPORTANT! When the QuantStudio™ 6 or 7 Flex System is set for DHCP, APIPA is automatically
enabled and the QuantStudio™ 6 or 7 Flex System self assigns an IP address when no address is
supplied by a DHCP server.

¢ If the network requires static IP addresses, obtain the IP address, subnet mask, and gateway
address for the QuantStudio™ 6 or 7 Flex System.

Connect the QuantStudio™ 6 or 7 Flex System to the
network

After deciding how to connect the QuantStudio™ 6 or 7 Flex System to a network, set up the
QuantStudio™ 6 or 7 Flex System according to your network policies.

Materials required

Ethernet cable with RJ45 connectors (a CAT6 Ethernet cable for a 1000Mbit/s network connection or a
CATS5 for 100Mbit/s connection)
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Define the instrument internet protocol settings

1.

Use the Ethernet cable to connect the Ethernet port of the QuantStudio™ 6 or 7 Flex Real-Time
PCR System to the nearest network port.

Power on the system.

In the main menu of the touchscreen, tap Settings then tap Set Network Information.

Note: The Set Network Information screen displays the Media Access Control (MAC) address of
the system below the Autodiscovery and Smart Monitoring check boxes. The MAC address can
be used to uniquely identify the system on the network.

Tap Autodiscovery to make the system discoverable by computers that are running the
QuantStudio™ Real-Time PCR Software.

Tap Smart Monitoring to enable the feature on the QuantStudio™ 6 or 7 Flex Real-Time PCR
System.

The Smart Monitoring feature allows Thermo Fisher Scientific service personnel to monitor the
status of the system remotely through an internet connection. Smart Monitoring employs multiple
layers of security, including a Secure Sockets Layer (SSL) and Lightweight Directory Access
Protocol (LDAP) authentication, to provide real-time troubleshooting and problem resolution for the
instrument. For a detailed description of the Smart Monitoring Service, see the Smart Monitoring
Service Product Bulletin: Leveraging the power of the Internet while maintaining system security
(Pub. No. 121PB07-03).

Set the Internet Protocol (TCP/IP) Properties for either DHCP or Static IP communication.

Network service Action

DHCP Tap Obtain an IP address automatically.

1. Tap Use the following IP address.

2. Tap the IP Address field, enter the IP address using the keypad, then tap Done.
3. Assign the:

Static IP _

* [P addresses for the DNS Servers (primary and secondary)
® Subnet Mask setting

* Default Gateway setting

7. Tap Save to save the settings, then tap OK when prompted.

8. Tap [ to return to the main menu.

Connect the computer to the network

Materials required

Ethernet cable with RJ45 connectors

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems (v1.6.1 or later) Maintenance and Administration Guide 125



Appendix C Networking
Connect the compurter to the network
Computer requirement

If you are connecting a computer that you provided to a network, confirm that the computer contains a
free network port.

Collect required information

Obtain the following information from your network administrator:
* Network policy for obtaining IP addresses (DHCP or static IP)

¢ If the network requires static IP addresses, obtain the IP address, subnet mask, and gateway
address for the computer

Set up the computer

IMPORTANT! We recommend that you arrange for a network administrator to connect your computer
to the network. The following procedure does not provide adequate detail for all network architectures.

Note: The following procedure is valid for the Microsoft™ Windows™ 7 operating system.

1. Use the Ethernet cable to connect the computer to the nearest network port.

2. Power on the computer, then log in using a user account that belongs to the Administrators user
group.

3. From the desktop, right-click My Network Places, then select Properties.
4. Right-click Local Area Connection, then select Properties.
5. Select Internet Protocol (TCP/IP), then click Properties.

6. Set the Internet Protocol (TCP/IP) Properties for either DHCP or Static IP communication:

Network

. . Action
configuration

1. Select Obtain an IP address automatically.
2. Set the DNS address. If the computer obtains DNS addresses:
DHCP e Automatically — Select Obtain DNS server address automatically.

* Statically — Select Use the following DNS address, enter the address of
the preferred and alternate DNS servers if available.

Select Use the following IP address.
In the IP Address field, enter the static IP address.
If necessary, enter a subnet mask.

Static IP

e N2

If necessary, enter a static gateway address in the Default Gateway field.

7. If your network requires advanced TCP/IP setup (such as WINS), define the settings:
a. Click Advanced in the Internet Protocol (TCP/IP) Properties dialog box.
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b. Define the IP Settings, DNS, and WINS tabs as instructed by your systems administrator, then
click OK.
8. Close all dialog boxes by clicking OK.

9. Restart the computer.
The computer is now visible to other computers on the network.

Install the QuantStudio™ Real-Time PCR Software

See “Install the software” on page 113.

Note: You must install the QuantStudio™ Real-Time PCR Software in order to monitor the
QuantStudio™ 6 or 7 Flex Real-Time PCR System over the network.

Monitor the QuantStudio™ 6 or 7 Flex Real-Time PCR
System

After connecting the system and a computer to the network, you can enable remote monitoring in the
QuantStudio™ Real-Time PCR Software to observe the instrument status remotely.

About remote monitoring

When the QuantStudio™ 6 or 7 Flex Real-Time PCR System is connected to the network, any computer
on the network that is running the QuantStudio™ Real-Time PCR Software can:

* Monitor the status of a run (see page 128)
* Download experiment files (see page 128)
¢ Enable or change the calibration reminders (see page 128)

Guidelines for remote monitoring

To help ensure optimal performance of the remote monitoring feature, observe the following guidelines:
* The QuantStudio™ Real-Time PCR Software can monitor up to 10 instruments.

* We do not recommend that a QuantStudio™ 6 or 7 Flex Real-Time PCR System be monitored by
more than 10 computers simultaneously.

* Unless you are sure that your system and computer exist on the same subnet, we recommend that
you use the IP address of the QuantStudio™ 6 or 7 Flex Real-Time PCR System to add it for remote
monitoring.
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Monitor the status of a run from the QuantStudio™ Real-Time PCR Software
1. In the QuantStudio™ Real-Time PCR Software Home tab, click Instrument Console.

2. In the Instrument Console, select the icon for your instrument, then click Manage Instrument.

Note: If the Manage Instrument button is inactive, add your instrument to the My Instruments
group.

3. In the Instrument Manager, click Monitor, then click Information.

4. In the Monitor Instrument screen, click Monitor Running Instrument.

The QuantStudio™ Real-Time PCR Software displays the status, attributes, calibration status, and
plot data for the selected system. If a communications warning appears, contact your network
administrator to troubleshoot the problem.

You can lose the software connection to the system if you:
® (Change the system that is connected directly to your computer
* Use the touchscreen to change the instrument name or IP address

Note: To reestablish the connection, restart the software.

Download experiment files

For more information about using the QuantStudio™ Real-Time PCR Software to transfer experiment
results from the QuantStudio™ 6 or 7 Flex Real-Time PCR System, see “Transfer experiments,
templates, and results data” on page 91.

Enable or change the calibration reminders

The calibration reminder settings allow you to configure the QuantStudio™ Real-Time PCR Software to
alert you by email when the QuantStudio™ 6 or 7 Flex Real-Time PCR System requires calibration. The
notifications settings feature is optional, and it does not affect performance.

IMPORTANT! The QuantStudio™ Real-Time PCR Software transmits email only while the system is
monitored. If the network connection is interrupted, the software stops transmitting updates.

Collect the required information

The QuantStudio™ Real-Time PCR Software requires access to a Simple Mail Transfer Protocol (SMTP)
server to email calibration reminders. Contact your systems administrator or information technology
department for the following information:

* Network address of a SMTP server.
* A user name and password for the server, if required for access.
* The Secure Sockets Layer (SSL) setting of the server (on or off).

128 QuantStudio™ 6 and 7 Flex Real-Time PCR Systems (v1.6.1 or later) Maintenance and Administration Guide



Appendix C Networking
Monitor the QuantStudio™ 6 or 7 Flex Real-Time PCR System

Define the mail server settings

1. In the QuantStudio™ Real-Time PCR Software, select Tools » Preferences.
2. In the Preferences dialog box, select the SMTP Settings tab.

3. Inthe SMTP Settings tab, define the settings for the SMTP server:

* Outgoing Mail Server (SMTP) field —Enter the network address of a Simple Mail Transfer
Protocol (SMTP) server. Optionally, you can specify the transmission control protocol (TCP)
port for the server by appending the port number to the server name, separating the two using
acolon ().

For example: smtp.mycompany.com:2023

Note: If a TCP port is not specified, the QuantStudio™ Real-Time PCR Software uses the
default port number (25).

* Encryption Required—Select if the mail server has SSL enabled.
* Authentication Required—Select if the mail server requires a user name and password.

¢ User Name and Password fields—If the mail server requires authentication, enter the user
name provided by your systems administrator.

4. Click OK.
Modify the notification settings for a monitored QuantStudio™ 6 or 7 Flex Real-Time
PCR System

1. Open the Calibration Reminders screen for the QuantStudio™ 6 or 7 Flex Real-Time PCR System:
a. In the QuantStudio™ Real-Time PCR Software Home tab, click Instrument Console.

b. In the Instrument Console, select your instrument from the list of instruments on the network,
then click Add to My Instruments.

Note: You must add a system to your list before you can manage it.

c. After the system is added to your list, select it, then click Manage Instrument.
d. In the Instrument Manager, click .5 Maintenance, then click Calibration Reminders.

2. In the Calibration Reminders Setting table, configure the notification settings for the calibrations
in interest. For each calibration that you want to monitor:

a. In the Expiry Interval column, enter the number of days that elapse before the type of
calibration expires on the system.

b. In the Send a Reminder column, select the check box to configure the QuantStudio™
Real-Time PCR Software to email a reminder to perform the calibration.

c. In the Reminder Interval column, enter the number of days that elapse before the software
emails recipients a reminder to perform the calibration.
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3. In the Enter e-mail addresses for notifications field, enter the email address(es) that you want to
receive email notifications. Separate multiple email addresses with commas (,).

4. Click Apply to change the notification settings.
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Place the QuantStudio™ 6 or 7 Flex Real-Time PCR System
on standby

If left unattended, the system automatically enters standby mode to conserve power. To enter standby
mode manually, tap [@ on the system touchscreen.

Power on the QuantStudio™ 6 or 7 Flex Real-Time PCR
System

To power on the QuantStudio™ 6 or 7 Flex System from a powered-off state:
1. Tap anywhere on the touchscreen to determine if the QuantStudio™ 6 or 7 Flex Real-Time PCR
System is in standby mode.
Does the touchscreen display the Standby screen after you touch it?
* Yes—The instrument is ready for use. Go to step 4.
* No—Go to step 2 to power on the instrument.

2. Power on the system. Toggle the power button on the rear of the system, then wait for it to start.

The system is ready to use when the touchscreen displays the main menu.
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3. Power on the monitor.

4. Power on the computer:
a. Press the computer power button, then wait for it to start.

b. When the Login screen appears, enter your user name and password, then click OK.

5. Start the QuantStudio™ Real-Time PCR Software:
a. On the desktop, double-click QuantStudio™ Real-Time PCR Software.

Note: If the shortcut is not present on the desktop, select Start » All Programs » Applied
Biosystems » QuantStudio Real-Time PCR Software to start the software.

IMPORTANT! If the software does not start, confirm that no other instances of the
instrument control software are open. If any instance of the software is open, close it before
starting the software.

b. If the QuantStudio™ Real-Time PCR Software Login appears, enter your user name and
password, then click Log In.

Enter your user name and password to log in.

User Name: ‘

Password: ‘

Exit Application

Note: Security is a separately licensed module. If your system requires this module, contact
Thermo Fisher Scientific.

Note: If the software displays the License Central screen after you log into the software,
your license file may have become corrupt. Contact Support to obtain a replacement license
file.

Power off the QuantStudio™ 6 or 7 Flex Real-Time PCR
System

The systems operate in low-power mode when not in use. The system can be powered off completely
so that the components draw no power.

Note: If the systems are inactive for extended periods of time, prepare them for storage (see “Store the
QuantStudio™ 6 or 7 Flex System” on page 133).

1. Power off the QuantStudio™ 6 or 7 Flex Real-Time PCR System:
a. If the touchscreen is not blank, tap [¢) to place the system into stand-by mode.
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b. Toggle the power button on the rear of the QuantStudio™ 6 or 7 Flex Real-Time PCR System.

2. Power off the computer:
a. From the desktop, select Start » Shut Down.

b. From the Shut Down Windows™ dialog box, select Shut Down, then click OK.

3. Power off the monitor.

Store the QuantStudio™ 6 or 7 Flex System

The QuantStudio™ 6 or 7 Flex System can be powered off and stored for extended periods of time. The
length of the period of inactivity determines the method you use to power off the QuantStudio™ 6 or 7
Flex System.

Materials required

Reaction plate or array card (unused)

Prepare the QuantStudio™ 6 or 7 Flex Real-Time PCR System

1. If you plan to store the QuantStudio™ 6 or 7 Flex Real-Time PCR System for more than a week or
you plan to move it, load an unused plate or array card into the system:

Note: The empty plate or array card protects the internal components of the system during
transport or during periods of inactivity lasting more than a week.

a. Tap [@ on the touchscreen.

b. Tap ¥ to eject the tray arm, place a plate or array card onto the plate adapter, then tap [
again to load the plate.

c. Tap [@] to place the system in stand-by mode.
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2. Toggle the power button on the rear of the system.

3. Power off the computer:
a. Select Start » Shut Down.

b. From the Shut Down Windows™ dialog box, select Shut Down, then click OK.

4. Power off the monitor.

Move the QuantStudio™ 6 or 7 Flex System

Perform this procedure to safely move the QuantStudio™ 6 or 7 Flex System short distances (for
example, between laboratories of the same building).

CAUTION! PHYSICAL INJURY HAZARD. Do not attempt to lift the QuantStudio™ 6 or 7 Flex
System or any other heavy objects unless you have received related training. Incorrect lifting can
cause painful and sometimes permanent back injury. Use proper lifting techniques when lifting or
moving the QuantStudio™ 6 or 7 Flex System. At least two people are required to lift it.

IMPORTANT! Moving your QuantStudio™ 6 or 7 Flex System can create subtle changes in the
alignment of the instrument optics. Recalibrate the instrument if necessary.
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How to handle the sample block and heated cover

To prevent damaging or contaminating the sample block or the heated cover, handle the assemblies as
shown below. After you remove each assembly from the QuantStudio™ 6 or 7 Flex System, place them
on a clean, dry surface or in its shipping container.

Prepare the QuantStudio™ 6 or 7 Flex System components
1. Power off the QuantStudio™ 6 or 7 Flex System and computer.

2. When the QuantStudio™ 6 or 7 Flex System and computer are powered off, disconnect all
QuantStudio™ 6 or 7 Flex System components and package the cabling for the move.

3. Prepare the QuantStudio™ 6 or 7 Flex System for the move:
a. Open the QuantStudio™ 6 or 7 Flex System access door.

b. Firmly press down on the sample block handle, pull the sample block from the QuantStudio™
6 or 7 Flex System, then place it on a clean, dry surface.

c. Pinch the handle of the heated cover together, then pull the assembly from the QuantStudio™
6 or 7 Flex System and place it on a clean, dry surface.
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d. Package the sample block and heated cover assembilies in a clean, dust-free container.

Move the QuantStudio™ 6 or 7 Flex System

Move the QuantStudio™ 6 or 7 Flex System according to the following guidelines:

Ensure that the surface on which you will place the QuantStudio™ 6 or 7 Flex System can support
at least 77.9 £ 0.6 kg (171.5 £ 0.13 Ibs).

Ensure that the path to transport the QuantStudio™ 6 or 7 Flex System is clear of obstructions.
At least two people are needed to lift and carry the QuantStudio™ 6 or 7 Flex System.

Keep your spine in a good neutral position.

Bend at the knees and lift with your legs.

Do not lift an object and twist your torso at the same time.

Coordinate your intentions with your assistant before lifting and carrying.

Reinstall the QuantStudio™ 6 or 7 Flex System

136

1.

Reconnect the components of the QuantStudio™ 6 or
7 Flex System. Use the Ethernet cable supplied with

the instrument to connect the QuantStudio™ 6 or 7 Flex
System to the network interface card in the computer.

IMPORTANT! Do not use a standard Ethernet cable
to connect the QuantStudio™ 6 or 7 Flex System to the
computer.

Ethemet

Install the sample block and heated cover assemblies.

Perform an RNase P instrument verification run. If the
run:

Passes — Do not recalibrate the QuantStudio™ 6 or 7 Flex System. No further action is necessary.
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Fails — Perform the following calibrations in the specified order:
a. ROI

b. Background
c. Uniformity
d. Dye

e. Normalization (TagMan™ Array Card block only)
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IMPORTANT! Security, Audit, and Electronic Signature (SAE) is a separately licensed module available
only on purchase. If your system requires this module, contact Thermo Fisher Scientific. The feature is
disabled by default even after the installation of the license and needs to be enabled.

The Security, Audit, and Electronic Signature (SAE) module is a component of the QuantStudio™
Real-Time PCR Software that allows you to configure the QuantStudio™ 6 and 7 Flex Systems to meet
specific requirements. The module provides the following functionality:

Security— Controls user access to the software. A default Administrator user account is provided,
and additional user accounts and permissions can be user-defined.

Note: You can enable or disable system security globally.

Note: The default password for the Administrator user account is Administrator; however, the
password can be changed during installation.

Auditing —Tracks changes made to library items, actions performed by users, and changes to the
Security, Audit, and Electronic Signature settings. The software automatically audits some actions
silently. You can select other items for auditing and specify the audit mode. The Auditing function
provides reports for audited library items, Security, Audit, and Electronic Signature changes, and
actions.

Note: You can enable or disable auditing globally and by record type.
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* Electronic signature (e-sig)—Determines if users are required to provide a user name and
password when performing certain functions. You can configure e-sig so that a user can print
a report or start a run only if the associated data are signed. You can also configure each e-sig
event to require multiple signatures and to require users with specific permissions to sign.

Note: You can enable or disable electronic signature globally.

Example applications

You can configure the Security, Audit, and Electronic Signature module in a variety of ways. For
example, you can:

* Require users to log in, and leave audit disabled.

* Allow only certain users to create or modify protocols.

¢ Allow only certain users to approve reviewed samples.

* Require experiments to be signed before users can run or print them.

Configure the security system

Access the Security screen and enable or disable security

Use the Security screen to disable and enable security, control restrictions and security policies for all
user accounts, and set up notifications when certain security events occur.

Note: Security is disabled by default.

To enable or disable security:

1. In the QuantStudio™ Real-Time PCR Software, select Tools » Security » Settings.
2. In the Security Settings dialog box, select the System tab.

3. Select or deselect Enable Security. Note the following:
* The software requires you to enter your user name and password when you enable security.
* The enable commands are grayed when a run is in process.
* When security is disabled, the @ is not active in lower parts of the screen.

* Disabling Security inactivates Auditing and E-Signature.

IMPORTANT! If you disable security, you inactivate audit and electronic signature functions;
however, no audit record is generated to indicate that audit and electronic signature functions are
disabled.

IMPORTANT! If you enable or disable the QuantStudio™ Real-Time PCR Software security,
auditing, and electronic signature feature, you must similarly enable or disable the QuantStudio™
6 or 7 Flex Real-Time PCR System security (see “Enable or disable instrument security” on

page 101). The software cannot connect to systems that do not match security settings.

4. Click Apply Settings.
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Set account setup and security policies

Note: Security policies apply to all user accounts.

1. In the QuantStudio™ Real-Time PCR Software, select Tools » Security » Settings.

2. In Account Setup, specify User Name limits.

IMPORTANT! The software allows spaces in user names. Use spaces in user names with caution.
For information, see “Spaces in user names and/or passwords” on page 140.

3. Specify User Password limits:
a. Specify the passwords length limits.

b. Specify password reuse. You cannot disable the password reuse restriction.

c. Specify the allowed characters in user passwords: spaces and alphabetical, numeric,
uppercase, lowercase, and special characters (commas, periods, semicolons, dashes,
underscores, and tildes).

4. In Security Policies, specify Password Expiration, Account Suspension, and Session Timeout
settings.

Note: A session times out while a run is in progress if the time-out period is exceeded and there is
no other user activity.

5. In the Open Non-Secure Data option, select Yes or No to determine whether users can open
experiments and templates that were created without security settings.

6. Click Set Up Messaging Notification Settings to specify when and how the software notifies the
administrator of certain security events. For information, see “Set up messaging notifications” on
page 141.

7. Click Apply Settings.

The new settings are applied to the user account the next time that the user logs in.

Spaces in user names and/or passwords

If you allow spaces in user names and/or passwords, be aware of the following issues:
* |eading and trailing spaces in user names are difficult to detect on the screen or in printed reports.
* The number of consecutive spaces in a user name is difficult to determine on the screen or in
printed reports.

Spaces in user names may cause confusion when a user searches for an audit record associated with
a user name. To find a record associated with a user name, specify the user name exactly, including
leading, consecutive, and trailing spaces.
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Set up messaging notifications

1. In the QuantStudio™ Real-Time PCR Software, select Tools » Security » Settings.

2. In the Security screen, click Set Up Messaging Notifications to display the Setup Notifications
dialog box.

3. Select the events for notification:

System security enabled or disabled — Security has been enabled or disabled.

User did not enter correct password—A user attempts to log in with an incorrect password.
The message indicates the number of failed authentications.

User account suspended —The user exceeds maximum number of allowed failed
authentications (login attempts with an incorrect password).

User session timed out—No activity occurred in a user account for the specified period of
inactivity.

4. Select the notification method:

Notify Admin at Login—If an event triggers notification, the next time any user with an
Administrator role logs in, the software lists those events, indicating the time each event
occurred and the user who triggered the event.

The Administrator has the option of acknowledging the event, which removes it from the
notification list.

Email Notification—If an event triggers notification, the QuantStudio™ Real-Time PCR
Software sends an email to the addresses in the adjoining Email Address column of the
table. The email notification displays the triggered event and displays the time that the event
occurred and the user who triggered the event.

5. Click OK.
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User account management

Create or edit user accounts

The software includes a default Administrator user account with permissions (defined by the account
user role) to perform all functions in the software. You cannot modify this account.

1. In the QuantStudio™ Real-Time PCR Software, select Tools » Security » Settings.

2. In the Security Settings dialog box, select the Users tab. In the Users tab, you can perform the
actions in the following table:

To... Action
1. Click Create to display the New User dialog box.
2. Enter user name, password, first name, middle initial (optional), and last name. Click a field
to display the field limits, which are specified in Security settings.
Note: First name, Ml (middle initial), and last name are used to create User Full Name,
which is displayed as the name of the logged-in user.
Note: You cannot change the user name after you save the user account.
3. Select Password Expires at First Login to require the user account to specify a new
Create a user password at first log in. The Password Expires On date is specified in Security settings.
account 4. Select the user role (described in “Create or edit a user role” on page 143) and the
electronic signature state (determines if a user account has permission to electronically
sign objects).
Leave the status set to ACTIVE.
5. (Optional) Enter email (for information only), phone, and comments.
6. Click Save.
A shaded Save button indicates an invalid entry in a field. Click a field to display the limits
for the field, then enter a valid entry.
1. In the Users screen, select a user account, then click Edit.
Edit a user Note: If you select multiple users, only Status and Role will change.
account 2. Edit settings as needed. You cannot edit the user name of an existing user.
3. Click Save.
Activate a 1. In the Users screen, select the user.
suspended user 2. Click Edit.
account 3. Change the Status from SUSPENDED to ACTIVE, then click Save.

Disable
(inactivate) a user
account

1.
2.
3.

IMPORTANT! You cannot delete a user, because user records are required for auditing. To
disable a user account, inactivate it as follows.

In the Users screen, select the user.
Click Edit.
Change the Status from ACTIVE to INACTIVE, then click Save.
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(continued)

To... Action

1. In the Users screen, select the affected user account, then click Edit.

2. Enter a replacement password for the user, then re-enter the password for confirmation.
Reset a forgotten

password 3. If you assigned the user a temporary password, then select Password Expires at First

Login to require the user to specify a new password at log in.
4. Click Save.

Determine the name of the logged-in user

The title bar of the QuantStudio™ Real-Time PCR Software window displays the name of the user.

Create or edit a user role

User roles determine the permissions associated with a user account. The QuantStudio™ Real-Time
PCR Software includes three default user roles:

* Administrator (cannot be edited or deleted)
* Scientist
® Technician

You can modify the Scientist and Technician roles, and you can create your own roles with customized
settings as needed.

1. In the QuantStudio™ Real-Time PCR Software, select Tools » Security » Settings.
2. In the Security Settings dialog box, select the Roles tab.

From the Roles tab, you can perform the actions in the following table:

To... Action

1. Click Create.
2. Enter a role name and (optional) description.

3. Select permissions (see “Permissions and default user roles (QuantStudio™ Real-Time
PCR Software v1.6.1)” on page 144). To select all permissions in a category, select
the check box next to the category.

Create a user
role

Note: Operations not shown in the following table are available to all user roles.
4. Click Save Role.

1. In the Roles screen, select a user role, then click Edit.
Edit auserrole | 2. Edit settings as needed. You cannot edit the Administrator user role.
3. Click Save Role.
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Permissions and default user roles (QuantStudio™ Real-Time PCR Software v1.6.1)

Note: To determine the permissions for a default role or to edit it, select the role, then click Edit.

The following table shows all user-configurable permissions and the settings for the default user

accounts.
Permissions Default user roles
Category Function Scientist | Technologist | Administrator
Create and.edlt expenmepts or ex.penment Yes Yes Yes
templates (includes running experiments)
Print, create a slide, and print a report Yes Yes Yes
Setup
Expprt exp.enment. results, audit reports, and Yes Yes Yes
audit security settings
Create, edit, and import sample attributes Yes Yes Yes
Perform a run using the Quickstart function Yes Yes Yes
Run Start arun Yes Yes Yes
Stop a run Yes Yes Yes
Create targets Yes Yes Yes
Targets (Library) Edit targets Yes Yes Yes
Delete targets Yes Yes Yes
Cregte analysis settings (includes default Yes Yes Yes
settings)
Analysis Settings
(Library) Edit analysis settings (includes default settings) Yes Yes Yes
Delete analysis settings Yes Yes Yes
Create a run method Yes Yes Yes
Run Methods (Library)
Delete a run method Yes Yes Yes
Create a custom dye Yes Yes Yes
Dye Edit a dye Yes Yes Yes
Delete a dye Yes No Yes
Create or. edit g study (for example, edit a plate Yes Yes Yes
or analysis settings)
Study Add (transfer) experiments to a study Yes Yes Yes
Remove experiments from study Yes Yes Yes
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(continued)
Permissions Default user roles
Category Function Scientist | Technologist | Administrator
Preferences Edit the system preferences Yes No Yes
Calibrations Perform calibrations Yes Yes Yes
RNaseP Perform an RNase P run Yes Yes Yes
Instrument Configuration | Add and remove instruments from monitoring No No Yes
Instrument Console Delete experiment Yes Yes Yes
Configure the security and audit feature No No Yes
Security Configuration Log in to user sessions that have timed out No No Yes
Perform E-Signing Yes Yes Yes
Manage the control library (add, edit, delete, Yes Yes Yes
delete all, import, or export)
Manage the sample library (add, edit, delete, Yes Yes Yes
delete all, import, or export)
Libraries Manage the SNP assay library (add, edit, delete, Yes Yes Yes
delete all, import, or export)
Manage the target library (add, edit, delete, Yes Yes Yes
delete all, import, or export)
Manage the analy.3|s settings library (add, edit, Yes Yes Yes
delete, delete all, import, or export)
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Permissions and default user roles for QuantStudio™ Real-Time PCR Software v1.7
orvil.7.1

Note: To determine the permissions for a default role or to edit it, select the role, then click Edit.

The following table shows all user-configurable permissions and the settings for the default user

accounts.
Permissions Default user roles
Category Function Scientist | Technologist | Administrator
T S TP e | e s
includes unming oxporments) Yes | Vs Yee
Setup Print, create a slide, and print a report Yes Yes Yes
E;(gict)r; ;;Lﬁi;rzzg nrszults, audit reports, and Yes Yes Yes
Create, edit, and import sample attributes Yes Yes Yes
Import plate setup Yes Yes Yes
Perform a run using the Quickstart function Yes Yes Yes
Run Start a run Yes Yes Yes
Stop a run Yes Yes Yes
Create target Yes Yes Yes
Targets (Library) Edit target Yes Yes Yes
Delete target Yes Yes Yes
Create targets Yes Yes Yes
Targets Edit targets Yes Yes Yes
Delete targets Yes Yes Yes
Create samples Yes Yes Yes
Samples Edit samples Yes Yes Yes
Delete samples Yes Yes Yes
Create sample Yes Yes Yes
Samples (Library) Edit sample Yes Yes Yes
Delete sample Yes Yes Yes
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(continued)
Permissions Default user roles
Category Function Scientist | Technologist | Administrator
S:t?r;cg Sa;nalysis settings (includes default Yes Yes Yes
Analysis Settings (Library) Edit analysis settings (includes default settings) Yes Yes Yes
Delete analysis settings Yes Yes Yes
Create a run method Yes Yes Yes
Run Methods (Library)
Delete a run method Yes Yes Yes
Create a custom dye Yes Yes Yes
Dye Edit a dye Yes Yes Yes
Delete a dye Yes No Yes
(C)):zerl]tael ;Srl Secsiiett: :;sz;jy (for example, edit a plate Yes Yes Yes
Study Add (transfer) experiments to a study Yes Yes Yes
Remove experiments from study Yes Yes Yes
Preferences Edit the system preferences Yes No Yes
Calibrations Perform calibrations Yes Yes Yes
RNaseP Perform an RNase P run Yes Yes Yes
Instrument Configuration | Add and remove instruments from monitoring No No Yes
Instrument Console Delete experiment Yes Yes Yes
Configure the security and audit feature No No Yes
Security Configuration Log in to user sessions that have timed out No No Yes
Perform E-Signing Yes Yes Yes
e S e s
Libraries Z:;?eg:lt r}iqspiﬂfaﬁ I(i:)n(ggt)(add, edit, delete, Yes Yes Yes
Manage the SNP assay library (add, edit, Yes Yes Yes

delete, delete all, import, or export)
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(continued)
Permissions Default user roles
Category Function Scientist | Technologist | Administrator
Manage the target library (add, edit, delete, Yes Yes Yes
delete all, import, or export)
Libraries
Manage the analysis settings library (add, edit, Yes Yes Yes

delete, delete all, import, or export)

Permissions and default user roles for QuantStudio™ Real-Time PCR Software

v1.7.2

Note: To determine the permissions for a default role or to edit it, select the role, then click Edit.

The following table shows all user-configurable permissions and the settings for the default user

accounts.
Permissions Default user roles

Category Function Scientist | Technologist | Administrator
e e T P e | v s
inclutes ruming sxpormenty Yeo | Yes Yes
Setup Print, create a slide, and print a report Yes Yes Yes
Z(Si?r; eeé(:)rir;llrzgtrlf nrgz,ults, audit reports, and Yes Yes Yes
Create, edit, and import sample attributes Yes Yes Yes
Import plate setup Yes Yes Yes
Perform a run using the Quickstart function Yes Yes Yes
Run Start arun Yes Yes Yes
Stop a run Yes Yes Yes
Create target Yes Yes Yes
Targets (Library) Edit target Yes Yes Yes
Delete target Yes Yes Yes
Create targets Yes Yes Yes
Targets Edit targets Yes Yes Yes
Delete targets Yes Yes Yes
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User account management

(continued)
Permissions Default user roles
Category Function Scientist | Technologist | Administrator
Create samples Yes Yes Yes
Samples Edit samples Yes Yes Yes
Delete samples Yes Yes Yes
Create sample Yes Yes Yes
Samples (Library) Edit sample Yes Yes Yes
Delete sample Yes Yes Yes
g;ft?;: Se;nalysis settings (includes default Yes Yes Yes
Analysis Settings (Library) Edit analysis settings (includes default settings) Yes Yes Yes
Delete analysis settings Yes Yes Yes
Create a run method Yes Yes Yes
Run Methods (Library)
Delete a run method Yes Yes Yes
Create a custom dye Yes Yes Yes
Dye Edit a dye Yes Yes Yes
Delete a dye Yes No Yes
S:Z?-,t; ;S: Sezztz :;L;;jy (for example, edit a plate Yes Yes Yes
Study Add (transfer) experiments to a study Yes Yes Yes
Remove experiments from study Yes Yes Yes
Preferences Edit the system preferences Yes No Yes
Calibrations Perform calibrations Yes Yes Yes
RNaseP Perform an RNase P run Yes Yes Yes
Instrument Configuration | Add and remove instruments from monitoring No No Yes
Instrument Console Delete experiment Yes Yes Yes
Configure the security and audit feature No No Yes
Log in to user sessions that have timed out No No Yes
Security Configuration
Perform E-Signing Yes Yes Yes
License Central No No Yes
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(continued)
Permissions Default user roles
Category Function Scientist | Technologist | Administrator

Manage the control library (add, edit, delete, Yes Yes Yes
delete all, import, or export)
Manage the sample library (add, edit, delete, Yes Yes Yes
delete all, import, or export)

Libraries Manage the SNP gssay library (add, edit, Yes Yes Yes
delete, delete all, import, or export)
Manage the target library (add, edit, delete, Yes Yes Yes
delete all, import, or export)
Manage the analy§|s settings library (add, edit, Yes Yes Yes
delete, delete all, import, or export)

View or print a user report

Note: The landscape and portrait functions are not available for the User or Roles reports. To print
either report in landscape, save the report electronically (PDF), then print the file in the desired
orientation.

1. In the QuantStudio™ Real-Time PCR Software, select Tools » Security » Settings
2. From the Security Settings dialog box, select the Users or Roles tab.
3. Click View Report.

4. From the Report screen, click tool bar options to manipulate the report as needed. Place the
mouse pointer over an item for a description of the item.

5. Click ¢ (Print) to print the report, or click [Z] (Save) to save the report electronically (PDF).

6. Close the report.
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Audit trail management

Access the audit screen and enable or disable auditing

Use the Audit screen to control the auditing state (disabled or enabled), the events that are audited, and
the reasons available to users when audit mode is set to Prompt or Required.

Note: Auditing is disabled by default.

IMPORTANT! If you disable security, you inactivate audit and electronic signature functions; however,
no audit record is generated to indicate that audit and electronic signature functions are disabled.

To enable auditing:

1. In the QuantStudio™ Real-Time PCR Software, select Tools » Security » Settings.
2. In the Security Settings dialog box, select the Audit tab.
3. Select or deselect Enable Audit.

4. Click Apply Settings.

Modify the auditing settings

To... Action

1. In the Audit Settings group of the Audit tab, select the objects to audit and the mode for
each enabled item (Experiments, Experiment Templates, or Study).

2. Set the Audit Mode for each item you enable for auditing:

Select ¢ Optional — The event is audited, a reason prompt is displayed, but the user can
objects to cancel and continue without entering a reason.
audit * Required — The event is audited, a reason prompt is displayed, and the user must

specify a reason and enter comments in the Comments field.
¢ Silent — The event is audited, no reason prompt is displayed.
3. Click Apply Settings.

You can create, modify and delete the reasons that are available for selection in the Audit
Reason dialog box (displayed when a user performs an audited action).

Create

audit 1. To require users to select a pre-defined reason in the Audit Reason dialog box (displayed
reason when a user performs an audited action), enable Require users to select a reason to
settings change from the list. Users are not permitted to enter a reason.

2. As needed, click Create, or select a reason from the list, then click Edit or Delete.
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Actions that can be audited

* Sign-in (success or failure)

* Sign-out (success)

* Enable or disable e-signatures

* Update audit settings

* Export or import security configuration records

* Export or import user accounts

* Install a license file (success or failure; v1.7 or later)
* Export setup or results

* Run (start, stop, completion, abort, failure, or error)
* Archive, purge, or restore action records

* Archive, purge, or restore audit records

Audit report generation

You can use the QuantStudio™ Real-Time PCR Software to generate reports of audit history from both
the Security Settings dialog box and from open experiments, templates, or studies.

* View audit histories from the Security Settings dialog box (see page 152)
* View audit histories from an experiment, a template, or a study (see page 156)

Viewing audit histories from the security settings dialog box
1. In the QuantStudio™ Real-Time PCR Software, select Tools » Security » Settings.

2. In the Security Settings dialog box, select the Audit tab, then click View Reports.

Note: To access the Audit Reports screen, the user role for an account must have the Configure
the security and audit feature permission. Users without the permission can view object audit
histories for individual entries in the libraries by selecting entries, then clicking View Audit History.
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From the Audit Reports dialog box, you can perform the actions in the following table:

To... Action

1. Select a tab to display:

¢ System Configuration History —Security, audit, and electronic signature configuration
records, including audit history for each user account.

¢ Action Record—System-specified audit events.

Display audit 2. (Optional) Select Filter by, then filter the table:

histories * Sort the table.

¢ Specify filters (date range, user name, action, object or record type, object or record
name, reason), then click Refresh.
Note: The Reason field in System Configuration History is not used.

* Select one or more records, then click View Report.

The Action Record log lists system-specified audit events.
All items in the action log are audited silently, except for the items noted as configurable.
Configurable items may include comments in the action log.

* Audit Settings (Update)

¢ Auditing Event (Archive, Restore, Purge)
Review the action |

I Configuration (Import, Export)
og

e Data Audit (Archive, Restore, Purge)

* Login (Success, Failure)

* Logout (Success)

* Run (Start, Stop, Completed, Failed, Aborted, Error)
® User Account (Create, Update)

1. Select the System Configuration History tab.

2. Display the records of interest.

3. Filter the list to decrease the time required to generate reports.
IMPORTANT! You cannot cancel a report after you click a view button.

4. Click View Report.

View and print

Note: From the audit report, the Create action value is listed as Added, Delete action
audit reports

value is displayed as Removed, and Update action value is displayed as Updated.

5. From the Report screen, click tool bar options to manipulate the report as needed. Place
the mouse pointer over an item for a description of the item.

* To print the report, click = (Print).
* To save the report electronically (PDF), click (] (Save).
6. Close the report.
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Audit report generation
(continued)
To... Action
The audit archive function makes a copy of audit records. Purge makes a copy of audit records,
and then deletes them. You can use the Restore function to restore purged audit records.
Archive and purge
To selectively archive or purge (delete) system configuration or action audit records:
1. Select the System Configuration History tab.
Archive, purge, | 5 gelect records in the appropriate screen.
and restore audit 3 . .
records . Click Archive or Purge.
4. If you select Archive, specify a location and name for the archive file (ASZ).
Restore
To restore system configuration or action audit records, click Restore, then select the ASZ file to
restore.
If the restore is not successful, see “Computer host ID to restore audit records” on page 154.
You can export audit records to a TXT file for additional manipulation and reporting outside the
QuantStudio™ Real-Time PCR Software.
1. Display the records of interest as described above.
Export audit 2. Click Export.
records ) . ! .
3. Specify a name and location for the export TXT file, then click Save.
Note: If you export audit records for samples that have been deleted or moved, an error
message is displayed. Return sample data files to their original location, then export again.
Review
the system The System Configuration History lists security, audit, and electronic signature configuration
configuration records.
history

Computer host ID to restore audit records

To restore audit records, the system requires the computer host ID during the archival to match the
computer host ID during the restoration. If there was a change to the computer host ID, the audit
records cannot be restored.

The following actions result in a change to the computer host ID:
* A change to the computer name
* Resetting the computer to the factory settings

A change to the IP address of the computer does not change the host ID.

1. If the host ID was changed, change the computer name in the computer settings to match the
name of the computer where the archival was performed.
2. Restore the audit records.

3. Change the computer name back to the original name after the audit records are restored.
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Review the system configuration history

The following table summarizes the actions that can be audited using the QuantStudio™ Real-Time
PCR Software. The System Configuration History lists security, audit, and electronic signature
configuration records.

Note: If you have installed additional modules to the software, then the list can contain additional
auditable records.

Record type Action Corresponds to...

Security Settings Update | Disable, enable, or modify security policies and session time-out settings

Modify password settings, security policies (password expiration and

Account Settings Update . .
account suspension), or user name settings

User Group Manager Update | Create, delete, or modify reason for change

Create | Create user role

User Role Delete | Delete user role

Update | Modify user role

Create | Create new user account

User Account
Update | Edit or suspend a user account

Delete | Assign a different user role to an existing user account

Role Assignment Create a user account, or assign a different user role to an existing

Update account
Audit Settings Update | Enable or disable auditing
Audit Type Update | Modify audit settings

Function Management Settings | Update | Update function management

Function Access Manager Update | Update function access management

Create | Create function

Function Delete | Delete function

Update | Update function

Create | Create a user role

Role Permissions Delete | Delete a user role

Update | Modify user role permissions

Delete | Create reason for change

Audit Reason for Change
Update | Delete or modify reason for change
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Audit report generation
(continued)
Record type Action Corresponds to...

Event Manager Update | Update the event manager

E-signature Manager Update | Enable or disable e-signature
Create | Create an e-signature meaning

E-signature Type Delete | Delete an e-signature meaning
Update | Edit an e-signature meaning or an e-signature action

E-signature Function Update | Edit an action requiring e-signature

File Name Update | Update the file name

File Version Update | Update the file version

Viewing audit histories from an experiment, template, or study

1.

In the QuantStudio™ Real-Time PCR Software, open an experiment (EDS), template (EDT), or study
(EDM) file.

From the open file, click ¥ Audit, then click Audit Records.

(Studies only) Select the audit records of interest:

® Study to view the audit records for the study.

* The name of an experiment to view the audit records for the experiment.

From the Audit Records screen of the open file, you can perform the actions in the following table:

To... Action
(Optional) Filter the table.
1. Check the Filter by check box.
Display the 2. Enter criteria for the records of interest, such as a date range, a user name, or a type of action.
audit 3. Click Refresh.
history To view details for a specific record:
1. Click the row in the list on the left to view the details of the record in the table on the upper right.
2. Click any row to view details for individual records in the table on the bottom right.
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(continued)

To... Action

1. From the table on the left, select the records to be exported:
® Click in the table, then press Ctrl-A to select all the records in the table.
* C(Click and drag or press Shift to select continuous rows.
Export * Press Ctrl to select discontinuous rows.
audit 2. Export the records:
records ¢ Click Export Summary to export only the records in the left table.
* Click Export Details to export the records in the left table and the associated details.
3. Select a location for the export file, enter a name for the file, then click Save.

4. Click OK in the confirmation message.

1. Click View Summary Report to open the Print Preview dialog box.
2. Preview, save or print the report:

* Click [Z] (Save) to save the report as a PDF or HTML file. Enter the file name, select a

Print audit location, select the file type, then click Save.

records
* Click =5 (Print) to send the report to the printer. From the Print dialog box, select the printer

and print options, then click OK.
3. Click 3 to close the Print Preview dialog box.

Manage electronic signature

Access the e-signature settings screen, and enable or disable the e-
signature

Use the Security screen to disable and enable electronic signature.

Note: Electronic signature is disabled by default.

To enable or disable electronic signature:

1. In the QuantStudio™ Real-Time PCR Software, select Tools » Security » Settings.
2. In the Security Settings dialog box, select the e-Signature tab.

3. Select or deselect Enable e-Signature.

IMPORTANT! Enabling the electronic signature feature can substantially increase the size of
experiment, template, and study files.

IMPORTANT! If you disable security, you inactivate audit and electronic signature functions. No
audit record is generated for the disabling of audit and electronic signature functions when you
disable security.

4. Click Apply Settings.
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Configure the meanings of the electronic signatures

The e-signature meanings are the text that a user can select to describe a reason for an electronic
signature. The QuantStudio™ Real-Time PCR Software is installed with the following default meanings.

Default data types
E-Signature definition
Plate setup Thermal cycler Analysis protocol | Analysis results
protocol

Reviewed and Approved Plate Set Yes Yes No No
Up

Reviewed and Approved Results No No Yes Yes
Reviewed and Approved Template No No Yes Yes

Use the Security Settings dialog box to add or remove electronic signature meanings and to determine
the data types to which they apply.

To... Action

1. In the e-Signature tab of the Security Settings dialog box, click Add in the e-
Signature Meanings settings.

. 2. In the Create Meaning dialog box, enter a description of the e-Signature meaning,
Add a meaning then click OK.

3. Select what data is signed for the selected meaning.
4. Click Apply Settings.

1. Select the meaning from the e-Signature Meanings list, then click Remove.

Delete a meaning 2. Click Apply Settings.

Configure the e-signature rights for user roles
To determine the user roles that can perform an electronic signature:

1. From the e-Signature tab of the Security Settings dialog box, select the check box next to the
appropriate user roles in the User Role signature rights table.

2. Click Apply Settings.

158 QuantStudio™ 6 and 7 Flex Real-Time PCR Systems (v1.6.1 or later) Maintenance and Administration Guide




Appendix E Security, audit, and electronic signature
Manage electronic signature

Select the actions that require signature

IMPORTANT! Do not change electronic signature settings during calibration.

1. In the Signature Required column, select the check box next to each action for which you want
to require electronic signatures (see Figure 9 on page 159). This selection causes the software to
present an e-sig prompt if a user performs the action on a data file that does not have the required
signatures. The data must be signed before the user can perform the action.

Action The software requires e-signatures when a user.
Print Report Prints a report from an experiment or study.
Start Run Initiates a run from the QuantStudio™ Real-Time PCR Software.

2. For each meaning of each selected action, enter the number of e-signatures from each user role
that are required before the software can execute the associated action. For example, in the
following figure, at least two users from the Administrator user role must sign an experiment using
the “Reviewed and Approved Plate Set Up” meaning before a user can start the associated run.

Signature Required  Action

L g;inttr:(eport Meaning Administrator =~ Technician = Scientist

e

= 4 i Reviewed and Approved Plate Set Up 2 0 0
Reviewed and Approved Results 0 0 0
Reviewed and Approved Template 0 0 0

Figure 9 Actions requiring signatures

3. Click Apply Settings.
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How the software prompts electronic signature

If the system is configured to check for a signature before starting a run or printing a report and the data
are not signed, the QuantStudio™ Real-Time PCR Software displays a message when the user clicks
Start Run or Print Report.

Example

The e-signature system is configured to require signatures from two users from the user account named
Administrator before a user can start a run. The experiment has not been signed.

A user attempts to begin the run. The following message is displayed:

Missing Required Signatures

The requested operation cannot be performed because some required signatures are missing.
. The following e-Signatures must be collected before this operation can be perfarmed:

s

Reviewed and Approved Plate Set Up by 2 Administrator(s)

Before the run can start, two administrators must sign. If a user with an incorrect user role signs, the
message is displayed again.

Generate e-signature reports

160

You can use the QuantStudio™ Real-Time PCR Software to generate reports of e-signature history from
open experiment (EDS) or template (EDT) files.

Task Description

Display the e-sig 1. In the QuantStudio™ Real-Time PCR Software, open an experiment or template
records file.

2. From the open experiment, click € Audit, then click E-Signatures.
3. (Optional) Click any row to view details for individual signatures.

Save or print e-sig | 1. In the QuantStudio™ Real-Time PCR Software, open an experiment or template
records file.

2. From the open experiment, click € Audit then click E-Signatures.
3. In the table, select the record to be saved or printed.
4. Save or print the record:

* Click [Z] (Save), select a location for the export file, enter a name for the file,
then click Save.
or
* Click & (Print).
5. Click OK in the confirmation message.
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Export and import user, security, audit, and e-signature settings

Task

Description

Save or print
the table of e-
signature events

. In the QuantStudio™ Real-Time PCR Software, open an experiment or template

file.

. From the open file, click ¥ Audit then click Print E-Signatures.

3. Save or print the record:

¢ Click [3Z] (Save), select a location for the export file, enter a name for the file,
then click Save.
or
® Click & (Print).
4. Click OK in the confirmation message.

Export and import user, security, audit, and e-signature

settings

Note: The export/import feature can be used to replicate identical security, audit, and e-signature
settings across multiple computers. The feature allows you to create a standard security, audit, and
e-signature settings “image” for the QuantStudio™ Real-Time PCR Software that can then be imported
by other copies of the software to bypass manual setup.

Task Description
Export . In any screen of the Security Settings dialog box, click Export.
. Select the items to export: All or Custom.
Custom contains select settings:

* Users & Roles—All user accounts with Active status and all user roles and associated
permissions (in case a user account specifies a user role that does not exist on the
system into which you import the profiles).

¢ System & Roles—All system settings and all user roles and associated permissions.

. Click Export or OK.

. When prompted, specify the name and location for the exported file (DAT), then click Save. A
message is displayed when the export completes.

Import . In any screen in the Security Settings dialog box, click Import in the Experiment Menu.

. Select the DAT file to import, then click Open. A message is displayed asking if you want to
overwrite the current system configuration. Click Yes.
If any imported user accounts already exist on the system, you are prompted to overwrite or
skip each account.
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User overview

The Security, Audit, and Electronic Signature (SAE) module is a component of the QuantStudio™
Real-Time PCR Software that provides the following functionality:

* System security— Controls user access to the software.

¢ Auditing—Tracks changes made to library items, actions performed by users, and changes to the
Security, Audit, and Electronic Signature settings.

* Electronic signature —Requires users to provide a user name and password when performing
certain functions.

Depending on the way that your administrator configures these features, you may see the following
dialog boxes and prompts when you use the software.

User account permissions

If your user account does not have permission to perform any function in the software, menu
commands are shaded.

Account suspension

If the QuantStudio™ Real-Time PCR Software is configured to suspend a user account for failed logins,
and if you repeatedly enter an incorrect user name and/or password, your user account is suspended,
and the Log In dialog box indicates that your account is inactive.
There are two ways to activate a suspended account:

* You can wait until the suspension period ends.

* An administrator can change the account status from Suspended to Active.

Note: While a user is suspended, another user can click Reset, then log in and replace the suspended
user.

Session time-out

If the QuantStudio™ Real-Time PCR Software is configured to time-out and there is no user activity for
the specified time, the Log In dialog box indicates that your user session has timed out. You must enter
your user name and password to access the software.

The administrator or another user with permission to log in to timed-out sessions can click Reset, then
log in.
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User overview
User security tasks
Task Description
Login Your access to functions in the software is based on the permissions associated with your

user account. Functions for which you do not have permissions are shaded.

Note: If the QuantStudio™ Real-Time PCR Software is configured for password expiration,
you are periodically prompted to change your password.

Note: If the QuantStudio™ Real-Time PCR Software is configured to monitor failed log in
attempts, you will be locked out of the software if you repeatedly enter an incorrect user
name and/or password.

Change your | When your password is about to expire, a message is displayed when you log in.
password

. . To change your password, select Tools » Change Password. Enter your current password,
when it expires

then enter the new password two times, then click OK.

Enter a reason | If the QuantStudio™ Real-Time PCR Software is configured for auditing, you may be
for change prompted to specify a reason when you make certain changes in the software.

Depending on your QuantStudio™ Real-Time PCR Software configuration, you can either
select a reason from the list or enter a reason for change.

Perform an If your system is configured for electronic signature, you may be required to have the
electronic experiment signed by other users before you can print a report or start a run. If an item is
signature set to require multiple signatures, all approvers must sign the associated data before the

action can be completed.

If electronic signature is enabled for experiments, any of the following may apply:
* The Tools » Security » Sign Data menu option is enabled.

* You are prompted to sign.
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Create a background plate or array card . ...ttt e 164

Create a custom dye plate for calibration ........ ... ... . 166

Create a background plate or array card

Whenever possible, use a Background Plate or the TagMan™ Array Background Buffer that is included
with the spectral calibration kit. The plates/array cards supplied in the kit contain a buffer that
accurately simulates the reagents used for PCR, and, therefore, produces high-quality calibration data.
If a background plate or array card from a spectral calibration kit is not available, you can create one as
described below.

Required materials

96/384-Well plate sample block

* MicroAmp™ Optical 96/384-Well Reaction Plate
* Safety glasses

® Optical Adhesive Cover or Optical Flat Caps

® Pipettor, 200-pL (with pipette tips)

* Powder-free gloves

* Deionized water

TagMan™ Array Card block (QuantStudio™ 7 Flex System only)

* TagMan™ Array Cards

* TagMan™ Array Card Sealer

* Centrifuge with array card buckets and array card carrier clips
* Permanent marker or pen

* Pipettor, 200-pL (with pipette tips)

* Powder-free gloves

* Safety glasses

* Deionized water
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Create a background plate

IMPORTANT! Wear powder-free gloves while creating the background plate.

1.

Remove a MicroAmp™ 96/384-Well Optical Reaction Plate from its box and place it on a clean, dry
surface.

Aliquot deionized water to each well of the reaction plate.

* 96-well, 0.2-mL: 50 pL
* 96-well, 0.1-mL: 30 pL
e 384-well: 20 pL

Seal the plate using an optical adhesive cover or optical flat caps.

Use the plate for background calibration as you would a background plate from the spectral
calibration kit.

Create a background array card (QuantStudio™ 7 Flex System only)

1.

2.
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b. Load 100 pL of the solution into a pipette.
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c. Hold the pipette in an angled position (~45°) and place the tip into the fill port.
There is a fill port on the left arm of each fill reservoir — the larger of the two holes.

(@ Fill port

(@ Vent port

d. Dispense the fluid so that it sweeps in and around
the fill reservoir toward the vent port.

When pipetting the reagents into the array card,
pipet the entire 100-uL volume into the fill reservoir,
but do not go past the first stop of pipettor plunger
or you may blow the solution out of the port.

IMPORTANT! Do not allow the tip to contact and
possibly damage the coated foil beneath the fill port.

4. Centrifuge and seal the array card as explained in “Fill the calibration TagMan™ Array Cards” on
page 38.

Create a custom dye plate for calibration

The QuantStudio™ 6 or 7 Flex System can be used to run assays designed with custom dyes (dyes not
manufactured by Thermo Fisher Scientific). Custom dyes must excite between 455 and 672 nm and
read between 505 and 723 nm.

Before you use custom dyes

Before using custom dyes with the QuantStudio™ 6 or 7 Flex System, you must:
* Determine optimum dye concentration.
* Create a custom dye plate.
* Add the custom dye to the software.
* Perform a dye calibration.
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Required materials

* (Centrifuge with plate adapter

® Custom dye(s)

* Safety glasses

* Powder-free gloves

* MicroAmp™ Optical 96/384-Well Reaction Plate
* Optical Adhesive Cover

* Pipettors and pipette tips (200-pL and 1000-pL)
¢ Tubes (2-mL and 10-mL)

* Deionized water

Determine optimum dye concentration

Note: Wear powder-free gloves while creating the dye plate.

1. Prepare and load the custom dye plate:

a. In the center of a 96- or 384-well plate, prepare a dilution series of the custom dye (for
example, 25, 50, 100, 200, 400, 800, 1600, and 3200 nM).

Use the following volumes:
* 96-well, 0.2-mL: 50 pL
* 96-well, 0.1-mL: 30 pL
e 384-well: 20 L

b. Seal the reaction plate using an optical adhesive cover.
c. Load the prepared reaction plate.

2. Start the calibration wizard:

a. In the Home screen of the QuantStudio™ Real-Time PCR Software, click Instrument
Console.

b. In the Instrument Console, select your system, then click Add to My Instruments.
c. Select the system, then click Manage Instrument.

d. In the Instrument Manager, click Maintenance, then click ROL.

e. In the ROI Calibration screen, click Start Calibration.

f. In the ROI dialog box, click Next until prompted to load the system. When the side door
opens, load the sealed plate. Ensure that the plate or the array card is properly aligned in the
holder.

g. In the ROI dialog box, select Check the box when the ROI calibration plate has been
loaded, click Next twice, then click START RUN to start the calibration.
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3. When the run is complete, inspect the ROl images:
a. Select the first filter from the Filter drop-down list.

b. Record the coordinate of the well that contains the lowest concentration of dye and that is
encircled by a ring. This well contains the optimal concentration of the custom dye at the
given filter.

c. Repeat steps a and b for the remaining filters.

d. After you determine the optimum concentration for each filter, determine the optimum
concentration for the custom dye. Compare the results from all filters, then select the
concentration that yields the highest possible signal in all filters.

4. Discard the plate.

AN WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the plate can reach
&= 100°C. Allow the plate to reach room temperature before removing.

5. In the ROI dialog box, click Finish to complete the calibration, then click No when prompted to
save the results.

Create a custom dye plate

IMPORTANT! Wear powder-free gloves while creating the dye plate.

1. Prepare the custom dye at the concentration determined in “Determine optimum dye
concentration” on page 167.

e 96-well, 0.2-mL: 5 mL
* 96-well, 0.1-mL: 3 mL
e 384-well: 8 mL

2. Pipet the diluted custom dye to all wells of an optical reaction plate.

* 96-well, 0.2-mL: 50 pL
* 96-well, 0.1-mL: 30 pL
e 384-well: 20 pL

3. Seal the wells of the reaction plate using an optical adhesive cover.

4. Centrifuge the plate for 2 minutes at <1500 rpm.

Note: The custom dye calibration plate must be well mixed and centrifuged.
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5. Verify that the liquid in each well of the plate is at the bottom of the well. If not, centrifuge the plate
again at a higher rpom and for a longer period of time.

Add the custom dye to the software

1. Start the dye calibration:

a.

d.

e.

In the Home screen of the QuantStudio™ Real-Time PCR Software, click Instrument
Console.

In the Instrument Console, select your system from the list of instruments on the network,

then click Add to My Instruments.

. Select the system, then click Manage Instrument.

In the Instrument Manager, click Maintenance, then click Dye.

In the Background Calibration screen, click Start Calibration.

2. In the Dye window, select a custom dye from the list or create the custom dye:

a.

b.

Click New Dye.

In the Dye Library dialog box, click New.
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c. Complete the New Dye dialog box, then click OK.

Field/option Action

Name Enter a name for the custom dye.

Wavelength | Enter the wavelength at which the dye fluoresces.

Select:

* Reporter if the dye works in conjunction with a quencher dye to report an
increase of PCR product.

Type * Quencher if the dye suppresses the fluorescence of a reporter dye until

amplification of PCR product.

¢ Both if the dye reports an increase of PCR product without the aid of a
quencher dye.

d. Click Close.

3. In the Dye window, enter a temperature setting for the calibration. Set the temperature to match
the temperature at which you intend to collect data. For example, the temperature for all system
dyes is 60°C because data collection for TagMan™ reagents occurs during the 60°C extension step
of the PCR.

4. Load the appropriate dye plate into the plate adapter, select Please check the box when the
dye calibration plate has been loaded, click Next twice, then click START RUN to start the
calibration.

5. When the run is complete and the system ejects the plate, remove and discard the plate or the

array card.

AN WARNING! PHYSICAL INJURY HAZARD. During instrument operation, the plate can reach
&= 100°C. Allow the plate to reach room temperature before removing.

6. In the Dye dialog box of the QuantStudio™ Real-Time PCR Software, click Next.

7. Verify the grouping of the dye spectra:
a. In the plate layout, select the wells of the plate.

b. Inspect the raw data. For each spectrum, verify that the peak is:
* Within the detectable range for the system.
* Free of irregular spectral peaks.
* Present at the correct filter for the dye.

Note: Among wells containing the same dye, variations in spectral position and peak position are
caused by minor differences in the optical properties and excitation energy between the individual
wells.

170 QuantStudio™ 6 and 7 Flex Real-Time PCR Systems (v1.6.1 or later) Maintenance and Administration Guide



Appendix F Calibration consumable preparation
Create a custom dye plate for calibration

8. Verify the status of the calibration. If the calibration:
Passed—If all spectra are acceptable, finish the calibration:
a. Click Next.

b. Enter any comments you have in the Comments field, click Finish, then click Yes when
prompted to save the calibration results.

Failed —Create another custom dye plate using the next dye concentration greater than the

concentration determined in “Determine optimum dye concentration” on page 167, then perform
the calibration again.
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How to order

You can order materials and accessories directly from thermofisher.com.

Note: Product availability and pricing can vary by region or country. Online ordering is not available in
all countries. For assistance, contact your local Thermo Fisher Scientific representative.

To order through the website or the QuantStudio™ Real-Time PCR Software:
* Confirm that your computer has an active internet connection.

* For optimal performance when accessing thermofisher.com, we recommend the current or most
recent versions of the following browsers:

- Google Chrome™

— Microsoft Edge™

— Safari™ (macOS™ operating systems only)
— Firefox™

Confirm that cookies and JavaScript™ support are enabled in your browser.

Note: PDF documents that are available on the website require a compatible PDF viewer (for
example, Acrobat Reader™ software).

How to order from the system software

1. To find your assay, complete the Find Assay pane in the QuantStudio™ Real-Time PCR Software:
a. Enter a gene name in the Enter Gene Name field, then click Find Assay.

b. In the Find Assay Results dialog box, select your assay.

c. Click Apply Assay Selection. The selected assay is added to your shopping list.
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2. Check that the Experiment Shopping List contains the desired materials, other than the assay

selected in the previous step, and that the quantities are correct, then click Order Materials in
List.

3. In the Order Materials - Login dialog box, enter your user name and password for the store, then
click Log In and Submit.

Order Materials - Log In x|

Log into the Applied Biosystems Store to place the selected iterns in your shopping basket. If you do
not have a user name and password, click "Register Now" to create a new account,

OR [ oo
Store Log In Register
To log into the Applied Biosystems Store, enter your user name If you do not A
and password then click"Log In and Submit'. have an Applied
Biosystems
User Name: I account, click

the link helow to
create a new
account,

Password: |

Log In and Submit -

Reqgister MNow

I~ Remember my user name and password for future orders

Note: If you do not have an account with thermofisher.com, click Register Now to create an
account.

When you are connected to thermofisher.com, follow the prompts to complete your order.

Kits, consumables, and accessories

The following kits, consumables, and reagents are to be used with the QuantStudio™ 6 and 7 Flex
Systems.

* 96-well 0.2-mL consumables (see page 174)

* 96-well 0.1-mL consumables (see page 174)

* 384-well consumables (see “384-well consumables” on page 175)
¢ TagMan™ Array Card consumables (see page 176)

* QuantStudio™ 6 and 7 Flex System accessories (see “QuantStudio™ 6 and 7 Flex Systems
accessories” on page 176)
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Note: For reagent or consumable shelf-life expiration date, see the package label.

Note: The QuantStudio™ 6 Flex System does not support the TagMan™ Array Card block.

96-well 0.2-mL consumables

Note: Spectral calibration plates for the QuantStudio™ 3 and 5 Instruments are used for the calibration
procedure with QuantStudio™ Real-Time PCR Software v1.6.1 or later.

Shelf life at storage

Consumable Cat. No. Storage
temperature
QuantStudio™ 3/5 10-Dye Spectral Calibration Kit, 96-Well
0.2-mL A26343
(Contains all 3 spectral calibration plates listed below)
QuantStudio™ 3/5 Spectral Calibration Plate 1, 96-Well A26331
0.2-mL (FAM™, VIC™, ROX™, SYBR™ dyes)
QuantStudio™ 3/5 Spectral Calibration Plate 2, 96-Well Use the consumable by
A26332 -25°C to o

0.2-mL (ABY™, JUN™, MUSTANG PURPLE™ dyes) 15°C the expiration date on the

] ) ] - packaging.
QuantStudio™ 3/5 Spectral Calibration Plate 3, 96-Well A26333
0.2-mL (TAMRA™, NED™, Cy®5 dyes)
Region of Interest (ROI) and Background Plates, 96-Well 4439364
0.2-mL (2 plates)
TagMan™ RNase P Instrument Verification Plate, 96-Well 4439382

0.2-mL

96-well 0.1-mL consumables

Note: Spectral calibration plates for the QuantStudio™ 3 and 5 Instruments are used for the calibration
procedure with QuantStudio™ Real-Time PCR Software v1.6.1 or later.

Consumable

Cat. No.

Storage

Shelf life at storage

temperature

QuantStudio™ 3/5 10-Dye Spectral Calibration Kit, 96-well,
0.1-mL A26342
(Contains all 3 spectral calibration plates listed below)
QuantStudio™ 3/5 Spectral Calibration Plate 1, A26336 | _25°C to Use thg cgnsumable by
(FAM™, VIC™, ROX™, and SYBR™ dyes), 96-well, 0.1 mL 159G the expiration date on the

) — - packaging
QuantStudio™ 3/5 Spectral Calibration Plate 2 (ABY™, A26337
JUN™, MUSTANG PURPLE™ dyes), 96-well (0.1-mL) plate
QuantStudio™ 3/5 Spectral Calibration Plate 3 (TAMRA™, A26340

NED™ and Cy®5 dyes) 96-well (0.1-mL) plate
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Consumable

Cat. No. Storage

Shelf life at storage

Region of Interest (ROI) and Background Plates, Fast
96-Well 0.1-mL (2 plates)

TagMan™ RNase P Instrument Verification Plate, Fast 96-

Well

temperature
4432426 o Use the consumable by
-25°C to .
_15°C the expiration date on the
4351979 packaging

384-well consumables

Note: Spectral calibration plates for the QuantStudio™ 3 and 5 Instruments are used for the calibration
procedure with the QuantStudio™ Real-Time PCR Software v1.6.1 or later.

Consumable Cat. No. Storage Shelf life at storage temperature
QuantStudio™ 5 10-Dye Spectral Calibration Kit, 384-
well

A26341

(Contains the 2 spectral calibration plates listed
below)
QuantStudio™ 5 Spectral Calibration Plate 1,
(FAM™, VIC™, ROX™ TAMRA™, and SYBR™ dyes), A26334
384-well -25°C to Use the consumable by the
QuantStudio™ 5 Spectral Calibration Plate 2 (ABY™, -15°C expiration date on the packaging.
JUN™, MUSTANG PURPLE™, NED™, and Cy®5 dyes), | A26335
384-well
Region of Interest (ROI) and Background Plates, 384- 4439320
well
TagMan™ RNase P Instrument Verification Plate, 384- 4455280

well
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TagMan™ Array Card consumables

Shelf life at storage

Consumable Cat. No. | Storage
temperature

Array Card Calibration Install Kit 4432250

(Includes the ViiA™ 7 Array Card Spectral Calibration Kit and the
ViiA™ 7 Array Card RNaseP Verification Kit)

ViiA™ 7 Array Card Spectral Calibration Kit, includes the following
components:

¢ Empty TagMan™ Array Cards
e FAM™ dye

e VIC™dye

e ROX™dye

¢ ROI dye mix

4432314

¢ Background buffer
e FAM™/ROX™ dye _95°C 1o Use the .cor?sumable by
the expiration date on

* VIC™/ROX™ dye -15°C the packaging.

ViiA™ 7 Array Card RNaseP Verification Kit, includes the following
components:
* TagMan™ Array Card

* Eight (8) vials of RNase P detection reagents, one for each
port in the TagMan™ Array Card. Each vial contains the
following reagents: 4432265

- PCR master mix

— RNase P primers
- A FAM™ dye-labeled probe

— A known concentration of human genomic DNA
template

Note: The Array Card block consumables are applicable only to the QuantStudio™ 7 Flex System.

QuantStudio™ 6 and 7 Flex Systems accessories

Accessory Cat. No.
384-Well Plate/Array Card Heated Cover 4454163
384-Well Plate Sample Block 4454165
96-Well Plate Heated Cover 4459841
96-Well Plate Sample Block 4459839
Array Card Bucket/Clip Set 4452205
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(continued)
Accessory Cat. No.
Array Card Sample Block 4454164
Fast 96-Well Plate Heated Cover 4459842
Fast 96-Well Plate Sample Block 4459840
Halogen lamp (12 V, 75 W) 4480914
Handheld Barcode Scanner 4453271
TagMan™ Array Card Sealer 4331770
QuantStudio™ 6 and 7 Flex Systems empty plates and array cards
Consumable Cat. No.
96-Well Fast Plate (empty), 10-pack 4346907
96-Well Fast Plate with Barcode (empty), 10-pack 4346906
96-Well Plate (empty), 10-pack N8010560
96-Well Plate with Barcode (empty), 10-pack 4306737
Adhesive Seal Applicator Kit, 5-pack 4481196
Array Card Kit (empty), 1-packl'] 4445702
Array Card Kit (empty), 4-packl'] 4445701
Optical Adhesive Covers, 25-pack 4481193

[l QuantStudio™ 7 Flex System only.

General-use materials and consumables

The following general-use materials and consumables are required to calibrate, maintain, and operate
the QuantStudio™ 6 and 7 Flex Systems. "MLS" indicates that the material is available from

fisherscientific.com or another major laboratory supplier.

Material/consumable Source
Bleach, 10% solution MLS
Centrifuge with 96-well plate buckets MLS
Cotton or nylon swabs and lint-free cloths MLS
Ethanol, 95% solution MLS
Optical clear adhesive film for PCR MLS
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(continued)
Material/consumable Source
Pipettors, 100-pL and 200-pL (with pipette tips) MLS
Powder-free gloves MLS
Safety glasses MLS
Screwdriver, flathead MLS
Tissue, lint-free MLS
Deionized water MLS
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QuantStudio™ 6 and 7 Flex Systems specifications

For more information, see the QuantStudio™ 6 and 7 Flex Real-Time PCR Systems Site Preparation
Guide (Pub. No. 4489824,

Component

Height

Depth

Width

Weight

Instrument!']

75.0cm (29.5in.)

70.0cm (27.6in.)

53.0cm (20.9 in.)

70 kg (154.3 Ibs)

Computer 56.5cm (22.3 in.) 54.7 cm (22.4 in.) 21.6cm (8.5in.) 10 kg (22.0 Ibs)
Monitor 38.0cm (15.01in.) 13.7cm (5.4 in.) 37.4cm (14.7 in.) 3.0 kg (6.7 lbs)
Keyboard 2.75cm (1.1in.) 445cm (17.8in.) 13.75¢cm (5.51in.) 0.75 kg (1.65 Ibs)

[ Weight varies depending on the sample block installed.
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Required clearances

During instrument setup and maintenance, it is necessary to access the back and sides of the
instrument. If the back of the instrument faces a wall, it will be necessary to have enough space to

rotate the instrument on the bench for access.

IMPORTANT! For safety, the power outlet used for powering the instrument must be accessible at all

times.
Component Top Front Sides Back
30.5cm 122 cm 51.0cm 15.2cm
Instrument

(12.0in.) (48.01in.) (20.01in.) (6.0in.)
30.5cm 15.2cm

Computer — —
(12.0in.) (6.0in.)

Electrical requirements

WARNING! For safety, the power outlet used for powering the instrument must be accessible at all
times. See “Required clearances” on page 181 for information about the space needed between the
wall and the instrument. In case of emergency, you must be able to immediately disconnect the main
power supply to all the equipment. Allow adequate space between the wall and the equipment so
that the power cords can be disconnected in case of emergency.

Note: Place the instrument and computer power receptacle on an electrical circuit that is not shared
with electrically noisy devices or devices that can cause power surges, such as refrigeration units.

The following table provides electrical specifications for the instrument and associated devices. For all
indicated input voltages, a 15 A circuit is required.

Device Rated current Rated power Rated voltage Rated frequency
Instrument 125A 950 VA
100-240
Computer 21A 125 VA 50/60 Hz
+10% VAC
Monitor 1.5A 65 VA

Note: The instrument, monitor, and computer self-adjust for 100-240 V input voltages of 50/60 Hz.
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Environmental requirements

Condition

Description

Altitude

Located between sea level and 6000 ft (~1800 m) above sea level

Electromagnetic
interference

Do not use this device in close proximity to sources of strong electromagnetic radiation
(for example, unshielded intentional RF sources). Strong electromagnetic radiation may
interfere with the proper operation of the device.

Humidity

15-80% (noncondensing)

Installation site

For indoor use only

The instrument has a Pollution Degree rating of Il. The instrument may only be installed
in an environment that has nonconductive pollutants such as dust particles or wood

Pollution chips. Typical environments with a Pollution Degree Il rating are laboratories and sales and
commercial areas.
The noise output of the instrument is <60 dB at idle.

Temperature 15-30°C (60-85°F)

Thermal output

During operation the net thermal output, based on the actual current draw of the
instrument and computer, is expected to be approximately 2731 BTU/hour [800 W].

Vibration

Ensure that the instrument is not adjacent to strong vibration sources, such as a
centrifuge, pump, or compressor. Excessive vibration will affect instrument performance.

Other conditions

Ensure the room is away from any vents that could expel particulate material on the
instrument components.

Avoid placing the instrument and computer adjacent to heaters, cooling ducts, or in direct
sunlight.

Network requirements

The computer is factory-configured for the TCP/IP protocol. The product includes a fast Ethernet
adapter (10/100 Mbps) with an RJ45-type connector and one 3-m (9.8-ft) crossover Ethernet cable that
connects the computer and the instrument.

If the instrument will be connected to a LAN, an active, tested LAN connection must be in place before
the scheduled installation date. Due to differences in network connections, the service representative
cannot configure the instrument to access a specific network.

You must supply a standard Category 5 Ethernet cable of the required length to connect the computer

to your LAN.
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QuantStudio™ 6 and 7 Flex Systems layout and connections

The QuantStudio™ 6 and 7 Flex Systems consist of the components in the following figure.

®

Component Description

QuantStudio™ 6 or 7
Flex Real-Time PCR
System

Performs fluorescence detection and data collection of experiment
and calibration plates or array cards.

Computer

Run the QuantStudio™ Real-Time PCR Software that is used to:

=
o
@ Monitor * Calibrate the systems.

* Set up experiments.

Keyboard . .
® (Optional) Run experiments.

* Analyze experiments.
Mouse

PR Barcode scanner Scans the barcodes of plates and array cards.

Connection Description

Supply power to the computer and the QuantStudio™ 6 and 7 Flex

A | Power cables Systems.m

Connects the QuantStudio™ 6 and 7 Flex Systems (Ethernet port) to

LAN connection or the Ethernet port on the network interface card in the computer. The
Ethernet cablel? components can be connected over a local area network or a via a direct
physical connection.
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(continued)
Connection Description
C | DVI cable Connects the monitor to the computer (DVI port).

D | Barcode scanner cable Connects the optional barcode scanner to the computer (USB port).

E | Keyboard cable Connects the keyboard to the computer (USB port).

F | Mouse cable Connects the mouse to the computer (USB port).

' Supplies 115/230 V depending on the geographic location of the installation.
[l Supplied with the QuantStudio™ 6 and 7 Flex Systems.
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WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, visit thermofisher.com/support.

Symbols on this instrument

Symbols may be found on the instrument to warn against potential hazards or convey important safety
information. In this document, the hazard symbol is used along with one of the following user attention
words.

* CAUTION!—Indicates a potentially hazardous situation that, if not avoided, may result in minor or
moderate injury. It may also be used to alert against unsafe practices.

* WARNING!—Indicates a potentially hazardous situation that, if not avoided, could result in death or
serious injury.

* DANGER!—Indicates an imminently hazardous situation that, if not avoided, will result in death or
serious injury.
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Symbols on this instrument

Standard safety symbols

Symbol and description

CAUTION! Risk of danger. Consult the manual for further safety information.

CAUTION! Risk of electrical shock.

CAUTION! Hot surface.

BB B P

CAUTION! Potential biohazard.

>

CAUTION! Ultraviolet light.

Symbole et description

MISE EN GARDE ! Risque de danger. Consulter le manuel pour d’autres renseignements de sécurité.

MISE EN GARDE ! Risque de choc électrique.

MISE EN GARDE ! Surface chaude.

> B B> P

MISE EN GARDE ! Danger biologique potentiel.

>

MISE EN GARDE ! Rayonnement ultraviolet.
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Additional safety symbols

Symbol and description

>

CAUTION! Laser radiation

B>

CAUTION! Moving parts.

B

CAUTION! Potential slipping hazard.

Symbole et description

>

MISE EN GARDE ! Laser radiation

B>

MISE EN GARDE ! Parties mobiles.

B

MISE EN GARDE ! Danger de glisser potentiel.
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Location of safety labels

Label and location

g}

LRI
PANNNNNNNNNNN
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Appendix | Safety
Symbols on this instrument

Symbols and descriptions

On (Power)

Off (Power)

Earth (ground) terminal

Protective conductor terminal (main ground)

! ®+ O —

Alternating current

{

Both direct and alternating current

Conformity symbols

Conformity mark

Description

Indicates conformity with safety requirements for Canada and U.S.A.

3

Indicates conformity with European Union requirements for safety and electromagnetic

compatibility.

Voo

Indicates conformity with Australian standards for electromagnetic compatibility.

=,

X[

INDICATES CONFORMITY WITH THE WEEE DIRECTIVE 2012/19/EU.

A CAUTION! To minimize negative environmental impact from disposal of
electronic waste, do not dispose of electronic waste in unsorted municipal

waste. Follow local municipal waste ordinances for proper disposal provision

and contact customer service for information about responsible disposal

options.

Indicates conformity with China RoHS, Environmental Friendly Use Period 25 Years.
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Safety information for instruments not manufactured by
Thermo Fisher Scientific

Some of the accessories provided as part of the instrument system are not designed or built by Thermo
Fisher Scientific. Consult the manufacturer's documentation for the information needed for the safe use
of these products.

Instrument safety
General

/t\. CAUTION! Do not remove instrument protective covers. If you remove the protective instrument
&/~ panels, you may be exposed to serious hazards including, but not limited to, severe electrical shock.

Physical injury

CAUTION! Moving and Lifting Injury. The instrument is to be moved and positioned only by the
personnel or vendor specified in the applicable site preparation guide. Improper lifting can cause
painful and permanent back injury.

Things to consider before lifting or moving the instrument or accessories:
. Depending on the weight, moving or lifting may require two or more persons.

. If you decide to lift or move the instrument after it has been installed, do not attempt to do so
without the assistance of others, the use of appropriate moving equipment, and proper lifting
techniques.

. Ensure you have a secure, comfortable grip on the instrument or accessory.

. Make sure that the path from where the object is to where it is being moved is clear of
obstructions.

. Do not lift an object and twist your torso at the same time. Keep your spine in a good neutral
position while lifting with your legs.

. Participants should coordinate lift and move intentions with each other before lifting and carrying.

. For smaller packages, rather than lifting the object from the packing box, carefully tilt the box on its
side and hold it stationary while someone else slides the contents out of the box.

CAUTION! Moving Parts. Moving parts can crush, pinch and cut. Keep hands clear of moving parts
while operating the instrument. Disconnect power before servicing.
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Electrical safety

WARNING! Fuse Installation. Before installing the instrument, verify that the fuses are properly
installed and the fuse voltage matches the supply voltage. Replace fuses only with the type and
rating specified for the unit. Improper fuses can damage the instrument wiring system and cause a
fire.

WARNING! Ensure appropriate electrical supply. For safe operation of the instrument:

. Plug the system into a properly grounded receptacle with adequate current capacity.
. Ensure the electrical supply is of suitable voltage.

. Never operate the instrument with the ground disconnected. Grounding continuity is required for
safe operation of the instrument.

AVERTISSEMENT ! Veiller a utiliser une alimentation électrique appropriée. Pour garantir le
fonctionnement de I'instrument en toute sécurité :

. Brancher le systeme sur une prise électrique correctement mise a la terre et de puissance adéqua-
te.

. S’assurer que la tension électrique est convenable.

. Ne jamais utiliser I'instrument alors que le dispositif de mise a la terre est déconnecté. La continui-
té de la mise a la terre est impérative pour le fonctionnement de I'instrument en toute sécurité.

WARNING! Power Supply Line Cords. Use properly configured and approved line cords for the
power supply in your facility.

AVERTISSEMENT ! Cordons d’alimentation électrique. Utiliser des cordons d’alimentation adap-
tés et approuvés pour raccorder I'instrument au circuit électrique du site.

WARNING! Disconnecting Power. To fully disconnect power either detach or unplug the power
cord, positioning the instrument such that the power cord is accessible.

AVERTISSEMENT ! Déconnecter I’'alimentation. Pour déconnecter entierement I'alimentation, dé-
tacher ou débrancher le cordon d’alimentation. Placer I'instrument de maniére a ce que le cordon
d’alimentation soit accessible.
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Cleaning and decontamination

CAUTION! Cleaning and Decontamination. Use only the cleaning and decontamination methods
that are specified in the manufacturer user documentation. It is the responsibility of the operator (or
other responsible person) to ensure that the following requirements are met:

[

. No decontamination or cleaning agents are used that can react with parts of the equipment or with
material that is contained in the equipment. Use of such agents could cause a HAZARD condition.

. The instrument is properly decontaminated a) if hazardous material is spilled onto or into the
equipment, and/or b) before the instrument is serviced at your facility or is sent for repair,
maintenance, trade-in, disposal, or termination of a loan. Request decontamination forms from
customer service.

. Before using any cleaning or decontamination methods (except methods that are recommended by
the manufacturer), confirm with the manufacturer that the proposed method will not damage the
equipment.

MISE EN GARDE ! Nettoyage et décontamination. Utiliser uniquement les méthodes de nettoya-
ge et de décontamination indiquées dans la documentation du fabricant destinée aux utilisateurs.
L'opérateur (ou toute autre personne responsable) est tenu d’assurer le respect des exigences sui-
vantes:

. Ne pas utiliser d’agents de nettoyage ou de décontamination susceptibles de réagir avec certaines
parties de I'appareil ou avec les matieres qu’il contient et de constituer, de ce fait, un DANGER.

. L’instrument doit étre correctement décontaminé a) si des substances dangereuses sont renver-
sées sur ou a l'intérieur de I’équipement, et/ou b) avant de le faire réviser sur site ou de I’envoyer
a des fins de réparation, de maintenance, de revente, d’élimination ou a I'expiration d’une période
de prét (des informations sur les formes de décontamination peuvent étre demandées auprés du
Service clientele).

. Avant d’utiliser une méthode de nettoyage ou de décontamination (autre que celles recomman-
dées par le fabricant), les utilisateurs doivent vérifier aupres de celui-ci qu’elle ne risque pas
d’endommager I'appareil.

Instrument component and accessory disposal

To minimize negative environmental impact from disposal of electronic waste, do not dispose of
electronic waste in unsorted municipal waste. Follow local municipal waste ordinances for proper
disposal provision and contact customer service for information about responsible disposal options.

Laser safety—barcode scanner

The optional barcode scanners included with the QuantStudio™ 6 and 7 Flex Systems are categorized
as Class 2 (ll) lasers.

Class 2 (ll) lasers are low-power, visible-light lasers that can damage the eyes. Never look directly into
the laser beam. The scanner is designed to prevent human access to harmful levels of laser light during
normal operation, user maintenance, or during prescribed service operations.
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The following table lists laser safety symbols and alerts that may be present on the instrument.

Alert

& CAUTION! LASER HAZARD, Bar Code Scanner. The bar code scanner included with the
instrument system is a Class 2 laser. To avoid damage to eyes, do not stare directly into the beam
or point into another person's eyes.

Alerte

& MISE EN GARDE ! RISQUE LIE AU RAYONNEMENT LASER, Lecteur de code-barres. Le lecteur
de code-barres inclut dans I'instrument est un appareil laser de classe 2. Pour éviter toute lésion
oculaire, ne regardez pas directement le faisceau et ne le dirigez pas vers les yeux d'une autre
personne.

Workstation safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such as fatigue,
pain, and strain. Minimize or eliminate these effects by configuring your workstation to promote neutral
or relaxed working positions.

CAUTION! MUSCULOSKELETAL AND REPETITIVE MOTION HAZARD. These hazards are caused
by potential risk factors that include but are not limited to repetitive motion, awkward posture, forceful
exertion, holding static unhealthy positions, contact pressure, and other workstation environmental
factors.

To minimize musculoskeletal and repetitive motion risks:

* Use equipment that comfortably supports you in neutral working positions and allows adequate
accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head postures.

Safety and electromagnetic compatibility (EMC) standards

The instrument design and manufacture complies with the following standards and requirements for
safety and electromagnetic compatibility.
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Safety and electromagnetic compatibility (EMC) standards

Safety standards

Reference

Description

EU Directive 2014/35/EU

European Union “Low Voltage Directive”

IEC 61010-1
EN 61010-1
UL 61010-1

CAN/CSA C22.2 No. 61010-1

Safety requirements for electrical equipment for measurement, control, and
laboratory use — Part 1: General requirements

IEC 61010-2-010
EN 61010-2-010

Safety requirements for electrical equipment for measurement, control and
laboratory use — Part 2-010: Particular requirements for laboratory equipment for
the heating of materials

IEC 61010-2-081
EN 61010-2-081

Safety requirements for electrical equipment for measurement, control and
laboratory use — Part 2-081: Particular requirements for automatic and semi-
automatic laboratory equipment for analysis and other purposes

EMC standards

Reference

Description

EU Directive 2014/30/EU

European Union “EMC Directive”

EN 61326-1
IEC 61326-1

Electrical Equipment for Measurement, Control and Laboratory Use — EMC Requirements
— Part 1: General Requirements

FCC Part 18 (47 CFR)

U.S. Standard “Industrial, Scientific, and Medical Equipment”

AS/NZS CISPR 11

Limits and Methods of Measurement of Electromagnetic Disturbance Characteristics of
Industrial, Scientific, and Medical (ISM) Radiofrequency Equipment

ICES-001, Issue 5

Industrial, Scientific and Medical (ISM) Radio Frequency Generators

Environmental design standards

Reference

Description

Directive 2012/19/EU

European Union “WEEE Directive” —Waste electrical and electronic equipment

Directive 2011/65/EU &
Commission Delegated
Directive (EU) 2015/863

European Union “RoHS Directive” —Restriction of hazardous substances in electrical
and electronic equipment

SJ/T 11364-2014

“China RoHS” Standard —Marking for the Restricted Use of Hazardous Substances in
Electronic and Electrical Products

For instrument specific certificates, visit our customer resource page at
www.thermofisher.com/us/en/home/technical-resources/rohs-certificates.html.
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Chemical safety

/W\. WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
&~ read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with

sufficient ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer

cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

AVERTISSEMENT ! PRECAUTIONS GENERALES EN CAS DE MANIPULATION DE PRODUITS
CHIMIQUES. Pour minimiser les risques, veiller a ce que le personnel du laboratoire lise attentive-
ment et mette en ceuvre les consignes de sécurité générales relatives a I'utilisation et au stockage
des produits chimiques et a la gestion des déchets qui en découlent, décrites ci-dessous. Consulter
également la FDS appropriée pour connaitre les précautions et instructions particulieres a respecter :

. Lire et comprendre les fiches de données de sécurité (FDS) fournies par le fabricant avant de
stocker, de manipuler ou d’utiliser les matériaux dangereux ou les produits chimiques. Pour obtenir
les FDS, se reporter a la section « Documentation et support » du présent document.

. Limiter les contacts avec les produits chimiques. Porter des équipements de protection appropriés
lors de la manipulation des produits chimiques (par exemple : lunettes de slreté, gants ou véte-
ments de protection).

. Limiter I'inhalation des produits chimiques. Ne pas laisser les récipients de produits chimiques
ouverts. lls ne doivent étre utilisés qu’avec une ventilation adéquate (par exemple, sorbonne).

. Vérifier régulierement I’absence de fuite ou d’écoulement des produits chimiques. En cas de fuite
ou d’écoulement d’un produit, respecter les directives de nettoyage du fabricant recommandées
dans la FDS.

. Manipuler les déchets chimiques dans une sorbonne.
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. Veiller a utiliser des récipients a déchets primaire et secondaire. (Le récipient primaire contient les
déchets immédiats, le récipient secondaire contient les fuites et les écoulements du récipient pri-
maire. Les deux récipients doivent étre compatibles avec les matériaux mis au rebut et conformes
aux exigences locales, nationales et communautaires en matiére de confinement des récipients.)

. Une fois le récipient a déchets vidé, il doit étre refermé hermétiquement avec le couvercle fourni.

. Caractériser (par une analyse si nécessaire) les déchets générés par les applications, les réactifs et
les substrats particuliers utilisés dans le laboratoire.

. Vérifier que les déchets sont convenablement stockés, transférés, transportés et éliminés en res-
pectant toutes les réglementations locales, nationales et/ou communautaires en vigueur.

. IMPORTANT ! Les matériaux représentant un danger biologique ou radioactif exigent parfois une
manipulation spéciale, et des limitations peuvent s’appliquer a leur élimination.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the instrument is
potentially hazardous. Follow the guidelines noted in the preceding General Chemical Handling
warning.

WARNING! 4L Reagent and Waste Bottle Safety. Four-liter reagent and waste bottles can crack
and leak. Each 4-liter bottle should be secured in a low-density polyethylene safety container with the
cover fastened and the handles locked in the upright position.

Biological hazard safety

196

WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
cdc.gov/labs/bmbl

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
who.int/publications/i/item/9789240011311
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Documentation and support

Related documentation

Document

Pub. No.

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems Site Preparation Guide

4489824

QuantStudio™ Real-Time PCR Software Getting Started Guide

4489822

High Resolution Melt Module for QuantStudio™ 6 and 7 Flex Real-Time PCR System Software
Getting Started Guide

4489823

QuantStudio™ Real-Time PCR Software v1.6.1 or later

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems (v1.6.1 or later) Quick Reference

MANO0018829

QuantStudio™ Real-Time PCR Software v1.3

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems (v1.3) Maintenance and Administration Guide

4489821

QuantStudio™ 6 and 7 Flex Real-Time PCR Systems Quick Reference

4489826

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
* Worldwide contact telephone numbers

* Product support information
— Product FAQs

- Software, patches, and updates
— Training for many applications and instruments
¢ Order and web support

* Product documentation
— User guides, manuals, and protocols

— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the

manufacturer.
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Appendix J Documentation and support
Limited product warranty

Limited product warranty

Life Technologies Corporation and its affiliates warrant their products as set forth in the
Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/
home/global/terms-and-conditions.html. If you have questions, contact Life Technologies at

www.thermofisher.com/support.
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Glossary

Glossary

aligned melt curve plot

Plot of the re-scaled melt curve.

allele

In a diploid organism, one of two DNA sequences found at the same locus (for example, a particular
gene), but located on homologous chromosomes. Two corresponding alleles may have the identical
sequence, or they may differ somewhat, often at one or more single-base sites (SNPs).

amplicon
A segment of DNA amplified during PCR.

amplification

Part of the instrument run in which PCR amplifies the target. Fluorescence data collected during
amplification are displayed in an Amplification Plot, and the data are used to calculate results.

Note: Only quantitative real-time PCR experiments, not end-point experiments, take amplification data
into account.

amplification efficiency (EFF %)

Calculation of the efficiency of the PCR amplification in an experiment. EFF% is calculated using the
slope of the regression line in the standard curve. A slope close to —3.32 indicates optimal, 100% PCR
amplification efficiency.

Amplification Plot

Display of data collected during the cycling stage of PCR amplification. The Ampilification Plot can be
viewed as:

* Baseline-corrected normalized reporter (AR, vs. cycle
* Normalized reporter (R, vs. cycle
* Threshold cycle (C;) vs. well
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amplification stage

Part of the instrument run in which PCR ampilifies the target. The amplification stage, called a cycling
stage in the thermal profile, consists of denaturing, primer annealing, and extension steps that are
repeated. Fluorescence data collected during the extension stage are displayed in an amplification plot,
and the data are used to calculate results. With chemistry, the last two steps of a PCR stage are
typically combined.

See also “cycling stage” on page 201.

assay

In a PCR reaction mix, two target-specific primers or two primers and a probe used to amplify a target.

assay mix

PCR reaction component in assays. The assay mix contains primers designed to amplify a target and a
probe designed to detect amplification of the target.

automatic baseline

An analysis setting in which the software calculates the baseline start and end cycles for the
amplification plot.

See also “baseline” on page 200.

automatic threshold

An analysis setting in which the software calculates the baseline start and end cycles and the threshold
in the amplification plot. The software uses the baseline and threshold to calculate the threshold cycle

(Gy.
See also “threshold cycle (Ct)” on page 210.

background calibration

Type of calibration in which the instrument performs reads of a background plate or array card,
averages the spectra recorded during the run, and extracts the resulting spectral component to a
calibration file. The software then uses the calibration file during subsequent runs to remove the
background fluorescence from the run data.

baseline

From the Amplification Plot, a cycle-to-cycle range that defines background fluorescence.

baseline-corrected normalized reporter (AR)

The magnitude of normalized fluorescence signal generated by the reporter. In experiments that contain
data from real-time PCR, the magnitude of normalized fluorescence signal generated by the reporter at
each cycle during the PCR amplification. From the AR, vs. Cycle Amplification Plot, AR, is calculated at
each cycle as:

AR, (cycle) = R, (cycle) -R, (baseline), where R,, = normalized reporter

See also “normalized reporter (Rn)” on page 205.

200 QuantStudio™ 6 and 7 Flex Real-Time PCR Systems (v1.6.1 or later) Maintenance and Administration Guide



Glossary

blocked IPC

In presence/absence experiments, a reaction that contains IPC blocking agent, which blocks
amplification of the internal positive control (IPC). In QuantStudio™ Real-Time PCR Software, also
the name of the task for the IPC target in wells that contain IPC blocking agent. See also “negative
control-blocked IPC wells” on page 204.

CE mark c €

The CE Mark (an acronym for the French “Conformite Europeene”) of conformity certifies that a product
has met the essential requirements of the applicable European Directive.

chemistry

See “reagents” on page 206.

control

Sample of known genotype or melt-curve shape.

Ct
See “threshold cycle (Ct)” on page 210.

C; algorithm

The QuantStudio™ Real-Time PCR Software uses the Baseline Threshold algorithm.

cycle threshold
See “threshold cycle (Ct)” on page 210.

cycling stage
In the thermal profile, a stage that is repeated. A cycling stage is also called an amplification stage.

See also “amplification stage” on page 199.

data collection

During the instrument run, a process in which an instrument detects fluorescence data from each well
of the plate or array card. The instrument transforms the signal to electronic data and saves the data in
the experiment file.

delta R, (AR,)

See “baseline-corrected normalized reporter (ARn)” on page 200.

derivative melt curve plot

The default view of the melting curve. It plots the negative derivative data (-R,,’) vs. temperature.

Note: An alternative view is the raw data view, which plots the normalized fluorescence from reporter
dye vs. temperature.
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derivative reporter (-R,,’)

The rate of change in fluorescence as a function of temperature. R, is used to plot a melting curve.
Significant decrease of the fluorescent signal generates a positive peak on the derivative view of the
melting curve.

dissociation curve

See “melt curve” on page 203.

dye calibration

EFF%

Type of calibration in which the software collects spectral data from a series of dye standards and
stores the spectral information for the dye standards in a pure spectra calibration file. This file is used
during experiment runs to characterize and distinguish the individual contribution of each dye in the
total fluorescence collected by the instrument.

See “amplification efficiency (EFF%)” on page 199.

error
The standard error of the slope of the regression line in the standard curve.
The error can be used to calculate a confidence interval (Cl) for the slope. Because the amplification
efficiency is calculated from the slope, knowing the error allows a Cl for the amplification efficiency to
be calculated.

experiment
Refers to the entire process of performing a run, including setup, run, and analysis.

filter
Dye excitation and emission filter combination that is set for an experiment. The QuantStudio™ 7 Flex
System includes a decoupled, six by six-color filter set. The QuantStudio™ 6 Flex System includes
a coupled five-color filter set. The excitation and emission filter combinations are preset by the
experiment document (.eds) file for your experiment.

flag

A quality control (QC) indicator which, when applied by the software to a well during analysis, indicates
a possible issue with that reaction. For example, a flag may be issued if no amplification is detected in
a well. Flags indicating potential problems are displayed in the Quality Control tab of the Plate Layout,
Well Table, and QC Summary screens.

forward primer

Oligonucleotide that flanks the 5’ end of the amplicon. The reverse primer and the forward primer are
used together in PCR reactions to amplify the target.

heterozygote

202

Samples having both allele 1 and allele 2.
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holding stage

In the thermal profile, the stage that holds the temperature constant for a defined period of time.

homozygote

Samples having only allele 1 or only allele 2.

Instrument Console

A software feature that allows you to monitor the status of any instrument on the network; view
calibration, maintenance, and instrument properties for a selected instrument; and open and close the
instrument drawer.

Instrument Manager

A software feature that allows you to monitor the status of an instrument; monitor Amplification Plots
and temperature plots in real time; view the calibration status, perform calibrations and manage files on
the instrument, including downloading completed experiments to your computer.

internal positive control (IPC)

In presence/absence experiments, a short synthetic DNA template that is added to PCR reactions. The
IPC can be used to distinguish between true negative results (the target is absent in the samples) and
negative results caused by PCR inhibitors, incorrect assay setup, or reagent or instrument failure.

IPC

See “internal positive control (IPC)” on page 203.
IPC+

See “negative control-IPC wells” on page 204.
melt curve

A plot of data collected during the melt curve stage. Peaks in the melt curve can indicate the melting
temperature (T,,,) of the target, or they can identify nonspecific PCR amplification. In the software, you
can view the melt curve as normalized reporter (R;) vs. temperature or as derivative reporter (-R,,’ ) vs.
temperature.

melt curve characteristics

The melt curve shape and the difference in melting temperature (T,,) values.

melt curve stage

In the thermal profile, a stage with a temperature increment to generate a melt curve.

melting temperature (T,)

The temperature at which 50% of the DNA is double-stranded and 50% of the DNA is dissociated into
single-stranded DNA. In a melt curve experiment, the melt curve plot displays the melting temperature.
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melting transition region

In Melt Curve experiments, the region before and after the melting temperature (T,,,). See also “melting
temperature (Tm)” on page 203.

negative control (NC)

The task for targets or SNP assays in wells that contain water or buffer instead of sample. No
amplification of the target should occur in negative control wells. Previously called no template control
(NTC).

negative control-blocked IPC wells

In presence/absence experiments, wells that contain IPC blocking agent instead of sample in the PCR
reaction. No amplification should occur in negative control-blocked IPC wells because the reaction
contains no sample and amplification of the IPC is blocked. Previously called no amplification control
(NAC).

negative control-IPC wells

In presence/absence experiments, wells that contain IPC template and buffer or water instead of
sample. Only the IPC template should amplify in negative control-IPC wells because the reaction
contains no sample. Previously called IPC+.

no template control (NTC)
See “negative control (NC)” on page 204.

nonfluorescent quencher-minor groove binder (NFQ-MGB)

Molecules that are attached to the 3’ end of probes. When the probe is intact, the nonfluorescent
quencher (NFQ) prevents the reporter dye from emitting fluorescence signal. Because the NFQ does not
fluoresce, it produces lower background signals, resulting in improved precision in quantification. The
minor groove binder (MGB) increases the melting temperature (T,,) of the probe without increasing its
length, allowing for the design of shorter probes.

normalization calibration

Type of calibration in which the software collects data from the normalization standards, then stores it in
a normalization calibration file.

normalized quantity

Either the C; Avg. of the target gene minus the C; Avg. of the endogenous control (Comparative C;
experiments), or the Q Avg. of the target divided by the Q Avg. of the endogenous control (Relative
Standard Curve experiments).

normalized quantity mean

The relative standard curve equivalent of the AC; mean value found in Comparative C; experiments
(computed as the geometric mean).
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normalized quantity SE

The relative standard curve equivalent of the AC; SE value found in Comparative C; experiments
(computed as the geometric standard error of the mean).

normalized reporter (R,)

Fluorescence signal from the reporter dye normalized to the fluorescence signal of the passive
reference dye (usually ROX™ dye on Thermo Fisher Scientific instruments).

outlier

A measurement (such as a C;) that deviates significantly from the measurement of the other replicates
for that same sample.

passive reference

A dye that produces fluorescence signal independent of PCR amplification, and that is added to each
reaction at a constant concentration. Because the passive reference signal should be consistent across
all wells, it is used to normalize the reporter dye signal to account for non-PCR related fluorescence
fluctuations caused by minor well-to-well differences in volume. Normalization to the passive reference
signal generally results in data with noticeably high precision among technical replicates.

plate layout

An illustration of the grid of wells and assigned content in the plate or array card. The number of rows
and columns in the grid depends on the sample block that you use.

From the software, you can use the plate layout as a selection tool to assign well contents, to view well
assignments, and to view results. The plate layout can be printed, included in a report, exported, and
saved as a slide for a presentation.

point

One standard in a standard curve. The standard quantity for each point in a standard curve is
calculated based on the starting quantity and serial factor.

positive control

In genotyping and presence/absence experiments, a DNA sample with a known genotype, homozygous
or heterozygous.

In the software, the task for the SNP assay in wells that contain a sample with a known genotype.

pure dye

Fluorescent compound used to calibrate the instrument. See “system dye” on page 209.

quantity

In quantification experiments, the amount of target in the samples. Absolute quantity can refer to copy
number, mass, molarity, or viral load. Relative quantity refers to the fold-difference between normalized
quantity of target in the sample and normalized quantity of target in the reference sample.
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quencher

A molecule attached to the 3’ end of probes to prevent the reporter from emitting fluorescence signal
while the probe is intact. With reagents, a nonfluorescent quencher-minor groove binder (NFQ-MGB)
can be used as the quencher.

R2 value

Regression coefficient calculated from the regression line in the standard curve. An important quality
value, the R? value indicates the closeness of fit between the standard curve regression line and the
individual C; data points from the standard reactions. A value of 1.00 indicates a perfect fit between the
regression line and the data points.

Raw Data Plot

A plot of raw fluorescent signal as detected through each emission filter, used to view raw data for
individual wells and at individual cycles.

reaction mix

A solution that contains all components to run the PCR reaction, except for the template (sample,
standard, or control). Also called a “PCR cocktail”.

reagents

The PCR reaction components used to amplify the target and to detect amplification.

real-time PCR

Process of collecting fluorescence data during PCR. Data from the real-time PCR are used to calculate
results for quantification experiments or to troubleshoot results for genotyping or presence/absence
experiments.

reference sample

In relative standard curve and Comparative C; (AAC;) experiments, the sample used as the basis for
relative quantification results. Also called the calibrator.

region of interest (ROI) calibration

Type of calibration in which the software maps the positions of the wells on the sample block of the
instrument. The software uses the ROI calibration data to associate increases in fluorescence during a
run with specific wells of the plate or array card. A calibration image for each individual filter must be
generated to account for minor differences in the optical path.

regression coefficients

Values calculated from the regression line in standard curves, including the R? value, slope, and
y-intercept. You can use the regression coefficients to evaluate the quality of results from the standards.
See also “standard curve” on page 208.

regression line

In standard curve and relative standard curve experiments, the best-fit line from the standard curve.
Regression line formula:
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Ci=m[log (Qty)] + b
where m is the slope, b is the y-intercept, and Qty is the standard quantity.

See also “regression coefficients” on page 206.

reject well

An action that the software performs during analysis to remove one or more wells from further analysis
if a specific flag is applied to the well.

relative standard curve method

A method to determine relative quantities. This method compensates for target and endogenous control
efficiency differences within each run. In all experiments, unknown samples and dilution series of
template (such as cDNA) are amplified. Following a run, the instrument software interpolates relative
quantities for each unknown sample from the appropriate dilution curve, then normalizes the data for
each sample (or set of replicates) as follows: target QAvg. + endogenous control QAvg.

replicate group
A user-defined biological grouping. A replicate group may be a set of identical reactions in an

experiment.

replicates

Total number of identical reactions containing identical components and identical volumes.

reporter

A fluorescent dye used to detect amplification. With reagents, the reporter dye is attached to the 5’ end.

reverse primer
An oligonucleotide that flanks the 3’ end of the amplicon. The reverse primer and the forward primer are
used together in PCR reactions to amplify the target.

reverse transcriptase

An enzyme that converts RNA to cDNA.

R

See “normalized reporter (Rn)” on page 205.

ROX™ dye

A dye supplied by Thermo Fisher Scientific, which is used as a passive reference in some experiments.

run method

Definition of the reaction volume and the thermal profile for the instrument run. The run method
specifies the temperature, time, ramp, and data collection points for all steps and stages of the
instrument run.
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sample

The biological tissue or specimen that you are testing for a target gene.

sample definition file

A tab-delimited file (TXT) or Microsoft™ Excel™ file (XLS or XLSX) that contains the sample name and
custom sample properties for a single experiment.

security, auditing and e-signature
A separately licensed software module that provides:

* System Security — Controls user access to the software. Provides a default Administrator user
account. You can define additional user accounts and permissions.

¢ Auditing — Tracks changes made to library items, actions performed by users, and changes to the
Security and Audit settings. The software automatically audits some actions silently. You can select
other items for auditing and specify the audit mode. Provides reports for audited library items,
Security and Audit changes, and actions.

* Electronic Signature (e-signature) — Controls whether users are permitted, prompted, or required
to provide a user name and password when accessing certain software features. You can select
which features are controlled and the number of signatures required for access. When authorized
persons use this feature, they are creating a legally binding signature.

serial factor

In the software, a numeric value that defines the sequence of quantities in the standard curve. The
serial factor and the starting quantity are used to calculate the standard quantity for each point in the
standard curve. For example, if the standard curve is defined with a serial factor of 1:10 or 10X, the
difference between any two adjacent points in the curve is 10-fold.

slope

Regression coefficient calculated from the regression line in the standard curve. The slope indicates the
PCR amplification efficiency for the assay. A slope of -3.32 indicates 100% amplification efficiency.

See also “amplification efficiency (EFF%)” on page 199 and “regression line” on page 206.

stage

In the thermal profile, a group of one or more steps. Examples: PCR stage, cycling stage (also called
amplification stage), and hold stage.

standard

A sample that you dilute and amplify along with unknown samples. This dilution series can contain
known starting quantities of the target of interest (absolute standard curve) or it can be of known
dilution factor (relative standard curve). Following the run, the software interpolates the C; values of the
unknowns to this curve, yielding either specific quantities of the target (for absolute curves) or relative
quantities (for relative dilution curves).

See also “standard curve” on page 208.
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standard curve

In standard curve and relative standard curve experiments:

* The best-fit line in a plot of the C; values from the standard reactions plotted against standard
quantities. See also “regression line” on page 206.

* A set of standards containing a range of known quantities. Results from the standard curve
reactions are used to generate the standard curve. The standard curve is defined by the number of
points in the dilution series, the number of standard replicates, the starting quantity, and the serial
factor.

standard curve method

Method for determining absolute target quantity in samples. With the standard curve method, the
software measures amplification of the target in samples and in a standard dilution series. Data from the
standard dilution series are used to generate the standard curve. Using the standard curve, the software
interpolates the absolute quantity of target in the samples.

See also “standard” on page 208 and “standard curve” on page 208.

standard dilution series

In standard curve and relative standard curve experiments, a set of standards containing a range of
known quantities. The standard dilution series is prepared by serially diluting standards. For example,
the standard stock is used to prepare the first dilution point, the first dilution point is used to prepare
the second dilution point, and so on. In the software, the volumes needed to prepare a standard dilution
series are calculated by the number of dilution points, the number of standard replicates, the starting
quantity, the serial factor, and the standard concentration in the stock. See also “standard curve” on
page 208.

standard quantity

In the PCR reaction, a known quantity. In standard curve experiments, the quantity of target in the
standard. From the software, the units for standard quantity can be for mass, copy number, viral load,
or other units for measuring the quantity of target. Standard quantity can also refer to dilution factor.

starting quantity

When defining a standard curve in the software, the highest quantity.

step
A component of the thermal profile. For each step in the thermal profile, you can set the ramp rate (ramp
increment for melt curve steps), hold temperature, and hold time (duration) are set as part of the TDD
file. Data collection can also be turned on or off for the ramp or the hold parts of the step in each TDD
file. For cycling stages, a step is also defined by the AutoDelta status.

system dye

Dye supplied by Thermo Fisher Scientific and calibrated on the QuantStudio™ 6 and 7 Flex Systems.
Before you use system dyes in your experiments, make sure the dye calibration is current in the
Instrument Console.
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target

The nucleic acid sequence to amplify and detect.

target color

From the software, a color assigned to a target to identify the target in the plate layout and analysis
plots.

task

From the software, the type of reaction performed in the well for the target or SNP assay.

technical replicates

Wells containing identical reaction components, including sample; important for evaluating precision.

temperature plot

From the software, a display of temperatures for the instrument cover and instrument block during the
instrument run.

template
The type of nucleic acid to add to the PCR reaction.

thermal profile

Part of the run method that specifies the temperature, time, ramp, and data collection points for all
steps and stages of the instrument run.

experiment document file (.eds)

The Thermo Fisher Scientific name for the electronic records that comprise all information about

a particular plate or array card, including metadata (name, barcode, comments), plate setup (well
contents, assay definitions), run method (thermal cycling protocol), run results, analysis protocol,
analysis results, audit records, and other consumable-specific data. Experiment document files have
the .eds suffix.

threshold

In Amplification Plots, the level of fluorescence above the baseline and within the exponential growth
region.

threshold cycle (Cy)

The PCR cycle number at which the fluorescence meets the threshold in the Amplification Plot. See
also “threshold” on page 210 and “Amplification Plot” on page 199.

Tm

See “melting temperature (Tm)” on page 203.

touchscreen

Instrument display that you touch to control the instrument.
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uniformity calibration

Type of calibration in which the software measures sample block uniformity. The calibration generates
data that compensate for the physical effects of the QuantStudio™ 6 and 7 Flex Systems filters on data

collected during an experiment.

unknown
From the software, the task for the target in wells that contain the sample being tested. In quantification
experiments, the task for the target in wells that contain a sample with unknown target quantities. In
genotyping experiments, the task for the SNP assay in wells that contain a sample with an unknown
genotype. In presence/absence experiments, the task for the target in wells that contain a sample in
which the presence of the target is not known. In melt curve experiments, the task for the target in wells
that contain a sample with an unknown melt curve profile.

variant

A sample (or group of samples) with a unique melt curve (that is, the melt curve is different from the
melt curves of other samples or controls used in the experiment). The software determines melt curve
differences by the melting temperature (T,,) and the shape of the melt curve.

y-intercept

From the standard curve, the value of y where the regression line crosses the y-axis. The y-intercept
indicates the expected threshold cycle (Cy) for a sample with quantity equal to 1.
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